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ABSTRAK 

 

      Penelitian ini bertujuan untuk mengetahui perbedaan hasil belajar mata 

pelajaran TIK siswa kelas XI SMA Muhammadiyah 1 Muntilan yang 

menggunakan jejaring sosial facebook sebagai media pembelajaran dan yang 

menggunakan modul. Jika sudah diketahui hasil belajarnya di mana terdapat 

perbedaan antara siswa yang menggunakan jejaring sosial facebook sebagai media 

pembelajaran dan yang menggunakan modul maka rekomendasinya ialah jejaring 

sosial facebook dapat digunakan sekolah sebagai media pembelajaran. 

      Metode penelitian yang digunakan adalah metode penelitian Quasi 

Eksperimen. Terdapat dua kelompok kelas dalam penelitian ini yaitu kelas 

eksperimen dan kelas kontrol. Kelas eksperimen diberi perlakuan dengan 

menggunakan jejaring sosial facebook sebagai media pembelajaran, sedangkan 

kelas kontrol diberi perlakuan dengan menggunakan modul sebagai media 

pembelajaran. Diadakan dua kali tes yaitu pretest dan posttest. Pretest digunakan 

untuk mengetahui apakah kemampuan kedua kelompok kelas sama atau tidak. 

Sementara itu posttest digunakan untuk menguji hipotesis yang diajukan. Sebelum 

dilakukan pengujian hipotesis terlebih dahulu dilakukan uji prasyarat analisis 

yaitu uji normalitas dan homogenitas untuk mengetahui teknik pengujian hipotesis 

yang akan digunakan. 

      Hasil uji prasyarat analisis menunjukkan bahwa data posttest berdistribusi 

tidak normal dan memiliki varian yang homogen. Oleh karena itu, uji hipotesis 

dalam penelitian ini menggunakan metode statistik non parametrik yaitu dengan 

menggunakan Uji Mann-Whitney. Berdasarkan hasil perhitungan dengan Uji 

Mann-Whitney diperoleh nilai signifikansi sebesar 0,030. Ditetapkan nilai 

probabilitas sebesar 0,05 sehingga nilai hitung Uji Mann-Whitney lebih kecil dari 

nilai probabilitas (0,030 < 0,05). Jadi dapat disimpulkan bahwa terdapat 

perbedaan pada hasil belajar mata pelajaran TIK siswa kelas XI SMA 

Muhammadiyah 1 Muntilan yang menggunakan jejaring sosial facebook sebagai 

media pembelajaran dan yang menggunakan modul.  

Kata Kunci : Facebook, Modul, Media Pembelajaran, Hasil Belajar 
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ABSTRACT 

 

      This research aims to know the difference of the study result in XI grade 

students’ who use facebook social media as learning media and who use module 

for TIK lesson in SMA Muhammadiyah 1 Muntilan. If it has been known about 

the study result in which there is a difference between the students who use 

facebook social media as learning media and who use module, so the 

recommendation is that facebook social media can be used as a learning media. 

      The research method that is used is Quasi Experiment. There are two groups 

of class in this research; Experimental class and Control class. Experimental class 

is given facebook social media as learning media and Control class is given 

Module as the learning media. There are two tests, those are pretest and posttest. 

Pretest is held to know whether their ability is same or not. Posttest is used to 

examine the proposed hypothesis. Before the hypothesis examination, there must 

be done an analytical requirement test first, those are a normality test and 

homogeneity to find the hypothesis test technique that will be used. 

      The result of analytical requirement test shows that the posttest data distribute 

abnormally and has a homogeneous kind.  Because of that the hypothesis test in 

this research using statistic method non parametric with a Mann-Whitney test. 

Based on the count result with a Mann-Whitney test, it got significance score that 

is 0.030 and fixed the probability score is 0.050, so the count score of Mann-

Whitney is less than the probably score (0.030 < 0.050). So, it can be concluded 

that there is a difference in TIK Lesson learning result for students grade XI in 

SMA Muhammadiyah 1 Muntilan between who use facebook social media as 

learning media and they use module. 

Keywords : Facebook, Module, Learning Media and Learning Result 

 

 

 

 



 

ix 
 

KATA PENGANTAR 

 

      Puji syukur kehadirat Allah SWT atas berkat rahmat dan karunia-Nya, Tugas 

Akhir Skripsi dalam rangka untuk memenuhi sebagian persyaratan untuk 

mendapatkan gelar Sarjana Pendidikan dengan judul “Studi Komparasi Antara 

Penggunaan Jejaring Sosial Facebook dan Modul Sebagai Media Pembelajaran 

Terhadap Hasil Belajar Mata Pelajaran TIK Kelas XI SMA Muhammadiyah 1 

Muntilan” dapat disusun sesuai dengan harapan. Tugas Akhir Skripsi ini dapat 

diselesaikan tidak lepas dari bantuan dan kerjasama dengan pihak lain. Berkenaan 

dengan hal tersebut, ingin menyampaikan ucapan terima kasih kepada yang 

terhormat: 

1. Ibu Dr. Ratna Wardani selaku Dosen Pembimbing TAS yang telah banyak 

memberikan semangat, dorongan, dan bimbingan selama penyusunan Tugas 

Akhir Skripsi ini. 

2. Bapak Achmad Fatchi, M.Pd dan Bapak Masduki Zakaria, M.T selaku 

Validator instrumen penelitian TAS yang memberikan saran/masukan 

perbaikan sehingga penelitan TAS dapat terlaksana sesuai dengan tujuan. 

3. Bapak Djoko Santoso, M.Pd dan Bapak Suparman, M.Pd selaku Dewan 

Penguji yang telah memberikan koreksi perbaikan secara komprehensif 

terhadap TAS ini. 

4. Bapak Muhammad Munir, M.Pd selaku Ketua Jurusan Pendidikan Teknik 

Elektronika beserta dosen dan staf yang telah memberikan bantuan dan fasilitas 

selama proses penyusunan pra proposal sampai dengan selesainya TAS ini. 



 

x 
 

5. Bapak  Dr. Moch Bruri Triyono selaku Dekan Fakultas Teknik Universitas 

Negeri Yogyakarta yang memberikan persetujuan pelaksanaan Tugas Akhir 

Skripsi. 

6. Bapak Yanto Siswoyo S.TP selaku Kepala SMA Muhammadiyah 1 Muntilan  

dan Guru Mata Pelajaran TIK yang telah memberi ijin dan bantuan dalam 

pelaksanaan penelitian Tugas Akhir Skripsi ini. 

7. Peserta didik SMA Muhammadiyah 1 Muntilan khususnya kelas XI IPS 1, XI 

IPS 3 dan XI IPA 1 atas bantuan yang telah diberikan dan kesediaan menjadi 

subjek penelitian hingga skripsi ini dapat tersusun. 

8. Semua pihak, secara langsung maupun tidak langsung, yang tidak dapat 

disebutkan di sini atas bantuan dan perhatiannya selama penyusunan Tugas 

Akhir Skripsi ini. 

      Akhirnya, semoga segala bantuan yang telah berikan semua pihak di atas 

menjadi amalan yang bermanfaat dan mendapatkan balasan dari Allah SWT dan 

Tugas Akhir Skripsi ini menjadi informasi bermanfaat bagi pembaca atau pihak 

lain yang membutuhkannya. 

 

                                                                          

 

 

 

 

 

 

 

Penulis 

 

 

 

 

Zen Widodo 

NIM. 09520244023 



 

xi 
 

DAFTAR ISI 

 

HALAMAN JUDUL .............................................................................    i 

PERSETUJUAN ...................................................................................   ii 

SURAT PERNYATAAN.....................................................................   iii 

HALAMAN PENGESAHAN ...............................................................  iv 

HALAMAN MOTTO ...........................................................................  v 

HALAMAN PERSEMBAHAN ...........................................................  vi 

ABSTRAK ...........................................................................................  vii 

ABSTRACT .........................................................................................  viii 

KATA PENGANTAR ..........................................................................  ix  

DAFTAR ISI ........................................................................................   xi 

DAFTAR TABEL ................................................................................  xiii 

DAFTAR GAMBAR ...........................................................................  xiv 

DAFTAR LAMPIRAN ........................................................................  xv 

BAB I  PENDAHULUAN ....................................................................   1 

A. Latar Belakang ...................................................................   1 

B. Identifikasi Masalah ...........................................................   6 

C. Batasan Masalah .................................................................   7 

D. Rumusan Masalah ..............................................................   7 

E. Tujuan Penelitian................................................................   8 

F. Manfaat Penelitian..............................................................   8 

 

 



 

xii 
 

BAB II  KAJIAN PUSTAKA ..............................................................   10 

A. Deskripsi Teori ..................................................................   10 

B. Penelitian Yang Relevan ...................................................   23 

C. Kerangka Pikir...................................................................   25 

D. Hipotesis ............................................................................   26 

BAB III  METODE PENELITIAN......................................................  27 

A. Metode Penelitian ..............................................................  27 

B. Variabel Penelitian  ...........................................................  30 

C. Lokasi dan Jadwal Penelitian ............................................  30 

D. Populasi dan Sampel Penelitian ........................................  31 

E. Teknik Pengumpulan Data ................................................  32 

F. Instrumen Penelitan ...........................................................  34 

G. Teknik Analisis Data .........................................................  45 

BAB IV  HASIL PENELITIAN DAN PEMBAHASAN ....................  50 

A. Hasil Penelitian .................................................................  50 

B. Pembahasan .......................................................................  64 

BAB V  KESIMPULAN DAN SARAN ..............................................  70  

A. Kesimpulan........................................................................  70 

B. Saran ..................................................................................  71 

DAFTAR PUSTAKA ..........................................................................  72 

LAMPIRAN .........................................................................................  74 

 

 



 

xiii 
 

DAFTAR TABEL 

 

Tabel 1. Kisi-Kisi Instrumen Tes .........................................................  35 

Tabel 2. Kisi-Kisi Instrumen Non-Test ................................................  36 

Tabel 3. Skor Dari Butir Kuesioner .....................................................  37 

Tabel 4. Kriteria Tingkat Kesulitan .....................................................  38 

Tabel 5. Hasil Indeks Kesulitan Butir Soal ..........................................  38 

Tabel 6. Kriteria Daya Pembeda ..........................................................  40 

Tabel 7. Hasil Daya Pembeda Butir Soal .............................................  40 

Tabel 8. Hasil Validitas Butir Soal ......................................................  42 

Tabel 9. Pedoman Tingkat Reliabilitas Instrumen ...............................  43 

Tabel 10. Kategori Tanggapan Siswa ..................................................  49 

Tabel 11. Hasil Deskriptif Pretest Kelas Eksperimen .........................  51 

Tabel 12. Hasil Deskriptif Pretest Kelas Kontrol ................................  53 

Tabel 13. Hasil Deskriptif Posttest Kelas Eksperimen ........................  54 

Tabel 14. Hasil Deskriptif Posttest Kelas Kontrol ...............................  56 

Tabel 15. Hasil Uji Normalitas Tes......................................................  58 

Tabel 16. Hasil Uji Homogenitas Tes ..................................................  59 

Tabel 17. Hasil Uji Kesamaan Kemampuan Kelompok ......................  60 

Tabel 18. Hasil Uji Hipotesis ...............................................................  62 

Tabel 19. Pengolahan Data Kuesioner .................................................  63 

Tabel 20. Frekuensi Masing-Masing Kategori Tanggapan Siswa .......  63 

 



 

xiv 
 

DAFTAR GAMBAR 

 

Gambar 1. Hubungan Antar Kelompok Sampel ..................................   28 

Gambar 2. Diagram Alur Penelitian.....................................................   29 

Gambar 3. Diagram Batang Pretest Kelas Eksperimen .......................   52 

Gambar 4. Diagram Batang Pretest Kelas Kontrol ..............................   53 

Gambar 5. Diagram Batang Posttest Kelas Eksperimen ......................   55 

Gambar 6. Diagram Batang Posttest Kelas Kontrol ............................   57 

Gambar 7. Grafik Tanggapan Penggunaan Jejaring Sosial Facebook .   64 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

xv 
 

DAFTAR LAMPIRAN 

 

Lampiran 1. Daftar Subjek Penelitian .........................................................   75 

Lampiran 2. Daftar Hadir ............................................................................   77 

Lampiran 3. Silabus Teknologi Informasi dan Komunikasi Kelas XI ........   79 

Lampiran 4. Rencana Pelaksanaan Pembelajaran (RPP) ............................   81 

Lampiran 5. Modul Pembelajaran ...............................................................   89 

Lampiran 6. Soal Pretest ............................................................................   130 

Lampiran 7. Kunci Jawaban Soal Pretest ..................................................   136 

Lampiran 8. Soal Posttest ..........................................................................   137 

Lampiran 9. Kunci Jawaban Soal Posttest .................................................   143 

Lampiran 10. Data Skor Kelas Eksperimen ...............................................   144 

Lampiran 11. Data Skor Kelas Kontrol......................................................   145 

Lampiran 12. Input Data Uji Coba Instrumen Pretest ...............................   146 

Lampiran 13. Hasil Analisis Uji Coba Instrumen Pretest..........................   147 

Lampiran 14. Input Data Uji Coba Instrumen Posttest ..............................   153 

Lampiran 15. Hasil Analisis Uji Coba Instrumen Posttest ........................   154 

Lampiran 16. Ringkasan Hasil Validitas Data Uji Coba Pretest ...............   160 

Lampiran 17. Ringkasan Hasil Validitas Data Uji Coba Posttest ..............   161 

Lampiran 18. Statistik Deskriptif Data Pretest dan Posttest .....................   162 

Lampiran 19. Uji Normalitas dan Uji Homogenitas ..................................   163 

Lampiran 20. Uji Kesamaan Kemampuan Kelompok dan Uji Hipotesis ..   164 

Lampiran 21. Data User Facebook Kelas Eksperimen ..............................   165 



 

xvi 
 

Lampiran 22. Kuesioner Tanggapan Siswa ...............................................   166 

Lampiran 23. Data Kuesioner ....................................................................   169 

Lampiran 24. Uji Validitas dan Reliabilitas Kuesioner .............................   171 

Lampiran 25. Deskripsi Data Kuesioner ....................................................   172 

Lampiran 26. SK Pembimbing ...................................................................   173 

Lampiran 27. Validasi Modul Pembelajaran .............................................   174 

Lampiran 28. Validasi Instrumen Tes ........................................................   177 

Lampiran 29. Validasi Instrumen Non-Test (Kuesioner) ...........................   180 

Lampiran 30. Surat Ijin Penelitian .............................................................   181 

Lampiran 31. Surat Keterangan Selesai Penelitian ....................................   182 

Lampiran 32. Screenshoot Pembelajaran Dengan Facebook .....................   183 

Lampiran 33. Dokumentasi Penelitian .......................................................   188 

Lampiran 34. SK Penguji ...........................................................................   190 

 

 

 

 



 
 

1 
 

BAB I 

PENDAHULUAN 

 

A. Latar Belakang 

      Perkembangan teknologi semakin berkembang dengan pesat di abad ke-20 ini, 

terutama perkembangan teknologi informasi dan komunikasi. Teknologi informasi 

dan komunikasi memiliki peranan penting dalam kehidupan manusia. Tanpa 

adanya teknologi informasi dan komunikasi, maka informasi-informasi penting di 

suatu tempat tidak akan dapat diketahui di tempat lain dengan cepat. Selain itu 

manusia juga tidak akan dapat saling berkomunikasi ketika berada di tempat yang 

terpisah. Teknologi informasi dan komunikasi yang ada di zaman sekarang ini 

antara lain adalah radio, televisi, telepon, faksimile, Internet dan sebagainya. Dari 

yang disebutkan tersebut tentunya memiliki kelebihan dan kekurangan masing-

masing. Salah satu teknologi informasi dan komunikasi yang paling berkembang 

saat ini adalah Internet. 

      Internet merupakan wujud perpaduan antara arus komunikasi dengan 

perkembangan teknologi. Di Indonesia, saat ini semua orang dapat dengan mudah 

mengakses berbagai informasi dari seluruh belahan dunia dengan adanya fasilitas 

Internet. Hampir semua handphone keluaran sekarang sudah menyediakan 

fasilitas Internet. Bagi pengguna komputer atau laptop juga dapat menggunakan 

Internet dengan mudah dari layanan ISP maupun dengan modem. Selain itu 

tempat-tempat strategis sekarang ini juga sudah menyediakan layanan wifi yang 

dapat digunakan untuk akses Internet secara gratis seperti di rumah makan, 
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bandara, sekolah, kantor dan sebagainya. Semua berita dan informasi ada di 

Internet dan bahkan selalu up to date dalam hitungan perdetik.  

      Salah satu layanan Internet yang paling popular dibandingkan dengan layanan 

lain saat ini adalah jejaring sosial. Dengan jejaring sosial, pengguna dapat dengan 

mudah menjalin hubungan dengan yang lainnya. Pengguna dapat menjalin 

pertemanan dengan teman-teman lama dan juga dapat berkenalan dengan banyak 

pengguna termasuk yang berada di luar negeri.  

      Ada banyak jejaring sosial yang ada di Internet. Namun yang paling popular 

saat ini ialah facebook. Banyak yang tertarik untuk menggunakan facebook 

dikarenakan aplikasi ini memiliki fasilitas yang paling lengkap dibandingkan 

dengan jejaring sosial yang lain. Di facebook pengguna dapat membuat group, 

pages, game, event, sponsored dan sebagainya yang tidak dimiliki jejaring sosial 

yang lain.  

      Facebook saat ini sudah menyebar secara luas penggunaannya di seluruh 

kalangan masyarakat Indonesia mulai dari anak-anak sampai dewasa. Namun, 

banyak yang masih awam mengenai penggunaan facebook. Hal ini ditunjukkan 

dengan masih banyaknya remaja yang menggunakan facebook tidak dengan 

tujuan tertentu atau bahkan menggunakannya tanpa tujuan. Misalnya ialah hanya 

untuk ikut-ikutan temannya ataupun hanya karena mengikuti tren yang ada. 

Menurut Sanggar Kanto (2011: 2), perilaku remaja dalam menggunakan facebook 

yang utama adalah untuk kepentingan hubungan antar pribadi seperti menulis di 

wall, memperbaharui profil, menulis pesan, melakukan posting foto baru ataupun 

menandai foto. Remaja dalam menggunakan facebook untuk bersosial sudah 
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menjadi rutinitas yang artinya setiap hari akan selalu mengakses facebook dan 

akan merasa terasing jika tidak mengakses facebook dalam sehari sehingga akan 

banyak waktu yang terbuang hanya untuk bermain facebook. Fenomena ini juga 

terjadi di kalangan siswa sekolah. Sekolah tidak begitu paham akan adanya 

fenomena ini, sehingga penggunaan facebook oleh siswa hanya menganggu 

aktifitas pembelajaran. Oleh karena itu, akan dilakukan penelitian dengan 

menggunakan jejaring sosial facebook sebagai media pembelajaran Penelitian ini 

menjadi menarik untuk dilakukan mengingat sampai saat ini masih belum banyak 

sekolah yang memanfaatkan jejaring sosial facebook sebagai media pembelajaran 

yang dapat membantu proses pembelajaran di sekolah.  

      Penelitian ini akan dilakukan di SMA Muhammadiyah 1 Muntilan. Alasan 

pemilihan tempat ini sebagai lokasi penelitian yaitu karena sudah mengamati 

secara umum penggunaan facebook di SMA Muhammadiyah 1 Muntilan saat 

diadakan KKN-PPL dan dapat disimpulkan bahwa sekolah ini sangat cocok untuk 

dijadikan objek penelitian ini dikarenakan banyak siswa yang belum dapat 

memanfaatkan jejaring sosial facebook secara terarah sehingga facebook hanya 

mengganggu proses pembelajaran siswa.  

      SMA Muhammadiyah 1 Muntilan merupakan salah satu Sekolah Menengah 

Atas swasta yang berlokasi di kecamatan Muntilan, kabupaten Magelang. Sekolah 

ini terletak di pinggir jalan raya Magelang – Yogyakarta. SMA Muhammadiyah 1 

Muntilan mempunyai misi memberikan pelatihan ketrampilan praktis dan 

kecakapan hidup kepada semua siswa yang sesuai dengan tuntutan zaman dan 

kemajuan teknologi. Salah satu cara untuk mewujudkan misi tersebut, maka SMA 
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Muhammadiyah 1 Muntilan menyediakan koneksi Internet di laboratorium 

komputer untuk siswa yang tidak mempunyai laptop dan juga memasang wifi di 

tempat-tempat tertentu di sekolah untuk siswa yang memiliki laptop. Diharapkan 

siswa dapat memanfaatkan fasilitas Internet ini untuk mendukung proses belajar 

dan untuk mencari materi-materi pelajaran. Namun faktanya, ketika diadakan 

KKN-PPL di sana, terlihat lebih banyak siswa yang menggunakan fasilitas wifi 

untuk membuka facebook untuk bersosial daripada membuka situs yang ada 

hubungannya dengan materi pelajaran. Memang belum ada aturan bahwa fasilitas 

Internet di sekolah tidak boleh digunakan untuk membuka facebook, namun bila 

penggunaan facebook untuk bersosial menggunakan fasilitas Internet sekolah 

berlebihan maka hal ini tentunya akan menganggu konsentrasi belajar siswa di 

sekolah.  

Ketika diadakan pembelajaran mata pelajaran TIK di laboratorium komputer 

saat KKN-PPL, banyak siswa yang justru asyik membuka facebook di komputer 

laboratorium ketika mahasiswa KKN menjelaskan materi. Ketika pembelajaran 

TIK diadakan di kelas, banyak juga siswa yang menggunakan handphone untuk 

membuka facebook, misalnya untuk update status, mengunggah foto dan 

sebagainya. Hal ini juga terjadi saat pembelajaran mata pelajaran lain yang 

diampu oleh guru di SMA Muhammadiyah 1 Muntilan. Bukti riil bahwa siswa 

membuka facebook saat pembelajaran dilangsungkan ialah dapat terlihat dari 

aktifitas facebook sebagian besar siswa SMA Muhammadiyah 1 Muntilan yang 

dapat dipantau oleh peneliti setiap hari dari beranda facebook dikarenakan peneliti 
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sudah berteman dengan sebagian besar siswa SMA Muhammadiyah 1 Muntilan di 

facebook.  

      Dampak yang terlihat dari kegiatan siswa mengakses facebook di sekolah 

yaitu, siswa menjadi tidak fokus dalam mengikuti pelajaran yang disampaikan 

oleh guru. Hal ini ditunjukkan dengan sebagian siswa yang tidak mampu 

menjawab pertanyaan yang diberikan oleh guru di sela-sela penjelasan sehingga 

guru harus mengulang beberapa kali penjelasannya kepada siswa agar siswa 

benar-benar paham terhadap materi pelajaran yang diberikan. 

      Mata pelajaran TIK (Teknologi Informasi dan Komunikasi) merupakan salah 

satu mata pelajaran yang diajarkan di SMA Muhammadiyah 1 Muntilan. Hampir 

80% pembelajaran mata pelajaran ini dilaksanakan di laboratorium komputer 

yang sudah terkoneksi dengan Internet. Jadi, apabila diterapkan penggunaan 

jejaring sosial facebook sebagai media pembelajaran tentunya tidak akan menemui 

banyak kesulitan karena sudah tersedia koneksi Internet. Selain itu pengalaman 

mengajar mata pelajaran ini juga pernah diperoleh ketika KKN-PPL, sehingga 

diharapkan tidak akan menemui banyak kesulitan ketika penelitian berlangsung. 

      Berdasarkan latar belakang penggunaan facebook di sekolah oleh siswa di 

SMA Muhammadiyah 1 Muntilan maka akan diadakan penelitian eksperimen 

yang berjudul “Studi Komparasi Antara Penggunaan Jejaring Sosial Facebook 

dan Modul Sebagai Media Pembelajaran Terhadap Hasil Belajar Mata Pelajaran 

TIK Kelas XI SMA Muhammadiyah 1 Muntilan”. Penelitian ini perlu dilakukan 

untuk mengetahui apakah terdapat perbedaan hasil belajar mata pelajaran TIK 

siswa kelas XI SMA Muhammadiyah 1 Muntilan yang menggunakan jejaring 
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sosial facebook sebagai media pembelajaran dan yang menggunakan modul. Jika 

terbukti terdapat perbedaan pada hasil belajar mata pelajaran TIK siswa kelas XI 

SMA Muhammadiyah 1 Muntilan yang menggunakan jejaring sosial facebook 

sebagai media pembelajaran dan yang menggunakan modul maka jejaring sosial 

facebook dapat dimanfaatkan sebagai media pembelajaran untuk mengurangi 

dampak negatif facebook di sekolah. 

 

B. Identifikasi Masalah 

      Berdasarkan uraian latar belakang, maka ada beberapa permasalahan yang 

dapat diidentifikasi adalah sebagai berikut : 

1. Masih banyaknya remaja yang menggunakan facebook tidak dengan tujuan 

tertentu atau bahkan menggunakannya tanpa tujuan. Misalnya ialah hanya 

untuk ikut-ikutan temannya ataupun hanya karena mengikuti tren yang ada. 

2. Remaja dalam menggunakan facebook untuk bersosial sudah menjadi rutinitas 

yang artinya setiap hari akan selalu mengakses facebook dan akan merasa 

terasing jika tidak mengakses facebook dalam sehari sehingga akan banyak 

waktu yang terbuang hanya untuk bermain facebook. 

3. Berdasarkan pengamatan yang dilakukan selama KKN-PPL, fasilitas Internet 

di sekolah yang diperuntukkan untuk mendukung proses belajar justru lebih 

banyak digunakan siswa untuk membuka facebook untuk bersosial. 

4. Ketika diadakan pembelajaran saat KKN-PPL banyak siswa yang justru asyik 

membuka facebook sehingga perhatian siswa ketika pembelajaran menjadi 

teralih dan siswa menjadi tidak fokus dalam mengikuti pelajaran. 
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C. Batasan Masalah 

      Permasalahan yang akan diangkat pada penelitian ini mengambil satu dari 

identifikasi masalah yang dijabarkan yaitu pada masalah ketika diadakan 

pembelajaran banyak siswa yang justru asyik membuka facebook sehingga 

perhatian siswa ketika pembelajaran menjadi teralih dan siswa menjadi tidak 

fokus dalam mengikuti pelajaran. Dari permasalahan tersebut akan diberikan 

solusi dengan melakukan pembelajaran dengan jejaring sosial facebook sebagai 

media pembelajaran.  

Parameter yang akan digunakan yaitu dengan membagi sampel menjadi 2 

kelompok. Kelompok pertama ialah kelompok eksperimen yang diberi perlakuan 

menggunakan jejaring sosial facebook sebagai media pembelajaran. Sedangkan 

untuk kelompok kedua adalah kelas kontrol sebagai kelas pembanding yang diberi 

perlakuan menggunakan modul sebagai media pembelajaran yang sudah biasa 

diterapkan di sekolah. Batasan yang diambil pada penelitian ini ialah perbedaan 

hasil belajar mata pelajaran TIK siswa kelas XI SMA Muhammadiyah 1 Muntilan 

yang menggunakan jejaring sosial facebook sebagai media pembelajaran dan yang 

menggunakan modul serta tanggapan siswa kelas eksperimen di SMA 

Muhammadiyah 1 Muntilan terhadap penggunaan jejaring sosial facebook sebagai 

media pembelajaran. 

 

D. Rumusan Masalah 

      Berdasarkan batasan masalah, maka dapat dirumuskan masalah sebagai 

berikut: 
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1. Apakah terdapat perbedaan hasil belajar mata pelajaran TIK siswa kelas XI 

SMA Muhammadiyah 1 Muntilan yang menggunakan jejaring sosial facebook 

sebagai media pembelajaran dan yang menggunakan modul? 

2. Bagaimana tanggapan siswa kelas eksperimen di SMA Muhammadiyah 1 

Muntilan terhadap penggunaan jejaring sosial facebook sebagai media 

pembelajaran? 

 

E. Tujuan Penelitian 

Berdasarkan rumusan masalah, tujuan yang ingin dicapai dalam penelitian ini 

adalah: 

1. Mengetahui perbedaan hasil belajar mata pelajaran TIK siswa kelas XI SMA 

Muhammadiyah 1 Muntilan yang menggunakan jejaring sosial facebook 

sebagai media pembelajaran dan yang menggunakan modul. 

2. Mengetahui tanggapan siswa kelas eksperimen di SMA Muhammadiyah 1 

Muntilan terhadap penggunaan jejaring sosial facebook sebagai media 

pembelajaran. 

 

F. Manfaat Penelitian 

Dari kegiatan penelitian ini diharapkan dapat memberikan manfaat sebagai 

berikut: 

1. Manfaat Teoritis 
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a. Memberikan sumbangsih pada dunia pendidikan bahwa jejaring sosial 

facebook dapat digunakan sebagai media pembelajaran untuk 

meningkatkan hasil hasil belajar. 

b. Hasil dari penelitian ini diharapkan dapat menjadi referensi bagi 

perkembangan dunia pendidikan. 

c. Dapat dijadikan rujukan untuk penelitian selanjutnya yang berhubungan 

dengan penggunaan jejaring sosial sebagai media pembelajaran. 

2. Manfaat Praktis 

a. Bagi siswa  

      Menjadikan penggunaan facebook oleh siswa menjadi terarah dan dapat 

menjadi media pembelajaran alternatif yang dapat memberikan pemahaman dan 

penjelasan terhadap materi pelajaran Teknologi Informasi dan Komunikasi. 

b. Bagi guru 

      Mengatasi solusi dari permasalahan ketika guru mengajar siswa justru asyik 

menggunakan facebook untuk bersosial. 

c. Bagi Peneliti  

      Memberikan wawasan keilmuan dan pengetahuan dalam menggunakan 

facebook sebagai media pembelajaran dalam pelajaran Teknologi Informasi dan 

Komunikasi. 
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BAB II 

KAJIAN PUSTAKA 

 

A. Deskripsi Teori 

1. Jejaring Sosial 

      Jejaring sosial adalah bentuk situs yang memungkinkan koneksi sosial secara 

luas di dunia maya (Edi Noersasongko, 2010: 195). Jadi, di dalam jejaring sosial, 

pengguna dapat saling berinteraksi antara pengguna yang satu dengan yang 

lainnya melalui Internet tanpa harus bertatap muka secara langsung. Dengan 

jejaring sosial, pengguna dapat berkenalan dengan siapapun, kapanpun dan di 

mana saja. Bahkan pengguna bisa juga berkenalan dengan pengguna yang berada 

di luar negeri. Jejaring sosial memungkinkan setiap penggunanya untuk 

berhubungan dengan siapapun tanpa batas. Jarak yang sangat jauh bukan suatu 

kendala bagi pengguna jejaring sosial untuk saling terhubung. 

Sampai saat ini banyak sekali situs jejaring sosial yang beredar di Internet. Di 

antaranya ialah friendster, myspace, facebook, twitter dan sebagainya. Friendster 

dan Myspace sempat berjaya di Indonesia pada tahun 2005 – 2009 sebelum 

facebook terkenal. Namun pada tahun 2010 para pengguna friendster mulai 

beralih ke facebook dikarenakan fitur facebook yang lebih lengkap dan variatif. 

Facebook yang sekarang ini telah merambah semua kalangan masyarakat di 

Indonesia mulai dari anak-anak sampai dewasa.  

2. Facebook 

a. Pengertian Facebook       
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      Facebook adalah situs yang humanis yang memperlakukan anggotanya 

sebagai manusia (Agung Herutomo, 2010: 17). Maksudnya ialah bahwa manusia 

memiliki kebutuhan dasar yang harus selalu berhubungan dengan manusia yang 

lainnya seperti berkomunikasi, bersosialisasi, membentuk komunitas dan 

sebagainya. Facebook dibuat untuk memenuhi kebutuhan manusia tersebut yang 

tidak dibatasi oleh jarak dimanapun manusia berada.  

b. Penggunaan Facebook 

      Penggunaan facebook yang utama ialah digunakan untuk bersosial, di mana 

antara pengguna yang satu dan pengguna yang lainnya dapat saling berhubungan 

dan berkomunikasi tanpa ada batasan ruang dan waktu. Walau begitu, Stella Wen 

Tian dari Universitas Sains dan Teknologi China menunjukkan kalau jejaring 

sosial online mahasiswa secara langsung mempengaruhi belajar sosial dan dapat 

berpengaruh positif pada belajar akademis. Facebook sangat mempengaruhi 

kehidupan sosial mahasiswa dan menunjukkan potensi yang bagus dalam 

berhadapan dengan perubahan yang dihadapi mahasiswa. Lembaga pendidikan 

perlu mengadopsi tindakan aktif untuk menggunakan aplikasi jejaring sosial yang 

ada seperti facebook untuk pendidikan (Stella Wen Tian, 2011: 9). 

      Menurut Stella Wen Tian (2011: 4), ada dua aspek utama yang digunakan 

pelajar pada facebook, satu sosial dan satunya lagi edukasional. Aspek sosial 

adalah aspek penggunaan facebook secara umum yang biasa pengguna gunakan, 

yaitu penggunaan facebook yang berkaitan dengan interaksi hubungan antar 

sesama. Topik yang diangkat dalam skripsi ini adalah penggunaan jejaring sosial 
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facebook sebagai media pembelajaran, maka dari itu pembahasan lebih 

difokuskan pada aspek edukasional facebook saja. 

      Aspek edukasional adalah aspek penggunaan facebook yang berkaitan dengan 

proses pembelajaran. Ada 3 fungsi yang dapat diaplikasikan pada penggunaan 

jejaring sosial facebook sebagai media pembelajaran yaitu fungsi untuk 

penyampaian materi pelajaran, fungsi untuk jadwal evaluasi dan fungsi untuk 

melakukan diskusi (Hengky Alexander, 2010:  49-50). Untuk masing-masing fitur 

yang digunakan akan dijelaskan sebagai berikut: 

1) Penyampaian Materi dan Diskusi Pelajaran 

a) Link 

      Guru dapat menyampaikan materi berbentuk link. Link ini dapat menuju ke 

suatu alamat web di Internet yang memuat materi pelajaran. Siswa cukup menuju 

link yang dibagikan tersebut dan setelah itu maka otomatis akan muncul halaman 

web yang menjadi sumber dari materi pelajaran tersebut. Dengan demikian, siswa 

dapat dengan mudah mencari dan mengakses materi pelajaran. Selain itu, guru 

dapat mengarahkan siswa untuk mengakses link yang sudah diketahui isinya 

sehingga materi pelajaran yang dipelajari dapat lebih terarah. Siswa juga dapat 

mengomentari link yang dibagikan di bawah postingan tersebut. Siswa dapat 

mengomentari dan menanyakan apa yang tidak paham sehingga dapat terjadi 

diskusi materi pelajaran di bawah postingan link tersebut.  

      Link dapat dibagikan di profil guru maupun di dalam grup yang sudah dibuat 

untuk siswa kelas tersebut. Namun untuk link ini lebih baik dibagikan di dalam 

grup dikarenakan jika dibagikan di dalam profil guru maka siswa harus menjadi 
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teman dari guru yang bersangkutan terlebih dahulu. Selain itu siswa juga harus 

rajin memantau profil dari guru bila ingin mengikuti link yang dibagikan dan tidak 

semua siswa akan melihatnya juga. Jika link ini dibagikan di grup maka semua 

siswa yang berada di dalam grup akan dapat melihat materi yang dibagikan 

tersebut dikarenakan jika ada yang melakukan posting di grup maka semua 

anggota grup akan mendapatkan pemberitahuan. Untuk penjelasan grup secara 

terperinci akan dijelaskan pada sub bab grup. 

b) Note 

      Selain link, guru juga dapat menggunakan note untuk penyampaikan materi 

pelajaran kepada siswa. Pada note guru dapat menyampaikan materi lebih banyak 

tanpa harus membuka web lain. Artinya, materi pelajaran dapat diletakkan pada 

note tersebut. Guru dapat menuliskan teks lebih banyak di note daripada dengan 

link. Selain itu, pada note terdapat bagian judul dan isi yang tentunya lebih sesuai 

untuk penyampaian materi pelajaran. Siswa dapat mengomentari note yang 

dibagikan di bawah postingan tersebut. Siswa dapat mengomentari dan 

menanyakan apa yang tidak paham sehingga dapat terjadi diskusi materi pelajaran 

di bawah postingan note tersebut. 

      Sama seperti link, note juga dapat dibagikan di profil guru maupun di dalam 

grup yang sudah dibuat untuk siswa kelas tersebut. Untuk menggunakan note 

yang ada di dalam profil, masuk ke apps kemudian notes. Setelah itu klik write a 

note. Sedangkan untuk melakukan posting note di grup caranya ialah masuk ke 

files kemudian create a doc. Note juga lebih baik dibagikan di grup supaya siswa 
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lebih mudah untuk mengakses note karena jika note dibagikan di grup maka 

semua siswa di dalam grup akan mendapatkan pemberitahuan. 

c) Grup 

      Grup adalah sebuah fitur di facebook yang dapat digunakan untuk membentuk 

suatu forum dalam sebuah komunitas. Fitur ini sangat tepat digunakan oleh guru 

untuk mendukung proses pembelajaran dikarenakan guru tidak perlu berteman 

dengan siswa untuk menyampaikan materi dan melakukan diskusi pelajaran. 

Siswa juga lebih mudah mengakses materi yang dibagikan karena jika guru 

melakukan posting, maka siswa akan menerima pemberitahuan dari facebook. 

Guru dapat memasukkan semua anggota kelasnya ke dalam satu grup di facebook. 

Guru dapat melakukan posting materi-materi pelajaran lewat Write Post (wall) 

grup. Siswa dapat pula menanyakan apa yang menjadi kesulitan belajarnya di 

grup untuk dapat dipecahkan bersama-sama.  

      Di grup juga terdapat beberapa fitur yang dapat digunakan untuk penyampaian 

materi dan diskusi pelajaran selain melalui wall.  Di antaranya adalah: 

(1)  Add photo, yaitu fitur yang dapat digunakan untuk saling berbagi 

gambar yang dapat mendukung pembelajaran. 

(2)  Add video, yaitu fitur yang dapat digunakan untuk saling berbagi video 

yang dapat mendukung pembelajaran. 

(3)  Ask Question, yaitu fitur yang dapat digunakan untuk menanyakan 

pertanyaan-pertanyaan yang berhubungan dengan pembelajaran dengan 

disertai dengan pilihan jawaban yang dapat dipilih anggota grup. 
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(4)  Add File, yaitu fitur yang dapat digunakan untuk saling berbagi buku-

buku elektronik pembelajaran yang berformat pdf maupun doc. 

      Fitur-fitur di dalam grup selain dapat digunakan untuk penyampaian materi 

juga dapat digunakan untuk diskusi materi yang dibagikan. Siswa dapat 

menanyakan apa yang tidak paham di komentar masing-masing fitur. Guru dapat 

menanggapinya sehingga terjadi diskusi materi pelajaran antara siswa dan guru. 

2) Pengingat Jadwal Evaluasi 

      Salah satu bagian yang tidak dapat dilupakan dalam sebuah pembelajaran 

adalah sebuah evaluasi pembelajaran atau yang biasa disebut dengan ulangan 

harian. Seringkali siswa melupakan kapan diadakannya ulangan harian, meskipun 

sudah disampaikan oleh guru sebelumnya. Dengan fitur event, siswa akan lebih 

mudah mengingat jadwal ulangan yang akan diadakan karena siswa akan selalu 

melihatnya ketika membuka beranda  facebook. Diharapkan siswa tidak lagi lupa 

untuk belajar sebelum diadakan ulangan harian sehingga harapannya tentunya 

untuk mendapat nilai yang memuaskan. 

      Jadwal evaluasi dapat dibagi menjadi dua bagian. Bagian pertama adalah 

jadwal evaluasi umum (evaluasi yang diadakan bersamaan) dan bagian kedua 

adalah evaluasi biasa yang diadakan oleh pengampu mata pelajaran tersebut. Guru 

dapat memasukkan jadwal evaluasi umum dan biasa tersebut ke dalam facebook 

melalui fitur event. Dengan demikian, siswa dapat melihat jadwal ujian atau 

evaluasi dari facebook. 

      Event dapat dibuat dengan dua cara. Melalui create event di dalam home dan 

create event yang ada di dalam grup. Akan lebih mudah bila menggunakan create 
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event yang ada di dalam grup karena secara otomatis dapat mengundang semua 

siswa yang ada di dalam grup. Jika membuat event dari create event yang ada di 

dalam home maka guru hanya dapat mengundang siswa yang sudah menjadi 

temannya saja dan harus memilih satu persatu dari semua temannya di facebook. 

Maka dari itu akan lebih efektif bila membuat jadwal evaluasi dari create event 

yang ada di dalam grup sehingga guru dapat mengundang semua siswa dengan 

mudah dan dapat juga mengundang siswa yang belum menjadi temannya di 

facebook asalkan sudah masuk ke dalam grup tersebut. 

3. Modul 

a. Pengertian Modul 

      Modul adalah suatu paket pengajaran yang memuat satu unit konsep dari pada 

bahan pelajaran (St Vebriarto, 1975: 22). Yang dimaksud dengan satu unit konsep 

ialah suatu mata pelajaran tertentu. Misalnya ialah modul untuk mata pelajaran 

Teknologi Informasi dan Komunikasi. Ada modul yang mencakup satu pokok 

bahasan saja dan ada pula modul yang mencakup beberapa pokok bahasan. Modul 

disajikan dalam bentuk yang bersifat intruksi. Hal ini dimaksudkan agar siswa 

mampu mempelajari suatu materi dengan sendirinya meskipun sedang tidak 

didampingi oleh guru mata pelajaran yang bersangkutan. Dengan modul, masing-

masing siswa dapat menentukan kecepatan dan intensitas belajarnya sendiri 

karena modul dapat dipelajari kapan saja dan di manapun siswa tersebut berada. 

b. Ciri-Ciri Modul 

      Menurut St Vebriarto (2010: 35), ada beberapa ciri-ciri modul. Di antaranya 

adalah: 
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1) Modul merupakan paket pengajaran yang bersifat self-instruksional. 

      Maksudnya ialah siswa diberi kesempatan belajar sendiri menurut irama dan 

kecepatannya masing-masing. Hal dasar yang mendasari dibuatnya modul ialah 

bahwa belajar adalah proses yang harus dilakukan oleh siswa sendiri. Guru hanya 

bertugas untuk memberikan sedikit petunjuk dan memantau kegiatan belajar 

siswa.  

2) Pengakuan atas perbedaan-perbedaan individual. 

      Maksudnya ialah bahwa setiap siswa memiliki perbedaan kemampuan 

akademik dan perbedaan gaya belajar. Modul ini sangat sesuai untuk menanggapi 

perbedaan-perbedaan tersebut. Hal itu dikarenakan modul bisa dipelajari secara 

individual maupun secara kelompok. 

3) Memuat rumusan tujuan pengajaran secara eksplisit. 

      Rumusan tujuan di dalam modul sangat berguna bagi guru maupun siswa. 

Bagi guru rumusan tujuan berguna untuk merencanakan apa yang harus dilakukan 

untuk bisa mencapai tujuan tersebut. Sedangkan bagi siswa rumusan tujuan 

berguna agar siswa mengetahui apa yang harus dicapai dalam kegiatan belajarnya. 

4) Adanya asosiasi, struktur dan urutan pengetahuan. 

      Materi pelajaran pada modul itu disusun mengikuti pengetahuan secara 

hirarkhis. Dengan demikian siswa dapat mengikuti urutan kegiatan belajar secara 

teratur. Apabila urutan itu dianggap kurang sesuai maka siswa dapat 

mengubahnya sesuai kehendak masing-masing karena pembelajaran dengan 

modul memungkinkan siswa bergerak sesuai iramanya masing-masing. 

5) Penggunaan berbagai macam media. 
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      Modul biasanya menggunakan media di dalam instruksinya untuk mendukung 

siswa agar lebih mudah dalam memahami materi yang ada. Media yang dimaksud 

misalnya ialah diagram, foto, slides, video dan sebagainya. 

6) Partisipasi aktif dari pada siswa. 

      Dalam pembelajaran menggunakan modul, siswa memang dituntut untuk 

berpartisipasi secara aktif dalam pembelajaran karena modul memang disusun 

untuk pembelajaran bersifat self-instruksional. 

7) Adanya reinforcement langsung terhadap respon siswa. 

      Dalam penggunaan modul siswa secara langung mendapatkan konfirmasi 

kegiatannya yang benar dan mendapatkan koreksi langung atas kesalahan kegiatan 

yang dilakukan. Hal ini karena modul akan menunjukkan hasil dari setiap 

kegiatan pembelajaran yang dilakukan. 

8) Adanya evaluasi terhadap penguasaan siswa atas hasil belajarnya. 

      Modul menyediakan evaluasi berupa uji kompetensi di setiap kompetensi 

dasar yang diajarkan. Uji kompetensi tersebut dilengkapi dengan kunci jawaban 

yang diletakkan dibagian akhir agar siswa bisa mengukur kemampuannya sendiri. 

Hal itu akan memperkecil kemungkinan kegagalan dan memberikan keyakinan 

bahwa siswa telah menguasai materi yang ada. 

4. Media Pembelajaran 

a. Pengertian Media Pembelajaran 

      Kata media berasal dari bahasa latin medius yang secara harfiah berarti 

‘tengah’, ‘perantara’ atau ‘pengantar’. Dalam bahasa Arab, media adalah 

perantara atau pengantar pesan dari pengirim kepada penerima pesan. Yang 
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dimaksud dengan perantara atau pengantar di dalam media pembelajaran ialah 

sesuatu yang akan mengantarkan siswa untuk memahami dan menguasai suatu 

materi pelajaran. Menurut Azhar Arsyad (2011: 4), media pembelajaran adalah 

media yang membawa pesan-pesan atau informasi yang bertujuan instruksional 

atau mengandung maksud-maksud pengajaran. Jadi jika suatu media mengandung 

sesuatu tentang pengajaran maka media tersebut dapat disebut dengan media 

pembelajaran. Misalnya suatu dvd. Dvd biasa tidak dapat disebut sebagai media 

pembelajaran. Namun jika dvd tersebut berisi materi pelajaran TIK misalnya, 

maka dvd tersebut dapat dikatakan sebagai sebuah media pembelajaran.  

b. Manfaat Media Pembelajaran 

      Menurut Azhar Arsyad (2011: 26), ada beberapa manfaat praktis dari 

penggunaan media pembelajaran. Di antaranya ialah: 

1) Media pembelajaran dapat memperjelas penyajian pesan dan informasi 

sehingga dapat memperlancar dan meningkatkan proses dan hasil belajar. 

      Dengan media pembelajaran maka pembelajaran menjadi lebih jelas. Siswa 

dapat sambil menggunakan media pembelajarannya sambil memperhatikan 

penjelasan guru sehingga proses penyampaian materi pelajaran menjadi lebih 

cepat dipahami. 

2) Media pembelajaran dapat meningkatkan dan mengarahkan perhatian anak 

sehingga dapat menimbulkan motivasi belajar, interaksi yang lebih 

langsung antara siswa dan lingkungannya, dan kemungkinan siswa untuk 

belajar sendiri-sendiri sesuai dengan kemampuan dan minatnya. 
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      Media pembelajaran yang  menarik tentunya akan membuat siswa untuk 

semangat belajarnya sehingga materi pelajaran akan lebih cepat diterima jika 

siswa sudah semangat dalam belajar. 

3) Media pembelajaran dapat mengatasi keterbatasan indera, ruang dan 

waktu. 

      Media pembelajaran dapat menunjukkan hal yang sulit dijelaskan apabila 

hanya menggunakan ceramah saja. Misalnya objek yang rumit seperti komponen-

komponen komputer yang akan lebih mudah dipahami siswa bila ditunjukkan 

dengan foto maupun video. 

4) Media pembelajaran dapat memberikan kesamaan pengalaman kepada 

siswa tentang peristiwa-peristiwa di lingkungan. 

      Misalnya ialah media pembelajaran simulasi perakitan komputer 

menggunakan flash. Meskipun hanya berupa simulasi akan tetapi dapat 

memberikan kesamaan pengalaman dengan yang menggunakan komputer secara 

nyata sehingga dapat menghemat biaya dan tempat. 

5. Hasil Belajar 

a. Pengertian Hasil Belajar 

      Hasil belajar terbentuk dari dua kata yaitu hasil dan belajar. Hasil merupakan 

respon atau tanggapan dari sebuah proses yang menjadikan sesuatu yang lebih 

baik dari sebelumnya. Belajar adalah proses untuk membuat perubahan dalam diri 

mahasiswa dengan cara berinteraksi dengan lingkungan untuk mendapatkan 

perubahan dalam aspek kognitif, afektif dan psikomotorik (Purwanto, 2013: 43). 
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Perubahan itu diperoleh melalui usaha, menetap dalam waktu yang relatif lama 

dan merupakan hasil pengalaman. 

      Hasil belajar adalah hasil yang dicapai dari proses belajar-mengajar sesuai 

dengan tujuan pendidikan (Purwanto, 2013: 54). Jika hasil belajar sudah sesuai 

dengan tujuan pendidikan maka proses pembelajaran sudah dapat dianggap 

berhasil. 

b. Domain Hasil Belajar 

      Domain hasil belajar adalah perilaku-perilaku kejiwaan yang akan diubah 

dalam proses pendidikan (Purwanto, 2013: 48). Perilaku kejiwaan tersebut dibagi 

menjadi tiga domain yaitu kognitif, psikomotorik dan afektif. 

1) Kognitif 

      Kognitif menyangkut nilai-nilai dalam hal jangkauan/ penguasaan 

pengetahuan (Suprihatin Guhardja, 1993: 6). Contohnya yaitu: mengetahui, 

memahami, menganalisis, mensintesis dan tahapan tertinggi yaitu mengevaluasi. 

2) Psikomotorik 

      Psikomotorik adalah sumber daya berupa kekuatan gerak fisik untuk 

mengerjakan suatu pekerjaan serta kemampuan untuk menggunakan peralatan 

(Suprihatin Guhardja, 1993: 8). Contohnya seperti tulisan tangan, menggambar, 

mengetik dan sebagainya. 

3) Afektif 

      Afektif merupakan ciri pribadi yang nampak sebagai sumber daya dalam 

hubungan antara personal dan dalam penggunaan sumber daya materi (Suprihatin 
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Guhardja, 1993: 6). Contohnya seperti  minat, sikap, apresiasi, dan cara 

penyesuaian diri. 

6. Mata Pelajaran Teknologi Informasi dan Komunikasi (TIK) 

      Mata pelajaran Teknologi Informasi dan Komunikasi (TIK) adalah salah satu 

mata pelajaran yang dimasukkan dalam kurikulum Sekolah Menengah Atas. Mata 

pelajaran TIK lebih dikenal oleh siswa sebagai pelajaran komputer. Mata 

pelajaran TIK selalu berkembang dari waktu ke waktu seiring dengan 

perkembangan teknologi informasi dan komunikasi. Perkembangan teknologi 

informasi dan komunikasi berkembang sangat pesat dari sisi hardware maupun 

software. Oleh karena itu sekolah benar-benar dituntut untuk selalu mengikuti 

dengan menggunakan hardware dan software sesuai dengan perkembangan 

zaman. 

      Visi mata pelajaran Teknologi Informasi dan Komunikasi (TIK) yaitu agar 

siswa dapat menggunakan perangkat Teknologi Informasi dan Komunikasi secara 

tepat dan optimal untuk mendapatkan dan memproses informasi dalam kegiatan 

belajar, bekerja dan aktfitas lainnya sehingga siswa mampu berkreasi, 

mengembangkan sikap inisiatif, mengembangkan kemampuan eksplorasi mandiri 

dan mudah beradaptasi dengan perkembangan yang baru (Departemen Pendidikan 

Nasional, 2007: 6). Dari visi mata pelajaran TIK tersebut dapat ditarik kesimpulan 

bahwa kurikulum mata pelajaran TIK ini digunakan untuk mempersiapkan siswa 

secara dini di dunia kerja. Hal ini dikarenakan saat ini hampir semua kegiatan di 

dunia kerja membutuhkan penggunaan Teknologi Informasi dan Komunikasi. Jika 
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kualitas pembelajaran ini baik tentunya akan berdampak baik pada perekonomian 

nasional. 

 

B. Penelitian yang Relevan 

      Penelitian yang relevan terhadap penelitian ini yaitu: 

1. Sri Hastuti (2011) melakukan penelitian tentang hubungan pemanfaatan situs 

jejaring sosial facebook dengan penguasaan mata pelajaran TIK pada siswa 

SMP Negeri di Kota Yogyakarta. Hasil penelitian menyatakan bahwa ada 

hubungan yang positif antara pemanfaatan situs jejaring sosial facebook 

dengan penguasaan mata pelajaran TIK pada siswa SMP Negeri di Kotamadya 

Yogyakarta dengan nilai r hitung yang lebih besar dari r tabel (0,253 > 0,05) 

dari taraf siginifikansi sebesar 5%. Penelitian ini masih sebatas penelitian 

survey. Artinya penelitian ini baru sebatas mengungkap hubungan pemanfaatan 

situs jejaring sosial facebook dengan penguasaan mata pelajaran TIK dari 

survey menggunakan angket. Penelitian ini belum mencoba menerapkan 

pemanfaatan jejaring sosial facebook pada pembelajaran mata pelajaran TIK 

yang sebenarnya. Jadi masih ada kemungkinan terdapat  siswa yang mengisi 

angket tidak pada kondisi yang sebenarnya. Pada kesempatan kali ini akan 

mencoba untuk menutup kelemahan dari penelitian survey dengan 

menggunakan metode penelitian eksperimen, yaitu dengan mencobakan 

langsung penggunaan jejaring sosial facebook sebagai media pembelajaran 

mata pelajaran TIK. Dengan begitu akan terlihat lebih jelas apakah 
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pemanfaatan jejaring sosial facebook sebagai media pembelajaran dapat 

bermanfaat dalam pembelajaran mata pelajaran TIK atau tidak. 

2. Amy Julia (2012) melakukan penelitian tentang pemanfaatan situs jejaring 

sosial facebook sebagai media pembelajaran TIK bagi siswa kelas XI SMA 

Negeri 1 Depok Sleman Yogyakarta. Hasil penelitian menyatakan bahwa hasil 

belajar pada mata pelajaran TIK dengan memanfaatkan situs jejaring sosial 

facebook sebagai media pembelajaran lebih tinggi daripada tidak 

memanfaatkan situs jejaring sosial facebook sebagai media pembelajaran 

dengan data signifikansi 0,00 < 0,05. Penelitian ini sudah menerapkan 

pemanfaatan jejaring sosial facebook pada pembelajaran mata pelajaran TIK 

yang sebenarnya sehingga kelemahan penelitian survey sudah ditutup pada 

penelitian ini. Penelitian ini menggunakan metode eksperimen dengan 

membandingkan kelas yang diberi perlakuan tambahan dengan menggunakan 

jejaring sosial facebook sebagai media pembelajaran (kelas eksperimen) 

dengan kelas konvensional yang hanya menerapkan pembelajaran seperti 

biasanya dan tidak diberi perlakuan tambahan (kelas kontrol). Dikarenakan 

kelas kontrol tidak diberi perlakuan tambahan maka akan ada indikasi bahwa 

kelas yang diberi perlakuan tambahan tentunya akan mendapatkan hasil yang 

lebih baik. Akan ditutup kekurangan dari penelitian ini dengan menambahkan 

perlakuan pada kelas kontrol dengan memberikan modul. Jadi akan terlihat 

apakah terdapat perbedaan hasil belajar kelas yang memanfaatkan jejaring 

sosial facebook sebagai media pembelajaran apabila dibandingkan dengan 

media pembelajaran lain seperti modul. 
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C. Kerangka Pikir 

      Media pembelajaran facebook diyakini dapat berpengaruh positif terhadap 

hasil belajar siswa dan hasil belajarnya dapat lebih baik daripada menggunakan 

media modul. Dengan facebook yang digunakan sebagai media pembelajaran, 

siswa dapat mengakses materi di mana saja dan kapan saja menggunakan 

handphone tanpa harus membawa buku maupun modul kemanapun siswa pergi 

sehingga lebih praktis. Selain itu dalam proses pembelajaran menggunakan media 

pembelajaran facebook, guru dapat menyampaikan materi walaupun tidak sedang 

bertatap muka dengan siswa. Interaksi tanya-jawab antara guru dan siswa pun bisa 

dilakukan ketika di luar jam pelajaran bahkan ketika di luar sekolah sekalipun. 

Siswa dapat menanyakan materi pelajaran yang tidak paham ketika di luar sekolah 

dan guru dapat menjelaskannya melalui media jejaring sosial facebook. Dengan 

demikian akan sangat membantu siswa ketika sedang kesulitan belajar saat di luar 

sekolah. Berdasarkan asumsi tersebut diperkirakan terdapat perbedaan hasil 

belajar mata pelajaran TIK siswa kelas XI SMA Muhammadiyah 1 Muntilan yang 

menggunakan jejaring sosial facebook sebagai media pembelajaran dan yang 

menggunakan modul. 

      Setelah pembelajaran dengan media pembelajaran facebook selesai dilakukan 

dan hasil belajarnya sudah diketahui, maka selanjutnya ialah menganalisis 

tanggapan siswa kelas eksperimen di SMA Muhammadiyah 1 Muntilan yang 

menggunakan jejaring sosial facebook sebagai media pembelajaran. Sebelum 

penelitian ini dilakukan, siswa belum pernah menggunakan jejaring sosial 

facebook sebagai media pembelajaran. Siswa hanya tahu penggunaan facebook 
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sebagai aspek sosial saja. Selain itu guru di SMA Muhammadiyah 1 Muntilan 

juga belum pernah mengenalkan penggunaan jejaring sosial facebook sebagai 

media pembelajaran. Berdasarkan asumsi tersebut diperkirakan tanggapan siswa 

kelas eksperimen di SMA Muhammadiyah 1 Muntilan terhadap penggunaan 

jejaring sosial facebook sebagai media pembelajaran diperkirakan masih dalam 

kategori rendah. 

 

D. Hipotesis 

      Hipotesis merupakan jawaban sementara terhadap rumusan masalah, 

dikatakan sementara karena jawaban ini masih didasarkan pada kajian teoritis dan 

belum diketahui data dari lapangan. Berdasarkan deskripsi teori, penelitian 

relevan dan kerangka pikir yang telah diuraikan sebelumnya maka hipotesis yang 

diuji dalam penelitian ini adalah: 

Terdapat perbedaan pada hasil belajar mata pelajaran TIK siswa kelas XI SMA 

Muhammadiyah 1 Muntilan yang menggunakan jejaring sosial facebook sebagai 

media pembelajaran dan yang menggunakan modul. 
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BAB III 

METODE PENELITIAN 

 

A. Metode Penelitian 

      Penelitian ini merupakan penelitian kuantitatif dengan bentuk rumusan 

masalah komparatif. Penelitian kuantitatif adalah penelitian yang berlandaskan 

pada filsafat positivisme, digunakan untuk meneliti pada populasi atau sampel 

tertentu, teknik pengambilan sampel pada umumnya dilakukan secara random, 

pengumpulan data menggunakan instrumen penelitian, analisis data bersifat 

kuantitatif/statistik dengan tujuan untuk menguji hipotesis yang ditetapkan 

(Sugiyono, 2010: 14). Rumusan masalah komparatif adalah rumusan masalah 

penelitian yang membandingkan keberadaan satu variabel atau lebih pada dua 

atau lebih sampel yang berbeda, atau pada waktu yang berbeda (Sugiyono, 2010: 

57).  

      Metode yang digunakan dalam penelitian ini adalah metode penelitian Quasi 

Experimental dengan bentuk Nonequivalent Control Group Design. Desain ini 

mempunyai kelompok kontrol, tetapi tidak dapat berfungsi sepenuhnya untuk 

mengontrol variabel-variabel luar yang mempengaruhi pelaksanaan eksperimen 

(Sugiyono, 2010: 114). Disebut Nonequivalent Control Group Design karena 

dalam desain ini terdapat dua kelompok yaitu kelompok eksperimen dan 

kelompok kontrol yang diberi pretest dan posttest sama sepeti pada Pretest-

Posttest Contol Group Design pada metode True Experimental Design, hanya 

bedanya pada desain ini kelompok eksperimen maupun kelompok kontrol tidak 
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dipilih secara random. Alasan dipilihnya metode Nonequivalent Control Group 

Design karena dalam penelitian ini sampel tidak dapat dipilih secara random. Hal 

ini dikarenakan tidak dapat merubah anggota kelas yang sudah ada. Untuk itu 

maka kelas eksperimen dan kelas kontrol akan menggunakan kelas yang sudah 

ada. 

      Berikut adalah hubungan dari antar kelompok sampel: 

 

 

 

Gambar 1. Hubungan Antar Kelompok Sampel 

Keterangan: 

O1 = Pretest kelompok eksperimen  

O3  = Pretest kelompok kontrol  

O2  =  Posttest kelompok eksperimen  

O4 =  Posttest kelompok kontrol  

X  =  Perlakuan jejaring sosial facebook sebagai media pembelajaran 

Y  =  Perlakuan modul sebagai media pembelajaran 

      Terdapat dua kali analisis. Analisis yang pertama adalah analisis pretest pada 

kelompok eksperimen dan kelompok kontrol (O1-O3). Hal yang diharapkan tidak 

terdapat perbedaan antara pretest kelompok eksperimen dan kelompok kontrol. 

Analisis yang kedua ialah untuk menguji hipotesis yang diajukan. Yang diuji 

adalah perbedaan antara O2 dan O4. Kalau terdapat perbedaan di mana rata-rata 

nilai O2 lebih besar dari O4 maka penggunaan jejaring sosial facebook sebagai 

media pembelajaran berpengaruh positif terhadap pembelajaran TIK di SMA 

 O1     X     O2 

 O3     Y     O4 
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Muhammadiyah 1 Muntilan dan jejaring sosial  facebook dapat digunakan sebagai 

media pembelajaran. Berikut adalah diagram alur penelitian: 

 

Gambar 2. Diagram Alur Penelitian 

 

Identifikasi Masalah dan Tujuan Penelitian 

Studi Literatur 

Pembuatan RPP, Modul, Soal Tes, Kuesioner 

1. Proses Judgement  RPP, Modul, Soal Tes, Kuesioner 

2. Proses perbaikan Judgement  RPP, Modul , Soal Tes, Kuesioner 

3. Proses uji coba Instrumen Soal Tes 

4. Analisis hasil uji coba Instrumen Soal Tes 

(Kelas Eksperimen) 

Perlakuan pembelajaran dengan 

media pembelajaran facebook 

(Kelas Kontrol) 

Perlakuan pembelajaran dengan 

media pembelajaran modul 

 

Pretest 

Posttest 

Pembahasan Hasil Penelitian 

Pengolahan Data dan Analisis Hasil Penelitian 

Penarikan Kesimpulan 
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B. Variabel Penelitian 

      Variabel penelitian adalah suatu atribut, sifat, aspek dari orang atau objek yang 

mempunyai variasi tertentu yang ditetapkan peneliti untuk dipelajari dan ditarik 

kesimpulan (Sugiyono, 2011: 61). Variabel dalam penelitian ini adalah: 

1. Pada rumusan masalah yang pertama variabel yang diukur ialah variabel hasil 

belajar. 

2. Pada rumusan masalah yang kedua variabel yang diukur ialah penggunaan 

jejaring sosial facebook sebagai media pembelajaran 

 

C. Lokasi dan Jadwal Penelitian 

      Penelitian ini dilaksanakan di SMA Muhammadiyah 1 Muntilan. SMA 

Muhammadiyah 1 Muntilan terletak di Jalan Tentara Pelajar, Muntilan. Alasan 

pemilihan tempat ini sebagai lokasi penelitian yaitu karena sudah mengamati 

secara umum penggunaan facebook di SMA Muhammadiyah 1 Muntilan saat 

diadakan KKN-PPL dan dapat disimpulkan bahwa sekolah ini sangat cocok untuk 

dijadikan objek penelitian ini dikarenakan semua siswa yang belum dapat 

memanfaatkan jejaring facebook sebagai media pembelajaran sehingga facebook 

hanya mengganggu proses pembelajaran siswa.  

      Untuk jadwal penelitiannya, diadakan pada bulan Mei 2013. Pada bulan Mei 

ini kegiatannya ialah melakukan pembelajaran pada kelas eksperimen dengan 

media pembelajaran facebook dan melakukan pembelajaran pada kelas kontrol 

dengan media modul serta melakukan pretest dan posttest pada kedua kelas 

tersebut.  
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      Setelah pembelajaran dan tes selesai dilakukan, di bulan Juni dibagikan 

kuesioner kepada kelas eksperimen untuk mengetahui bagaimana tanggapan siswa 

kelas eksperimen di SMA Muhammadiyah 1 Muntilan terhadap penggunaan 

jejaring sosial facebook sebagai media pembelajaran. 

 

D. Populasi dan Sampel Penelitian 

      Populasi adalah wilayah generalisasi yang terdiri atas objek/subjek yang 

mempunyai kualitas dan karakteristik tertentu yang ditetapkan oleh peneliti untuk 

dipelajari dan kemudian ditarik kesimpulannya (Sugiyono, 2010: 117). Populasi 

dalam penelitian ini adalah siswa kelas XI di SMA Muhammadiyah 1 Muntilan. 

Terdapat 5 kelas IPS dari XI IPS 1 sampai XI IPS 5 dan satu kelas XI IPA. 

      Sampel adalah bagian dari jumlah dan karakteristik yang dimiliki oleh 

populasi tersebut (Sugiyono, 2010: 118). Dalam penelitian ini digunakan teknik 

sampling purposive dalam pengambilan sampelnya, tidak menggunakan teknik 

pengambilan sampel secara random. Sampling purposive adalah teknik penentuan 

sampel dengan pertimbangan tertentu (Sugiyono, 2010: 124). Alasan 

digunakannya teknik pengambilan sampel dengan teknik sampling purposive ialah 

karena tidak dapat mengubah anggota kelas yang sudah ada. Untuk itu maka 

digunakan kelas yang sudah ada di dalam populasi SMA Muhammadiyah 1 

Muntilan. Sampel yang digunakan adalah kelas XI IPS 1 dan XI IPS 3. 

Pertimbangan menggunakan kedua kelas tersebut ialah karena saat pengamatan 

selama KKN-PPL kelas XI IPS 1 dan kelas XI IPS 3 ialah dua kelas yang 

mempunyai kemampuan yang hampir sama. Kelas XI IPS 1 digunakan sebagai 



 
 

32 
 

kelas eksperimen sementara kelas XI IPS 3 digunakan sebagai kelas kontrol. 

Kelas XI IPA tidak dimasukkan ke dalam sampel karena kelas IPA hanya terdapat 

satu kelas, sedangkan apabila dibandingkan dengan kelas IPS maka syarat untuk 

penelitian komparasi tidak terpenuhi dikarenakan kemampuan akademik antara 

kelas IPA dan IPS di SMA Muhammadiyah 1 Muntilan tidak setara. 

 

E. Teknik Pengumpulan Data 

      Teknik pengumpulan data dalam penelitian ini menggunakan dua jenis teknik 

pengumpulan data yaitu tes dan kuesioner. Berikut merupakan penjelasan dari 

kedua teknik pengumpulan data yang digunakan. 

1. Tes 

      Tes adalah serentetan pertanyaan atau latihan serta alat lain yang digunakan 

untuk mengukur ketrampilan, pengetahuan inteligensi, kemampuan atau bakat 

yang dimiliki oleh individu atau kelompok (Suharsimi Arikunto, 2010: 193). Tes 

digunakan untuk mengukur variabel hasil belajar. Pada penelitian ini digunakan 

dua kali tes yaitu pretest dan posttest. Pada kondisi awal, kelompok eksperimen 

dan kelompok kontrol sama-sama diberi pretest untuk mengetahui kemampuan 

awal kedua kelompok ini. Diharapkan tidak terdapat perbedaan antara pretest 

kelas eksperimen dan kelas kontrol. Kelas eksperimen diberi perlakuan dengan 

menggunakan jejaring sosial facebook sebagai media pembelajaran, sedangkan 

kelas kontrol diberi perlakuan dengan menggunakan modul sebagai media 

pembelajaran. Setelah pembelajaran selesai maka diadakan posttest untuk kedua 

kelompok. Jika hasil posttest kelas eksperimen  memiliki perbedaan dengan kelas 



 
 

33 
 

kontrol maka kesimpulannya adalah jejaring sosial facebook dapat digunakan 

sebagai media pembelajaran oleh guru di sekolah.  

      Alasan penggunaan tes sebagai alat pengumpulan data dalam penelitian ini 

ialah karena variabel yang diteliti ialah hasil belajar. Hasil belajar akan terlihat 

jelas jika diukur dengan tes karena hasilnya terlihat nyata. Jika diukur dengan alat 

ukur lain akan sulit dibedakan hasil belajar siswa yang satu dengan yang lainnya.  

2. Kuesioner 

      Kuesioner merupakan teknik pengumpulan data yang memberi seperangkat 

pertanyaan atau pernyataan tertulis kepada responden untuk dijawabnya 

(Sugiyono, 2010: 199). Pada penelitian ini yang diteliti menggunakan kuesioner 

adalah penggunaan jejaring sosial facebook sebagai media pembelajaran. 

Kuesioner diberikan kepada kelas eksperimen untuk mengetahui bagaimana 

tanggapan siswa kelas eksperimen di SMA Muhammadiyah 1 Muntilan terhadap 

penggunaan jejaring sosial facebook sebagai media pembelajaran. Pembagian 

kuesioner dilakukan dengan pembagian butir soal pernyataan yang kemudian 

dijawab oleh responden sesuai pilihan jawaban yang telah disediakan.  

      Alasan penggunaan kuesioner sebagai alat pengumpulan data tanggapan siswa 

kelas eksperimen di SMA Muhammadiyah 1 Muntilan yang menggunakan 

jejaring sosial facebook sebagai media pembelajaran karena kuesioner ialah alat 

pengumpulan data yang paling sesuai untuk mengungkap suatu fakta atau 

pendapat bila subjek sampelnya lebih dari sepuluh orang. Jumlah siswa kelas 

eksperimen pada penelitian ini berjumlah 28 orang.  
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F. Instrumen Peneltian 

1. Penyusunan Instrumen 

      Instrumen adalah alat atau fasilitas yang digunakan oleh peneliti dalam 

mengumpulkan data agar pekerjaannya lebih mudah dan hasilnya lebih baik, lebih 

cermat, lengkap dan sistematis sehingga mudah diolah (Suharsimi Arikunto, 

2010: 192). Instrumen ini sangat membantu ketika penelitian berlangsung sebagai 

pedoman tentang apa yang harus dilakukan selama penelitian. Menurut Suharsimi 

Arikunto (2010: 193), instrumen dibedakan menjadi dua macam yaitu instrumen 

tes dan non-test. 

      Penelitian ini menggunakan dua macam instrumen tersebut, yaitu tes dan non-

test. Instrumen yang berbentuk tes digunakan pada pretest dan posttest untuk 

mengukur hasil belajar siswa sementara instrumen yang berbentuk non-test 

berupa kuesioner digunakan untuk mengetahui tanggapan siswa kelas eksperimen 

di SMA Muhammadiyah 1 Muntilan terhadap penggunaan jejaring sosial 

facebook sebagai media pembelajaran. Instrumen dibuat berdasarkan kisi-kisi. 

Kisi-kisi instrumen dalam penelitian ini adalah sebagai berikut: 

a. Instrumen Tes 

      Kisi-kisi instrumen berbentuk tes pada penelitian ini diambil berdasarkan 

Kompetensi Dasar pada Silabus Kelas XI Mata Pelajaran TIK Semester Genap 

Tahun Ajaran 2012/2013 SMA Muhammadiyah 1 Muntilan mengenai 

penggunaan perangkat lunak Microsoft PowerPoint. Berikut adalah kisi-kisi 

instrumen tes. 
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Tabel 1. Kisi-Kisi Instrumen Tes 

Kompetensi 

Dasar 

Indikator Pretest Posttest Jumlah 

Butir 

Menggunakan 

menu ikon 

yang terdapat 

dalam 

perangkat 

lunak pembuat 

presentasi 

 Mendeskripsikan 

manfaat program 

presentasi 

 

29, 30 1, 2 

 

 

 

2 

 

 

 

 Mengidentifikasi fungsi 

menu, tools dan ikon 

 

26, 27, 28 3, 4 , 5 

 

3 

 

 Membuat presentasi 

dengan template  

 

23, 24, 25 6, 7, 8 

 

3 

 

 Mengatur Layout 

presentasi 

 

21, 22 9, 10 

 

2 

 

 Mengatur format teks 18, 19, 20  11, 12, 13 3 

Jumlah 15 13 

Membuat 

presentasi teks 

dengan variasi 

tabel, grafik, 

gambar dan 

diagram 

 Menyisipkan objek 

berupa  picture 

 

15, 16, 17 14, 15, 16 

 

 

3 

 

 

 Menyisipkan diagram 

 

13, 14 17, 18 

 

2 

 

 Menyisipkan Chart 

 

11, 12 19, 20 

 

2 

 

 Menyisipkan table 

 

9, 10 21, 22 

 

2 

 

 Menyisipkan Word Art 

 

7, 8 23, 24 

 

2 

 

 Menyisipkan audio 

 

5, 6 25, 26 

 

2 

 

 Mengatur efek transisi 

 

3, 4 27, 28 

 

2 

 

 Menentukan durasi 

presentasi 

 

1, 2 29, 30 2 

Jumlah 15 17 

Total 30 
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b. Instrumen Non-Test 

      Instrumen non-test digunakan untuk mengetahui tanggapan siswa kelas 

eksperimen di SMA Muhammadiyah 1 Muntilan terhadap penggunaan jejaring 

sosial facebook sebagai media pembelajaran. Hasil dari kuesioner ini dapat 

mengungkapkan gambaran dari siswa apakah setuju terhadap penggunaan jejaring 

sosial facebook sebagai media pembelajaran. Berikut adalah kisi-kisi instrumen: 

Tabel 2. Kisi-kisi Instrumen Non-Test 

Indikator Sub Indikator Fitur Sub Fitur No. Butir 

Aspek Sosial 

Facebook 

Media yang 

digunakan 
 

 1, 2 

Intensitas 

Penggunaan 
 

 3, 4 

Aspek 

Edukasional 

Facebook 

Intensitas 

Penggunaan 
 

 5, 6, 7 

Penyampaian 

Materi dan 

Diskusi 

Pelajaran 

Link  8, 9 

Note 10, 11 

Grup 

Write Post (Wall) 12, 13 

Add photo 14, 15 

Add video 16, 17 

Ask Question 18, 19 

Add File 20, 21 

Grup secara 

umum 

22, 23 

Pengingat 

Jadwal Evaluasi 
Event 

 24, 25 

 

      Untuk mengukur nilai variabel penelitian agar dapat menghasilkan data yang 

lebih akurat, efisien dan komunikatif digunakan skala dalam bentuk angka. Skala 

pengukuran dalam instrumen non-test ini menggunakan 4 alternatif jawaban. 

Responden menjawab salah satu jawaban kuantitatif yang telah disediakan.  

Berikut adalah penjabaran dari skor masing-masing pilihan jawaban: 
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Tabel 3. Skor Dari Butir Kuesioner 

Pilihan Nilai 

Selalu (SL) 4 

Sering (SR) 3 

Jarang (JR) 2 

Tidak Pernah(TP) 1 

 

2. Uji Instrumen 

      Uji Intrumen dilakukan untuk mengetahui kelayakan perangkat instrumen 

dalam pengambilan data. Instrumen yang baik dan benar dapat diperoleh dengan 

cara menguji coba dan menganalisis instrumen tersebut sebelum dipakai dalam 

pengambilan data. Instrumen penelitian yang diuji cobakan dalam penelitian ini 

adalah berupa instrumen tes dan instrumen non-test.  

a. Instrumen Tes 

      Uji instrumen tes dalam penelitian ini menggunakan analisis butir soal. 

Analisis butir soal atau analisis item adalah pengkajian pertanyaan-pertanyaan tes 

agar diperoleh perangkat pertanyaan yang memiliki kualitas yang memadai (Nana 

Sudjana, 2005: 135). Ada dua jenis analisis butir soal, yakni analisis tingkat 

kesulitan dan analisis daya beda di samping validitas dan reliabilitas (Nana 

Sudjana, 2005: 135). Uji instrumen tes ini dilakukan pada anggota populasi tetapi 

yang di luar sampel. Dalam hal ini, pengujian instrumen tes dicobakan pada kelas 

XI IPA 1. Adapun analisis uji instrumen tes adalah sebagai berikut: 

1) Analisis Tingkat Kesulitan 

      Tingkat kesulitan butir adalah angka yang menunjukkan besarnya proporsi 

peserta tes yang menjawab benar pada suatu butir (Endang Mulyatiningsih, 2012: 
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135). Nilai dari tingkat kesulitan yaitu dari 0,0 sampai 1,0. Jika tingkat kesulitan 

soal bernilai 0,0 berarti tidak ada satupun dari seluruh siswa peserta tes yang 

menjawab soal dengan benar dan kesimpulannya adalah soal tersebut terlalu 

sukar. Sebaliknya, jika tingkat kesulitan soal bernilai 1,0 berarti seluruh siswa 

peserta tes dapat menjawab soal dengan benar dan kesimpulannya adalah soal 

tersebut terlalu mudah. Kriteria tingkat kesulitan soal dapat dijabarkan pada tabel 

berikut: 

Tabel 4. Kriteria Tingkat Kesulitan 

Rentang Kriteria 

0,00 ≤ TK ≤ 0,30 Sulit 

0,31 ≤ TK ≤ 0,70 Sedang 

0,71 ≤ TK ≤ 1,00 Mudah  

            (Suharsimi Arikunto, 2012: 225) 

 

      Pada penelitian ini indeks kesulitan instrumen tes dihitung menggunakan 

software Iteman. Setelah dilakukan uji coba instrumen pada kelas XI IPA 1, hasil 

yang diperoleh untuk analisis uji indeks kesulitan adalah sebagai berikut. 

Tabel 5. Hasil Indeks Kesulitan Butir Soal 

Soal Indeks 

Kesukaran 

Nomor Soal Jumlah 

Pretest Mudah 

 

1, 2, 4, 5, 6, 7, 8, 10, 12, 14, 15, 16, 17, 18, 19, 

21, 22, 24, 25, 26, 27, 28, 29, 30 

24 

Sedang 3, 9, 13, 20, 23 5 

Sulit 11 1 

  Total 30 

Posttest Mudah 1, 2, 4, 5, 6, 8, 9, 11, 12, 13, 15, 18, 21, 22, 23, 

24, 25, 26, 27, 28, 29, 30 

22 

Sedang 7, 10, 14, 16, 20 5 

Sulit 3, 17, 19 3 

  Total 30 
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      Menurut Endang Mulyatiningsih (2012: 173), bahwa tingkat kesulitan suatu 

butir soal dipengaruhi oleh tingkat kemampuan dari anggota kelompok peserta 

tes. Jika suatu soal diujikan pada kelompok siswa yang pandai, indeks kesulitan 

butir kemungkinan banyak yang masuk pada kategori mudah, sementara jika 

diujikan pada kelompok siswa yang kurang pandai, indeks kesulitan butir 

kemungkinan banyak yang masuk pada kategori sulit.  

      Pada penelitian ini soal diujikan pada kelas XI IPA 1 yaitu kelas yang cukup 

banyak memiliki kelompok siswa pandai di SMA Muhammadiyah 1 Muntilan. 

Dan hasilnya ialah sesuai dengan teori yang disampaikan oleh Endang 

Mulyatiningsih yaitu indeks kesulitan butir banyak yang masuk pada kategori 

mudah dengan 24 soal tergolong mudah dalam pretest dan 22 soal tergolong 

mudah dalam posttest. 

      Menurut Suharsimi Arikunto (2012: 173), bahwa soal yang mudah maupun 

soal yang sulit bukan berarti tidak boleh digunakan, hal ini tergantung 

penggunaannya. Maka dari itu kesimpulan dari uji kesulitan soal ini adalah tidak 

ada butir soal yang gugur.  

2) Analisis Daya Beda 

      Daya beda soal adalah kemampuan suatu soal untuk membedakan antara 

siswa yang pandai (berkemampuan tinggi) dengan siswa yang bodoh 

(berkemampuan rendah) (Suharsimi Arikunto, 2012: 226). Nilai dari daya beda 

soal yaitu dari 0,0 sampai dengan 1,0 sama seperti pada tingkat kesulitan soal. 

Bedanya yaitu kalau pada daya beda terdapat nilai negatif. Tanda negatif berarti 

soal terbalik menunjukkan kualitas peserta tes. Yaitu jika anak pandai tidak bisa 
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menjawab soal dengan benar sementara anak kurang pandai justru dapat 

menjawab soal dengan benar. Kriteria tingkat daya beda dapat dijabarkan pada 

tabel berikut: 

Tabel 6. Kriteria Daya Pembeda 

Indeks Pembeda Kategori 

D ≤ 0,20 Jelek 

0,21 ≤ D ≤ 0,40 Cukup 

0,41 ≤D ≤ 0,70 Baik 

0,71 ≤D ≤ 1,00 Baik Sekali 

(Suharsimi Arikunto, 2012: 232) 

 

      Pada penelitian ini indeks daya beda instrumen tes dihitung menggunakan 

software Iteman. Setelah dilakukan uji coba instrumen pada kelas XI IPA 1, hasil 

yang diperoleh untuk analisis uji indeks daya beda adalah sebagai berikut. 

Tabel 7. Hasil Daya Pembeda Butir Soal 

Soal Daya Beda Nomor Soal Jumlah 

Pretest Jelek - 0 

Cukup  - 0 

Baik 3, 4, 6, 9, 10, 11, 12, 13, 15, 16, 

18, 20, 22, 23, 25, 27, 28, 30 

18 

Baik Sekali 1, 2, 5, 7, 8, 14, 17, 19, 21, 24, 

26, 29 

12 

Total 30 

Posttest Jelek 4, 19, 24 3 

Cukup  10, 17 2 

Baik 3, 6, 14, 16, 27, 29 6 

Baik Sekali 1, 2, 5, 7, 8, 9, 11, 12, 13, 15, 

18, 20, 21, 22, 23, 25, 26, 28, 30 

19 

Total 30 
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      Menurut Endang Mulyatingsih (2012: 174), jika soal mempunyai daya beda 

yang jelek maka kemungkinan terjadi banyak peserta tes yang menjawab dengan 

menebak sehingga soal yang mempunyai daya beda jelek harus dibuang karena 

tidak mampu membedakan siswa yang pandai dan kurang pandai. Dari teori 

tersebut dapat disimpulkan bahwa dalam pengujian daya beda ini pada pretest 

semua soal lolos sementara pada soal posttest terdapat tiga soal yang harus 

dibuang yaitu soal no 4, 19 dan 24. 

3) Uji Validitas 

      Instrumen dikatakan valid apabila instrumen tersebut dapat dengan tepat 

mengukur apa yang hendak diukur (Eko Putro, 2012: 141). Dengan kata lain 

validitas berkenaan dengan ketepatan dengan alat ukur. Jika menggunakan 

instrumen yang valid, tentunya didapatkan data yang valid pula. Uji validitas 

dilakukan dengan mencobakannya langsung ke dalam populasi yang di luar 

sampel yaitu kelas XI IPA 1. 

      Setelah dicobakan ke kelas XI IPA 1, koefisien validitas instrumen dihitung 

menggunakan software iteman. Penafsiran nilai koefisien validitas dilakukan 

dengan membandingkan nilai r hasil perhitungan iteman dengan nilai r yang ada 

dalam tabel r. Nilai r untuk N= 30 dengan taraf signifikansi 5% adalah 0,361. Jadi 

untuk nilai r yang kurang dari 0,361 adalah tidak valid. Dari perhitungan iteman 

dan setelah dibandingkan dengan r tabel maka hasil validitas dapat disimpulkan 

dalam tabel berikut: 

 

 

 



 
 

42 
 

Tabel 8. Hasil Validitas Butir Soal 

Tes Validitas Nomor Soal Jumlah 

Pretest Valid 

 

1, 2, 3, 4, 5, 6, 7, 8, 

9, 10, 11, 12, 13, 14, 

15, 16, 17, 18, 19, 

20, 21, 22, 23, 24, 

25, 26, 27, 28, 29, 

30 

30 

Tidak Valid - 0 

Posttest Valid 

 

1, 2, 3, 5, 6, 7, 8, 9, 

11, 12, 13, 14, 15, 

16, 18, 20, 21, 22, 

23, 25, 26, 27, 28, 

29, 30 

25 

Tidak Valid 4, 10, 17, 19, 24 5 

 

      Menurut Eko Putro (2012: 150), analisis selanjutnya hanya dilakukan terhadap 

data dari butir-butir instrumen yang valid saja, sedangkan butir instrumen yang 

tidak valid harus dikeluarkan atau dibuang. Dari teori tersebut dapat disimpulkan 

bahwa dalam pengujian validitas pada pretest semua soal lolos sementara pada 

soal posttest terdapat lima soal yang harus dibuang yaitu soal no 4, 10, 17, 19 dan 

24. 

4) Uji Reliabilitas 

      Kata reliabilitas dalam bahasa Indonesia diambil dari kata reliability dalam 

bahasa Inggris. Instrumen tes dapat dikatakan reliable jika memberikan hasil yang 

tetap atau konsisten apabila diujikan berkali-kali. Jika kepada siswa diberikan tes 

yang sama pada waktu yang berlainan, maka siswa tetap berada dalam urutan 
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(ranking) yang sama dalam kelasnya. Misalnya jika tes pertama mendapat nilai 85 

maka tes selanjutnya juga mendapat nilai 85 juga. Seandainya terjadi perubahan 

hasil, perubahan itu dapat dikatakan tidak berarti. Misalnya menjadi 84 maupun 

86. 

      Pengujian reliabilitas instrumen tes pada penelitian ini menggunakan 

reliabilitas internal. Reliabilitas internal diperoleh dengan cara menganalisis data 

dari satu kali pengumpulan data (Eko Putro, 2012: 160). Hasil perhitungan 

selanjutnya dibandingkan dengan tabel berikut sebagai patokan untuk mengetahui 

reliabilitas instrumen. 

Tabel 9. Pedoman Tingkat Reliabilitas Instrumen 

Interval Koefisien Tingkat Hubungan 

0,00 – 0,199 Sangat Rendah 

0,20 – 0,399 Rendah 

0,40 – 0,599 Sedang 

0,60 – 0,799 Kuat 

0,80 – 1,000 Sangat Kuat 

 

(Sugiyono, 2010: 231) 

 

 

      Pada penelitian ini koefisien reliabilitas instrumen dihitung menggunakan 

software iteman. Setelah dilakukan uji coba instrumen, hasil yang diperoleh untuk 

analisis uji reliabilitas pada pretest adalah sebesar 0,884 dan pada posttest sebesar 

0,857. Karena nilai reliabilitas pada pretest sebesar 0,884 dan pada posttest 

sebesar 0,857 maka kedua instrumen tes tersebut memiliki reliabilitas yang sangat 

kuat dan layak digunakan untuk penelitian. 
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b. Instrumen Non-Test 

      Uji instrumen non-test (kuesioner) pada penelitian ini menggunakan metode 

validasi terpadu yaitu dengan mencobakan langsung ke kelas eksperimen 

dikarenakan hanya kelas ini yang menggunakan jejaring sosial facebook sebagai 

media pembelajaran. Butir kuesioner yang valid digunakan untuk dianalisis 

sementara butir kuesioner yang tidak valid dibuang. Adapun analisis uji instrumen 

non-test adalah sebagai berikut: 

1) Uji Validitas 

      Koefisien validitas instrumen dihitung menggunakan software SPSS. 

Penafsiran nilai koefisien validitas dilakukan dengan membandingkan harga r 

hasil perhitungan SPSS dengan r yang ada dalam tabel r. Nilai r untuk N= 28 

dengan taraf signifikansi 5% adalah 0,374. Jadi untuk nilai r yang kurang dari 

0,374 adalah tidak valid. Dari 22 butir instrumen dalam kuesioner terdaapat dua 

butir yang mempunyai nilai r di bawah 0,374 yaitu butir no 17 dengan nilai r= 

0,181 dan butir no 22 dengan nilai r= 0,161. Sesuai teori dalam uji validitas 

karena kedua butir terebut tidak valid maka butir no 17 dan no 22 harus dibuang. 

2) Uji Reliabilitas 

      Pada penelitian ini untuk menghitung koefisien reliabilitas instrumen 

menggunakan software SPSS. Setelah dilakukan uji coba instrumen, hasil yang 

diperoleh untuk analisis uji reliabilitas instrumen non-test ini adalah sebesar 

0,876. Karena nilai reliabilitas pada instrumen non-test ini sebesar 0,876 maka 

instrumen non-test ini memiliki reliabilitas yang sangat kuat dan layak digunakan 

untuk penelitian. 
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G. Teknik Analisis Data 

      Teknik analisis data yang digunakan dalam penelitian ini dibagi menjadi dua 

tahap. Tahap pertama ialah dengan menganalisis data hasil instrumen tes berupa 

pretest dan posttest untuk menjawab hipotesis yang diajukan dengan 

menggunakan teknik pengolahan data secara kuantitatif. Sedangkan tahap kedua 

ialah menganalisis data dari instrumen non-test (kuesioner) untuk mengetahui 

tanggapan siswa terhadap penggunaan jejaring sosial facebook sebagai media 

pembelajaran TIK kelas XI dengan menggunakan analisis data secara deskriptif. 

1. Instrumen Tes 

      Teknik analisis data instrumen tes yang digunakan dalam penelitian ini dibagi 

menjadi empat tahap. Tahap pertama ialah dengan menjabarkan data hasil 

penelitian melalui statistik deskriptif. Tahap kedua ialah melakukan uji prasyarat 

analisis guna menentukan jenis analisis yang digunakan untuk menguji hipotesis 

penelitian. Tahap ketiga adalah menguji kesamaan kemampuan kelompok dan 

tahap yang terakhir adalah menguji hipotesis yang diajukan. 

a. Statistik Deskriptif 

      Statisitik deskriptif adalah statistik yang berfungsi untuk mendeskripsikan atau 

memberi gambaran terhadap obyek yang diteliti melalui data sampel atau populasi 

sebagaimana adanya, tanpa melakukan analisis dan membuat kesimpulan yang 

berlaku untuk umum (Sugiyono, 2010: 29).  

      Pada penelitian ini penghitungan statistik deskriptif dilakukan dengan 

menggunakan software SPSS. Yang dihitung pada statistik deskriptif ini antara 
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lain mean, median, nilai minimum, nilai maksimum, standar deviasi dan yang 

terakhir ialah data digambarkan dalam sebuah diagram batang. 

b. Uji Prasyarat Analisis 

      Sebelum analisis data dilakukan, terlebih dahulu dilakukan uji prasyarat 

analisis. Langkah ini penting karena hasilnya menentukan teknik analisis yang 

harus dilakukan. Uji prasyarat analisis meliputi: 

1) Uji Normalitas 

      Uji normalitas dilakukan untuk mengetahui apakah data dari masing-masing 

kelompok sampel berdistribusi normal atau tidak. Menurut Sugiyono (2010: 79), 

jika data berdistribusi normal maka analisis data menggunakan teknik statistik 

parametris, sementara jika data berdistribusi tidak normal maka menggunakan 

teknik statistik nonparametris. Data-data yang diuji pada normalitas adalah nilai 

pretest dan posttest untuk kelas eksperimen maupun kontrol.  

      Pada penelitian ini uji normalitas dilakukan dengan menggunakan software 

SPSS yaitu dengan uji Kolmogorov Smirnov. Hasil perhitungan dari SPSS 

dibandingkan dengan kriteria pengujian sebagai berikut: 

 Angka signifikansi (sig) >0,05, maka data berdistribusi normal 

 Angka signifikansi (sig) <0,05, maka data tidak berdistribusi normal 

(Singgih Santoso, 2010: 46) 

2) Uji Homogenitas 

      Uji homogenitas digunakan untuk mengetahui apakah masing-masing 

kelompok sampel mempunyai varian yang sama atau tidak. Pengujian 

homogenitas sampel menjadi sangat penting apabila bermaksud melakukan 
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generalisasi untuk hasil penelitiannya serta penelitian yang data penelitiannya 

diambil dari kelompok-kelompok terpisah yang berasal dari satu populasi 

(Suharsimi Arikunto, 2010: 364). 

      Pada penelitian ini uji homogenitas dilakukan dengan menggunakan software 

SPSS yaitu dengan uji Levene. Hasil perhitungan dari SPSS dibandingkan dengan 

kriteria pengujian sebagai berikut: 

 Angka signifikansi (sig) >0,05, maka varian populasi adalah identik 

(homogen) 

 Angka signifikansi (sig) <0,05, maka varian populasi adalah tidak identik 

(tidak homogen) 

(Singgih Santoso, 2010: 51) 

c. Uji Kesamaan Kemampuan Kelompok 

      Uji kesamaan kemampuan kelompok dalam penelitian ini digunakan untuk 

mengetahui apakah kemampuan awal siswa kelas kontrol dan kelas eksperimen 

seimbang. Jika kemampuan kedua kelas seimbang maka penelitian dapat 

dilanjutkan. Akan tetapi jika kemampuan kedua kelas berbeda maka harus 

mengganti dengan kelas yang lain yang mempunyai kemampuan yang seimbang 

dan untuk mengetahuinya harus diadakan ujian pretest kembali pada kelas baru 

yang dipilih untuk menggantikan kelas yang lama tersebut. 

d. Uji Hipotesis 

      Uji hipotesis dalam penelitian ini digunakan untuk mengetahui ada tidaknya 

perbedaan hasil belajar antara kelas eksperimen yang menggunakan jejaring sosial 

facebook sebagai media pembelajaran dengan kelas kontrol yang menggunakan 
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modul sebagai media pembelajaran. Ada dua macam cara untuk melakukan uji 

hipotesis dalam penelitian ini. Ketentuannya adalah sebagai berikut: 

1) Uji-T Dua Sampel Independen (Independent-Samples t Test) digunakan 

untuk membandingkan selisih dua purata (mean) dari dua sampel yang 

independen dengan asumsi data terdistribusi normal (Stanislaus Uyanto, 

2009: 137). 

2) Uji Mann-Whitney (Mann-Whitney Test) digunakan untuk membandingkan 

dua sampel independen dengan skala ordinal atau skala interval tapi tidak 

terdistribusi normal (Stanislaus Uyanto, 2009: 321). 

      Pada penelitian ini uji hipotesis dilakukan dengan menggunakan software 

SPSS yaitu dengan salah satu di antara Uji-T atau Uji Mann-Whitney tergantung 

dari data instrumen tes berdistribusi normal atau tidak. Untuk menjawab hipotesis 

yang diajukan, maka hasil perhitungan dari Uji-T atau Uji Mann-Whitney 

dibandingan dengan taraf signifikansi 0,05 dengan ketentuan sebagai berikut: 

 Jika signifikansi <0,05, maka Ho ditolak 

 Jika signifikansi ≥0,05, maka Ho diterima 

(Stanislaus Uyanto, 2009: 137) 

2. Instrumen Non-Test 

      Teknik analisis data instrumen non-test menggunakan teknik analisis deskripsi 

data. Untuk mengetahui bagaimana tanggapan siswa terhadap pembelajaran 

dengan menggunakan jejaring sosial  facebook dilakukan pengkategorian skor 

total yang diperoleh masing-masing butir siswa. Pengkategorian dilaksanakan 

berdasarkan rata-rata dan simpangan baku yang diperoleh. 
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      Pengkategorian dibagi menjadi 4 kategori sebagai berikut: 

  Tabel 10. Kategori Tanggapan Siswa 

Skor Siswa Kategori 

x ≥ M + SD Sangat positif/sangat tinggi 

M + SD > x ≥ M Tinggi/ positif 

M > x ≥ M – SD Negatif/ Rendah 

x < M – SD Sangat negatif/rendah 

 

(Djemari Mardhapi, 2008: 123) 

 

Keterangan: 

M : Mean/ rata-rata skor keseluruhan siswa 

SD: Standar Deviasi/ simpangan baku skor keseluruhan siswa 

X : skor total yang dicapai siswa 
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BAB IV 

HASIL PENELITIAN DAN PEMBAHASAN 

 

A. Hasil Penelitian 

      Pada bab ini dikemukakan hasil penelitian, analisis data dan pembahasan. 

Penelitian ini dilaksanakan di SMA Muhammadiyah 1 Muntilan. Sampel pada 

penelitian ini adalah siswa kelas XI IPS 1 berjumlah 28 anak sebagai kelas 

eksperimen dan siswa kelas XI IPS 3 berjumlah 31 anak sebagai kelas kontrol. 

Masing-masing kelas diberi perlakuan dengan metode pembelajaran yang 

berbeda. Kelas eksperimen diberi perlakuan dengan menggunakan jejaring sosial 

facebook sebagai media pembelajaran sementara kelas kontrol diberi perlakuan 

dengan menggunakan modul sebagai media pembelajaran. Penelitian terhadap 

sampel dilakukan selama 4 kali pertemuan dengan materi Microsoft PowerPoint. 

Banyaknya pertemuan ini disesuaikan dengan standar kompetensi dan kompetensi 

dasar yang harus dicapai oleh siswa. Data yang diperoleh dari penelitian ini 

adalah hasil tes yaitu pretest dan posttest. Pretest diberikan kepada siswa sebelum 

pembelajaran untuk mengetahui kemampuan awal siswa, sedangkan posttest 

diberikan kepada siswa setelah pembelajaran selesai untuk mengetahui 

kemampuan siswa setelah diberikan perlakuan. Pengambilan data kuesioner untuk 

mengetahui tanggapan siswa terhadap penggunaan facebook sebagai media 

pembelajaran diberikan kepada kelas eksperimen di SMA Muhammadiyah 1 

Muntilan setelah pembelajaran dengan media pembelajaran facebook selesai 

dilakukan. 
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1. Analisis Hasil Tes 

      Analisis hasil tes dibagi menjadi tiga tahap yaitu Statistik Deskriptif, Uji 

Prasyarat Analisis dan Uji Hipotesis.  

a. Statistik Deskriptif 

1) Pretest 

a) Pretest Kelas Eksperimen 

      Data untuk pretest kelas eksperimen (kelas yang menggunakan jejaring sosial 

facebook sebagai media pembelajaran) diambil dari hasil ujian tes kemampuan 

awal yang diujikan pada tanggal 7 Mei 2013. Berikut ini merupakan statistik 

deskriptif hasil perhitungan data pretest kelas eksperimen yang dihitung 

menggunakan program SPSS: 

Tabel 11. Hasil Deskriptif Pretest Kelas Eksperimen 

 

Statistics 

Pretest KelasEksperimen 

N 
Valid 28 

Missing 0 

Mean 6.668 

Median 6.600 

Std. Deviation .7968 

Minimum 5.0 

Maximum 8.3 

 

 

      Berdasarkan hasil perhitungan data pretest kelas eksperimen didapatkan 

bahwa nilai terendah dan tertinggi dari kelas eksperimen adalah 5,0 dan 8,3 

dengan nilai rata-ratanya 6,668 dan standar deviasi sebesar 0,7968. Penyebaran 

data pretest pada kelas eksperimen berkisar antara nilai rata-rata ± simpangan 
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baku yaitu 6,668 ± 0,7968. Hasil pretest kelas eksperimen secara lebih jelas dapat 

dilihat pada diagram batang berikut ini: 

 
Gambar 3. Diagram Batang Pretest Kelas Eksperimen 

 

 

      Dari diagram batang untuk pretest kelas eksperimen, terlihat hanya seorang 

siswa mendapatkan nilai tertinggi yaitu sebesar 8,3. Sedangkan dua orang siswa 

mendapatkan nilai terendah sebesar 5,0. Pada pretest kelas ekspermen ini siswa 

paling banyak mendapatkan nilai 6,6 sebanyak sepuluh siswa. 

b) Pretest Kelas Kontrol 

      Data untuk pretest kelas kontrol (kelas yang menggunakan modul sebagai 

media pembelajaran) diambil dari hasil ujian tes kemampuan awal yang diujikan 

pada tanggal 3 Mei 2013. Berikut ini merupakan statistik deskriptif hasil 

perhitungan data pretest kelas kontrol yang dihitung menggunakan program 

SPSS: 
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Tabel 12. Hasil Deskriptif Pretest Kelas Kontrol 

 

Statistics 

Pretest KelasKontrol 

N 
Valid 31 

Missing 0 

Mean 6.674 

Median 6.600 

Std. Deviation .8091 

Minimum 5.0 

Maximum 8.6 

 

 

      Berdasarkan hasil perhitungan data pretest kelas kontrol didapatkan bahwa 

nilai terendah dan tertinggi dari kelas kontrol adalah 5,0 dan 8,6 dengan nilai rata-

ratanya 6,674 dan standar deviasi sebesar 0,8091. Penyebaran data pretest pada 

kelas kontrol berkisar antara nilai rata-rata ± simpangan baku yaitu 6,674 ± 

0,8091. Hasil pretest kelas kontrol secara lebih jelas dapat dilihat pada diagram 

batang berikut ini: 

 
Gambar 4. Diagram Batang Pretest Kelas Kontrol 
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      Dari diagram batang untuk pretest kelas kontrol, terlihat hanya seorang siswa 

mendapatkan nilai tertinggi yaitu sebesar 8,3. Begitu pula yang mendapatkan nilai 

terendah sebesar 5,0 juga hanya seorang siswa. Pada pretest kelas kontrol ini 

siswa paling banyak mendapatkan nilai 6,6 sebanyak tujuh siswa dan nilai 7,0 

sebanyak enam siswa 

2) Posttest 

a) Posttest Kelas Eksperimen 

      Data untuk posttest kelas eksperimen (kelas yang menggunakan jejaring sosial 

facebook sebagai media pembelajaran) diambil setelah proses pembelajaran 

selesai dilaksanakan. Pengambilan data nilai posttest kelas eksperimen ini diambil 

pada tanggal 28 Mei 2013. Berikut ini merupakan statistik deskriptif hasil 

perhitungan data posttest kelas eksperimen yang dihitung menggunakan program 

SPSS: 

Tabel 13. Hasil Deskriptif Posttest Kelas Eksperimen 

 

Statistics 

Posttest KelasEksperimen 

N 
Valid 28 

Missing 0 

Mean 8.800 

Median 8.800 

Std. Deviation .4355 

Minimum 8.0 

Maximum 9.2 
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      Berdasarkan hasil perhitungan data posttest kelas eksperimen didapatkan 

bahwa nilai terendah dan tertinggi dari kelas eksperimen adalah 8,0 dan 9,2 

dengan nilai rata-ratanya 8,8 dan standar deviasi sebesar 0,4355. Penyebaran data 

posttest pada kelas eksperimen berkisar antara nilai rata-rata ± simpangan baku 

yaitu 8,8 ± 0,4355. Hasil posttest kelas eksperimen secara lebih jelas dapat dilihat 

pada diagram batang berikut ini: 

 

Gambar 5. Diagram Batang Posttest Kelas Eksperimen 

 

      Dari diagram batang untuk posttest kelas eksperimen, terlihat banyak siswa 

yang mendapatkan nilai tertinggi sebesar 9,2 yaitu sebanyak 13 siswa. Sedangkan 

tiga orang siswa mendapatkan nilai terendah sebesar 8,0. Pada posttest kelas 
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eksperimen ini siswa paling banyak mendapatkan nilai 9,2 sama dengan nilai 

tertingginya yaitu sebanyak 13 siswa. 

b) Posttest Kelas Kontrol 

      Data untuk posttest kelas kontrol (kelas yang menggunakan modul sebagai 

media pembelajaran) diambil setelah proses pembelajaran selesai dilaksanakan. 

Pengambilan data nilai posttest kelas kontrol ini diambil pada tanggal 31 Mei 

2013. Berikut ini merupakan statistik deskriptif hasil perhitungan data posttest 

kelas kontrol yang dihitung menggunakan program SPSS: 

Tabel 14. Hasil Deskriptif Posttest Kelas Kontrol 

Statistics 

Posttest KelasKontrol 

N 
Valid 31 

Missing 0 

Mean 8.413 

Median 8.400 

Std. Deviation .7553 

Minimum 6.0 

Maximum 9.2 

 

      Berdasarkan hasil perhitungan data posttest kelas kontrol didapatkan bahwa 

nilai terendah dan tertinggi dari kelas kontrol adalah 6,0 dan 9,2 dengan nilai rata-

ratanya 8,413 dan standar deviasi sebesar 0,7553. Penyebaran data posttest pada 

kelas kontrol berkisar antara nilai rata-rata ± simpangan baku yaitu 8,413 ± 

0,7553. Hasil posttest kelas kontrol secara lebih jelas dapat dilihat pada diagram 

batang berikut ini: 
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Gambar 6. Diagram Batang Posttest Kelas Kontrol 

 

 

      Dari diagram batang untuk posttest kelas kontrol, terlihat lima orang siswa 

mendapatkan nilai tertinggi yaitu sebesar 9,2. Sementara itu satu orang yang 

mendapatkan nilai terendah yaitu sebesar 6,0. Pada posttest kelas kontrol ini siswa 

paling banyak mendapatkan nilai 8,8 sebanyak sepuluh siswa dan nilai 8,4 

sebanyak sembilan siswa. 

b. Uji Prasyarat Analisis 

      Sebelum pengujian hipotesis dilakukan, terlebih dahulu dilakukan uji 

prasyarat analisis yang meliputi: 

1) Uji Normalitas 
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      Uji normalitas dilakukan pada data nilai pretest dan posttest. Hal ini bertujuan 

untuk mengetahui apakah data yang diambil berdistribusi normal atau tidak, dan 

juga untuk menentukan teknik statistik yang digunakan pada uji hipotesis.  

      Analisis statistik yang digunakan dalam penelitian ini adalah uji Kolmogorov-

Smirnov, yang dihitung menggunakan program SPSS. Hasil uji normalitas data 

pretest dan posttest disajikan pada tabel berikut ini: 

Tabel 15. Hasil Uji Normalitas Tes 

One-Sample Kolmogorov-Smirnov Test 

 PreEksperimen PostEksperimen PreKontrol PostKontrol 

N 28 28 31 31 

Normal Parametersa,b 
Mean 6.668 8.800 6.674 8.413 

Std. Deviation .7968 .4355 .8091 .7553 

Most Extreme Differences 

Absolute .180 .285 .150 .267 

Positive .177 .179 .150 .149 

Negative -.180 -.285 -.096 -.267 

Kolmogorov-Smirnov Z .954 1.509 .835 1.489 

Asymp. Sig. (2-tailed) .322 .021 .488 .024 

a. Test distribution is Normal. 

b. Calculated from data. 

 

      Dari hasil uji normalitas nilai pretest kelas eksperimen dan kelas kontrol, 

didapat nilai signifikansi sebesar 0,322 untuk kelas eksperimen dan 0,488 untuk 

kelas kontrol. Hasil ini menunjukkan bahwa data pretest kedua kelas berdistribusi 

normal karena nilai signifikansinya lebih besar dari 0,05.  

      Sementara itu dari hasil uji normalitas nilai posttest kelas eksperimen dan 

kelas kontrol, didapat nilai signifikansi sebesar 0,021 untuk kelas eksperimen dan 

0,024 untuk kelas kontrol. Hasil ini menunjukkan bahwa data posttest kedua kelas 

berdistribusi tidak normal karena nilai signifikansinya kurang dari 0,05.  
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2) Uji Homogenitas 

      Uji homogenitas dilakukan pada data nilai pretest dan posttest. Hal ini 

bertujuan untuk mengetahui apakah data penelitian memiliki varian yang 

homogen atau tidak 

      Analisis statistik yang digunakan dalam uji hipotesis ini  adalah menggunakan 

analisis Test of Homogeneity of Varians dengan statistik Levene, yang dihitung 

menggunakan program SPSS. Hasil uji homogenitas data pretest dan posttest 

disajikan pada tabel berikut ini: 

Tabel 16. Hasil Uji Homogenitas Tes 

Test of Homogeneity of Variances 

 Levene Statistic df1 df2 Sig. 

Pretest .009 1 57 .923 

Posttest 1.395 1 57 .242 

 

      Uji homogenitas tes diperoleh dari hasil nilai signifikansi uji Levene Statistic 

dengan persyaratan data dikatakan homogen atau varian sama apabila nilai sig 

>0,05. Berdasarkan tabel hasil uji homogenitas tes dapat dilihat bahwa nilai 

signifikansi homogenitas pretest dan posttest >0,05 yaitu pada pretest sebesar 

0,923 dan pada posttest sebesar 0,242. Hasil ini menunjukkan bahwa data nilai 

pretest dan posttest pada penelitian ini memiliki varian yang homogen. 

c. Uji Kesamaan Kemampuan Kelompok 

      Uji kesamaan kemampuan kelompok dilakukan pada data pretest, yaitu pretest 

kelas eksperimen dan pretest kelas kontrol. Hal ini bertujuan untuk mengetahui 

apakah kemampuan awal siswa kelas eksperimen dan kelas kontrol seimbang atau 

tidak.   
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      Setelah dilakukan uji normalitas dan homogenitas, diketahui bahwa 

penyebaran skor pada pretest kelas eksperimen maupun kelas kontrol berdistribusi 

normal dan untuk uji homogenitas diperoleh hasil bahwa nilai pretest kelas 

eksperimen dan kelas kontrol memiliki varian yang homogen. Oleh karena itu, uji 

kesamaan kemampuan kelompok dalam penelitian ini menggunakan metode 

statistik parametrik yaitu dengan menggunakan Uji-T sampel independen (Equal 

Variance Assumed). 

      Analisis statistik yang digunakan dalam uji kesamaan kemampuan kelompok 

ini adalah Uji-T sampel independen  (Equal Variance Assumed), yang dihitung 

menggunakan program SPSS. Hasil Uji-T disajikan pada tabel di bawah berikut 

ini: 

          Tabel 17. Hasil Uji Kesamaan Kemampuan Kelompok 

 

 

      Berdasarkan hasil perhitungan dengan Uji-T tersebut diperoleh nilai 

signifikansi sebesar 0,976. Karena nilai signifikansi >0,05 , maka dapat 

disimpulkan bahwa tidak terdapat perbedaan pada hasil pretest kelas eksperimen 

dan kelas kontrol sehingga dapat dikatakan bahwa kedua kelas mempunyai 

kemampuan awal yang seimbang dan kedua kelas layak digunakan untuk 

penelitian. 
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d. Uji Hipotesis 

      Uji hipotesis dilakukan untuk mengetahui perbedaan hasil belajar setelah 

diberikan perlakuan yang berbeda pada kelas eksperimen yang menggunakan 

jejaring sosial facebook sebagai media pembelajaran dan kelas kontrol yang 

menggunakan modul sebagai media pembelajaran. Untuk mengetahui perbedaan 

setelah diberikan perlakuan, maka uji hipotesis dilakukan dengan menggunakan 

data posttest yaitu nilai posttest kelas eksperimen dan nilai posttest kelas kontrol.  

      Setelah dilakukan uji normalitas dan homogenitas, diketahui bahwa 

penyebaran skor pada posttest kelas eksperimen maupun kelas kontrol 

berdistribusi tidak normal, sedangkan untuk uji homogenitas diperoleh hasil 

bahwa nilai posttest kelas eksperimen dan kelas kontrol memiliki varian yang 

homogen. Oleh karena itu, uji hipotesis dalam penelitian ini menggunakan metode 

statistik non parametrik yaitu dengan menggunakan Uji Mann-Whitney sebagai 

alternatif dari Uji-T di dalam statistik parametrik.  

      Hipotesis yang diuji pada uji hipotesis penelitian ini adalah: 

Terdapat perbedaan pada hasil belajar mata pelajaran TIK siswa kelas XI SMA 

Muhammadiyah 1 Muntilan yang menggunakan jejaring sosial facebook sebagai 

media pembelajaran dan yang menggunakan modul. 

      Kriteria pengambilan kesimpulan yang digunakan adalah sebagai berikut : 

 Jika signifikansi <0,05, maka Hipotesis diterima 

 Jika signifikansi ≥0,05, maka Hipotesis ditolak 

(Stanislaus Uyanto, 2009: 137) 
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      Analisis statistik yang digunakan dalam uji hipotesis ini adalah Uji Mann-

Whitney, yang dihitung menggunakan program SPSS. Hasil Uji Mann-Whitney 

disajikan pada tabel di bawah berikut ini: 

Tabel 18. Hasil Uji Hipotesis  

 

Test Statisticsa 

 Nilai 

Mann-Whitney U 295.500 

Wilcoxon W 791.500 

Z -2.175 

Asymp. Sig. (2-

tailed) 
.030 

a. Grouping Variable: grup 

 

      Berdasarkan hasil perhitungan dengan Uji Mann-Whitney tersebut diperoleh 

nilai signifikansi sebesar 0,030. Karena nilai signifikansi <0,05 , maka Hipotesis 

diterima. Jadi dari tabel  tersebut dapat disimpulkan bahwa terdapat perbedaan 

pada hasil belajar mata pelajaran TIK siswa kelas XI SMA Muhammadiyah 1 

Muntilan yang menggunakan jejaring sosial facebook sebagai media pembelajaran 

dan yang menggunakan modul. 

2. Analisis Data Kuesioner 

      Analisis data kuesioner dalam penelitian ini digunakan untuk mengetahui 

tanggapan siswa terhadap pembelajaran mata pelajaran TIK dengan menggunakan 

jejaring sosial facebook. Pengolahan data pada data kuesioner siswa ini 

menggunakan program SPSS dengan perincian sebagai berikut: 
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Tabel 19. Pengolahan Data Kuesioner  

 

Statistics 

DataKuesioner 

N 
Valid 28 

Missing 0 

Mean 43.89 

Median 42.50 

Std. Deviation 9.267 

Minimum 25 

Maximum 65 

 

      Hasil analisis kuesioner siswa digunakan untuk mengetahui tanggapan siswa 

terhadap pembelajaran dengan menggunakan jejaring sosial facebook. Skala 

pengukuran dalam penelitian ini menggunakan 4 alternatif jawaban yaitu selalu, 

sering, jarang dan tidak pernah. Dipilih alternatif jawaban ini karena setiap butir 

instrumen dalam kuesioner ini adalah kegiatan yang dilakukan oleh siswa selama 

pembelajaran berlangsung dengan media pembelajaran facebook. Pengkategorian 

dilaksanakan berdasarkan rata-rata dan simpangan baku yang diperoleh. 

    Pengkategorian disajikan dalam tabel berikut: 

Tabel 20. Frekuensi Masing-Masing Kategori Tanggapan Siswa 

No Skor Frekuensi Kategori 

1. x ≥ 53,157 4 Sangat positif/sangat tinggi 

2. 53,157 > x ≥ 43,89 8 Tinggi/ positif 

3. 43,89 > x ≥ 34,623 13 Negatif/ Rendah 

4. x < 34,623 3 Sangat negatif/rendah 

 

      Dari tabel frekuensi kategori tanggapan siswa  dapat diketahui bahwa terdapat 

4 orang siswa yang memiliki tanggapan yang sangat tinggi terhadap penggunaan 
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jejaring sosial facebook sebagai media pembelajaran dan 8 orang siswa yang 

memiliki tanggapan yang tinggi. Sementara itu terdapat 13 orang siswa yang 

memiliki tanggapan yang rendah terhadap penggunaan jejaring sosial facebook 

sebagai media pembelajaran dan 3 orang siswa yang memiliki tanggapan yang 

sangat rendah. Untuk lebih jelasnya maka disajikan presentase masing-masing 

kategori pada grafik berikut: 

 

Gambar 7. Grafik Tanggapan Penggunaan Jejaring Sosial Facebook 

 

B. Pembahasan 

1. Pembahasan Hasil Penelitian 

      Penelitian ini bertujuan untuk mengetahui perbedaan hasil belajar mata 

pelajaran TIK siswa kelas XI SMA Muhammadiyah 1 Muntilan yang 

menggunakan jejaring sosial facebook sebagai media pembelajaran dan yang 

menggunakan modul. Berdasarkan tujuan penelitian tersebut, maka penelitian 

yang dilakukan adalah penelitian eksperimen. Penelitian ini melibatkan dua 
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sampel kelas yaitu kelas XI IPS 1 sebagai kelas eksperimen dan kelas XI IPS 3 

sebagai kelas kontrol. Kelas eksperimen diberi perlakuan dengan menggunakan 

jejaring sosial facebook sebagai media pembelajaran sedangkan kelas kontrol 

diberi perlakuan dengan menggunakan modul sebagai media pembelajaran. 

      Sebelum diberi perlakuan, terlebih dahulu diadakan pretest baik pada kelas 

eksperimen maupun kelas kontrol. Hal tersebut dilakukan untuk mengetahui 

apakah kemampuan awal kedua kelas sama atau tidak. Untuk mengetahui 

kemampuan awal kedua kelas dapat diketahui dari besar rata-rata nilai pretest dan 

hasil uji kesamaan nilai pretest. Dari data hasil penelitian, nilai rata-rata pretest 

pada kelas eksperimen sebesar 6,66 dan pada kelas kontrol sebesar 6,67 dengan 

nilai maksimal 10 jika siswa mampu menjawab semua soal dengan benar.    

Berdasarkan data tersebut diketahui nilai rata-rata pretest kelas eksperimen dan 

kelas kontrol setara. Untuk melakukan uji kesamaan kemampuan kelompok 

terlebih dahulu dilakukan uji normalitas dan uji homogenitas terhadap nilai pretest 

dengan menggunakan software SPSS. Hasil uji normalitas menunjukkan bahwa 

kedua kelas berdistribusi normal dan hasil uji homogenitas menunjukkan bahwa 

kedua kelas memiliki varian yang sama. Karena kedua kelas berdistribusi normal 

dan memiliki varian yang sama maka dapat dilakukan uji kesamaan kemampuan 

kelompok dengan Uji-T sampel independent (Equal Variance Assumed). Dari 

hasil perhitungan dapat dilihat bahwa kedua kelas tersebut mempunyai 

kemampuan awal yang sama. Hal ini dibuktikan dari hasil perhitungan nilai 

signifikansi sebesar 0,976. Karena nilai signifikansi >0,05 maka dapat 

disimpulkan bahwa kedua kelompok sampel tersebut memiliki kemampuan awal 
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yang sama.   Kesamaan kemampuan awal pada kedua kelas merupakan pijakan 

awal dalam pelaksanaan penelitian ini, karena jika kedua kelas mempunyai 

perbedaan atau tidak sama dalam kemampuan awalnya kemungkinan 

menyebabkan kegagalan dalam penelitian ini karena syarat dari penelitian 

komparasi ialah kedua kelompok sampel harus mempunyai kemampuan awal 

yang seimbang. 

      Setelah pretest pada kedua kelas selesai dilaksanakan, langkah selanjutnya 

ialah memberikan kegiatan pembelajaran materi Microsoft PowerPoint kepada 

kelas eksperimen dan kelas kontrol. Pemilihan materi pembelajaran ini didasarkan 

pada silabus mata pelajaran TIK yang ada di SMA Muhammadiyah 1 Muntilan. 

Masing-masing kelas diberikan materi dan jumlah pertemuan yang sama yaitu 

sebanyak 4 kali pertemuan dengan 8 jam mata pelajaran. Perbedaanya yaitu hanya 

terletak pada media pembelajaran yang digunakan saja. Alasan digunakan 4 kali 

pertemuan dalam penelitian ini dikarenakan cakupan kompetensi dasar yang ada 

dalam silabus tidak terlalu banyak dan cukup untuk 4 kali pertemuan. 

      Pada akhir pembelajaran diberikan posttest untuk mengetahui peningkatan 

kemampuan siswa. Posttest dilakukan setelah kedua kelas menyelesaikan materi 

Microsoft PowerPoint dengan memberikan tes yang sama pada kelas eksperimen 

dan kelas kontrol. Dari pemberian posttest diketahui perbedaan hasil belajar siswa 

setelah diberikan pengajaran dengan media pembelajaran yang berbeda. Dari data 

hasil penelitian, nilai rata-rata posttest pada kelas eksperimen sebesar 8,8 dan 

kelas kontrol sebesar 8,4 dengan nilai maksimal 10 jika siswa mampu menjawab 

semua soal dengan benar. Kelas eksperimen dan kelas kontrol sama-sama 
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mengalami peningkatan hasil belajar. Akan tetapi peningkatan hasil belajar kelas 

eksperimen lebih tinggi dibandingkan peningkatan hasil belajar pada kelas 

kontrol. Perbandingan rata-rata nilai posttest kedua kelas menunjukkan adanya 

perbedaan hasil belajar siswa setelah diberikan perlakuan yang berbeda. 

      Untuk menjawab rumusan masalah yang ada diperlukan pengujian hipotesis. 

Untuk melakukan uji hipotesis terlebih dahulu dilakukan uji normalitas dan uji 

homogenitas terhadap nilai posttest dengan menggunakan software SPSS. Hasil 

uji normalitas menunjukkan bahwa kedua kelas berdistribusi tidak normal dan 

hasil uji homogenitas menunjukkan bahwa kedua kelas memiliki varian yang 

sama. Karena kedua kelas berdistribusi tidak normal dan memiliki varian yang 

sama maka uji hipotesis menggunakan metode statistik non parametrik yaitu 

dengan menggunakan Uji Mann-Whitney sebagai alternatif dari Uji-T di dalam 

statistik parametrik. Berdasarkan hasil perhitungan dengan Uji Mann-Whitney 

tersebut diperoleh nilai signifikansi sebesar 0,030. Karena nilai signifikansi <0,05 

maka dapat disimpulkan bahwa Hipotesis diterima yaitu terdapat perbedaan pada 

hasil belajar mata pelajaran TIK siswa kelas XI SMA Muhammadiyah 1 Muntilan 

yang menggunakan jejaring sosial facebook sebagai media pembelajaran dan yang 

menggunakan modul. 

      Dari analisis hasil kuesioner tanggapan siswa terhadap penggunaan jejaring 

sosial facebook sebagai media pembelajaran diketahui bahwa terdapat 4 orang 

siswa yang memiliki tanggapan yang sangat tinggi terhadap penggunaan jejaring 

sosial facebook sebagai media pembelajaran dan 8 orang siswa yang memiliki 

tanggapan yang tinggi. Sementara itu terdapat 13 orang siswa yang memiliki 
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tanggapan yang rendah terhadap penggunaan jejaring sosial facebook sebagai 

media pembelajaran dan 3 orang siswa yang memiliki tanggapan yang sangat 

rendah. Hasil kuesioner tersebut menunjukkan bahwa frekuensi terbesar 

tanggapan siswa dalam pembelajaran menggunakan facebook ini masih dalam 

kategori rendah yaitu sebanyak 13 orang. Hal ini dikarenakan siswa yang baru 

pertama kali ini diterapkan pembelajaran dengan menggunakan jejaring sosial 

facebook sebagai media pembelajaran sehingga siswa belum terbiasa dan masih 

perlu adaptasi. 

2. Kebermaknaan Hasil Penelitian 

      Dari hasil penelitian yang dilakukan, didapatkan kesimpulan bahwa terdapat 

perbedaan pada hasil belajar mata pelajaran TIK siswa kelas XI SMA 

Muhammadiyah 1 Muntilan yang menggunakan jejaring sosial facebook sebagai 

media pembelajaran dan yang menggunakan modul dengan nilai rata-rata posttest 

kelas yang menggunakan jejaring sosial facebook sebagai media pembelajaran 

lebih tinggi daripada nilai rata-rata posttest kelas yang menggunakan modul. 

Kebermaknaan dari hasil tersebut ialah bahwa jejaring sosial facebook dapat 

digunakan sebagai media pebelajaran di sekolah dan bahkan hasilnya dapat lebih 

baik daripada dengan media pembelajaran modul. Dengan menggunakan jejaring 

sosial facebook sebagai media pembelajaran maka dapat mengarahkan 

penggunaan facebook oleh siswa menjadi lebih terarah sehingga dampak negatif 

dari facebook yang hanya digunakan pada aspek sosial dapat dikurangi.  

      Yang dapat dilakukan dari hasil penelitian yang didapat ini adalah hasil 

penelitian akan disampaikan kepada guru di SMA Muhammadiyah 1 Muntilan 
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dengan harapan guru di sana dapat mengikuti untuk mencoba penggunaan jejaring 

sosial facebook ini sebagai media pembelajaran terutama pada guru pengampu 

mata pelajaran Teknologi Informasi dan Komunikasi di mana penelitan telah 

dicobakan pada mata pelajaran ini dan sudah terbukti berhasil. 
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BAB V 

KESIMPULAN DAN SARAN 

 

A. Kesimpulan 

      Berdasarkan hasil penelitian dan pembahasan yang telah diuraikan pada bab 

IV, maka dapat ditarik beberapa kesimpulan yang merupakan tujuan dalam 

penelitian ini. Kesimpulan tersebut antara lain adalah sebagai berikut: 

1. Hasil uji hipotesis dengan menggunakan Uji Mann-Whitney menghasilkan nilai 

signifikansi sebesar 0,030. Ditetapkan nilai probabilitas sebesar 0,05 sehingga 

nilai hitung Uji Mann-Whitney lebih kecil dari nilai probabilitas (0,030 < 

0,05). Jadi dapat disimpulkan bahwa terdapat perbedaan pada hasil belajar 

mata pelajaran TIK siswa kelas XI SMA Muhammadiyah 1 Muntilan yang 

menggunakan jejaring sosial facebook sebagai media pembelajaran dan yang 

menggunakan modul. Artinya ialah jejaring sosial facebook dapat digunakan 

sebagai media pembelajaran di sekolah. Dengan menggunakan jejaring sosial 

facebook sebagai media pembelajaran maka dapat mengarahkan penggunaan 

facebook oleh siswa menjadi lebih terarah sehingga dampak negatif dari 

facebook yang hanya digunakan pada aspek sosial dapat dikurangi. 

2. Analisis hasil kuesioner menunjukkan bahwa tanggapan siswa kelas 

eksperimen di SMA Muhammadiyah 1 Muntilan  terhadap penggunaan jejaring 

sosial facebook sebagai media pembelajaran memiliki tingkat kecenderungan 

yang rendah. Ditunjukkan dengan tingkat interval 43,89 > x ≥ 34,623 yang 

diisi responden terbanyak yaitu 13 siswa. Artinya ialah frekuensi penggunaan 
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jejaring sosial facebook sebagai media pembelajaran oleh siswa masih dominan 

pada kategori jarang. Hal ini dikarenakan siswa yang baru pertama kali 

diterapkan pembelajaran dengan facebook sehingga siswa belum terbiasa dan 

masih perlu banyak adaptasi.  

 

B. Saran 

      Penelitian ini menjelaskan bahwa pembelajaran yang menggunakan media 

pembelajaran facebook memiliki hasil belajar yang lebih baik dibandingkan 

dengan pembelajaran yang menggunakan media pembelajaran modul. Beberapa 

hal yang dapat disarankan antara lain: 

1. Bagi SMA Muhammadiyah 1 Muntilan 

      Guru dapat mencoba menggunakan facebook sebagai penunjang kegiatan 

belajar-mengajar agar siswa dapat memanfaatkan fenomena facebook ini untuk 

hal yang bermanfaat bagi pendidikan tidak hanya untuk hal-hal yang tidak 

bermanfaat. 

2. Bagi Peneliti Lain 

      Perkembangan ilmu pengetahuan dan teknologi banyak mengembangkan 

berbagai media berbasis teknologi informasi. Dengan diperolehnya hasil 

penelitian ini, diharapkan dapat mendorong penelitian lain untuk berusaha 

mengembangkan bentuk penelitian berlanjutan terhadap perkembangan tekologi 

informasi maupun fenomena jejaring sosial lain yang kemungkinan dapat 

digunakan juga untuk mendukung proses kegiatan belajar-mengajar di sekolah. 
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Lampiran 1:  

DAFTAR SUBJEK PENELITIAN 

 

Kelas Eksperimen (XI IPS 1): 

No Nama Lengkap 

1 Apik Winulat 

2 Aprilia Nuraini 

3 Aprilia Susilowati 

4 Danang Susetyo Ridwan 

5 Danu Dwi Pambudi 

6 Devi Kurnianingsih  

7 Diah Ayu Candra Devi 

8 Dita Rahmawati 

9 Fera Hidayatun Najah 

10 Fika Ariyani 

11 Hery Prasetya 

12 Iis Mariyana 

13 Landung Suryandoko 

14 Mitfah Nur Fauzi 

15 Muhammad Lukman Hakim 

16 Nino Fibriana 

17 Novia Anggraini 

18 Noviana Indri Astuti 

19 Novita Riviyani 

20 Nur Oktaviyanni 

21 Rafita Nur Laila 

22 Riki Bagus Budi Perkoso 

23 Riska Noviani 

24 Risky Bagus Nur Sidiq 

25 Roro Berlianingtiyas Probosekti 

26 Ruli 

27 Siti Khotimatussaroh 

28 Yuni Wahyu Hidayah 
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Kelas Kontrol (XI IPS 3): 

 

No Nama Lengkap 

1 Agus Budiyanto 

2 Ani Salwa Dama Rini 

3 Ayu Hermawati 

4 Eka Septia Ningsih 

5 Eni Nur Nita 

6 Erwin Budiman 

7 Eti Purwati 

8 Fajar Pujiyantoro 

9 Fatimah Anggi Safitri 

10 Fitriyaningsih Sulistiyami 

11 Helmy Ferawati Dwi Anggraini 

12 Ida Khoirunisa 

13 Islamiya 

14 Joko Purnomo 

15 Lisa Nur Indahsari 

16 Muhammad Alam Wizuda Utama 

17 Nisvah Tri Utami 

18 Nur Isnaini 

19 Putri Dwi Lestari 

20 Rani Susilaningsih 

21 Riki Dwi Saputra 

22 Rizka Wildanu Arikzan 

23 Rully Adi Perdana 

24 Siti Latipah 

25 Wahyu Eri Hidayati 

26 Wahyu Sukma Arga Rini 

27 Wahyu Susilowati 

28 Yenni Ariyanti 

29 Khalifatus Sholikhah 

30 Anugrah Darmawan 

31 Wahyu Dwi S 
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Lampiran 2: 

DAFTAR HADIR 

 

Kelas Eksperimen (XI IPS 1): 

No Nama Lengkap 
Mei Tgl 

7 14 21 28 

1 Apik Winulat V v v V 

2 Aprilia Nuraini V v v V 

3 Aprilia Susilowati V v v V 

4 Danang Susetyo Ridwan V v v V 

5 Danu Dwi Pambudi V v v V 

6 Devi Kurnianingsih  V v v V 

7 Diah Ayu Candra Devi V v v V 

8 Dita Rahmawati V v v V 

9 Fera Hidayatun Najah V v v V 

10 Fika Ariyani V v v V 

11 Hery Prasetya V v v V 

12 Iis Mariyana V v v V 

13 Landung Suryandoko V v v V 

14 Mitfah Nur Fauzi V v v V 

15 Muhammad Lukman Hakim V v v V 

16 Nino Fibriana V v v V 

17 Novia Anggraini V v v V 

18 Noviana Indri Astuti V v v V 

19 Novita Riviyani V v v V 

20 Nur Oktaviyanni V v v V 

21 Rafita Nur Laila V v v V 

22 Riki Bagus Budi Perkoso V v v V 

23 Riska Noviani V v v V 

24 Risky Bagus Nur Sidiq V v v V 

25 Roro Berlianingtiyas Probosekti V v v V 

26 Ruli V v v V 

27 Siti Khotimatussaroh V v v V 

28 Yuni Wahyu Hidayah V v v V 
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Kelas Kontrol (XI IPS 3): 

 

No Nama Lengkap 
Mei Tgl 

10 17 24 31 

1 Agus Budiyanto v v v V 

2 Ani Salwa Dama Rini v v v V 

3 Ayu Hermawati v v v V 

4 Eka Septia Ningsih v v v V 

5 Eni Nur Nita v v v V 

6 Erwin Budiman v v v V 

7 Eti Purwati v v v V 

8 Fajar Pujiyantoro v v v V 

9 Fatimah Anggi Safitri v v v V 

10 Fitriyaningsih Sulistiyami v v v V 

11 Helmy Ferawati Dwi Anggraini v v v V 

12 Ida Khoirunisa v v v V 

13 Islamiya v v v V 

14 Joko Purnomo v v v V 

15 Lisa Nur Indahsari v v v V 

16 Muhammad Alam Wizuda Utama v v v V 

17 Nisvah Tri Utami v v v V 

18 Nur Isnaini v v v V 

19 Putri Dwi Lestari v v v V 

20 Rani Susilaningsih v v v V 

21 Riki Dwi Saputra v v v V 

22 Rizka Wildanu Arikzan v v v V 

23 Rully Adi Perdana v v v V 

24 Siti Latipah v v v V 

25 Wahyu Eri Hidayati v v v V 

26 Wahyu Sukma Arga Rini v v v V 

27 Wahyu Susilowati v v v V 

28 Yenni Ariyanti v v v V 

29 Khalifatus Sholikhah v v v V 

30 Anugrah Darmawan v v v V 

31 Wahyu Dwi S v v v V 
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Lampiran 3: 

SILABUS   

TEKNOLOGI INFORMASI DAN KOMUNIKASI 

KELAS XI 
 

 
Nama Sekolah  : SMA Muhammadiyah I Muntilan 
Mata Pelajaran  : Teknologi  Informasi dan Komunikasi 
Kelas / Semester  : XI/2 
Standar Kompetensi : 2. Menggunakan perangkat lunak pembuat presentasi 
 
 

Kompetensi Dasar  Materi Pembelajaran Kegiatan Pembelajaran Indikator Pencapaian Penilaian Sumber / 
Bahan / Alat 

2.1  Menggunakan menu 

ikon yang terdapat 

dalam perangkat lunak 

pembuat presentasi 

 

Menu Operasional 
Microsoft Power Point 

 Mendiskusikan dan 
mengidentifikasi fungsi 
masing-masing menu 
tool dan ikon pada 
lembar kerja power point 

 Mampraktekan 
beberapa fungsi dari 
menu, tool dan ikon 
pada lember kerja 
power point 

 Mengatur Layout 
presentasi 

 Mempraktekan format 
teks 

 Mendeskripsikan 
manfaat program 
presentasi 

 Mengidentifikasi fungsi 
menu, tools dan ikon 

 Mengatur Layout 
presentasi 

 Mengatur format teks 
 

Penilaian 
melalui kinerja 
(praktek serta 
tes tertulis) 

 Buku TIK 
Karya 
Sadiman, 
S.Pd 
Penerbit 
Erlangga 
Jakarta 

 Seperangkat 
Komputer 
dengan 
software 
Power Point 
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Kompetensi Dasar  Materi Pembelajaran Kegiatan Pembelajaran Indikator Pencapaian Penilaian Sumber / 
Bahan / Alat 

2.2  Membuat presentasi 

teks dengan variasi 

tabel, grafik, gambar 

dan diagram 

 

Membuat Presentasi 
Dengan Microsoft 
Power Point 
 

 Mempraktekan cara 
menyisipkan picture 

 

 Mempraktekan cara 
menyisipkan diagram 

 

 Mempraktekan cara 
menyisipkan Chart 
 

 Mempraktekan cara 
menyisipkan tabel 

 

 Mempratekan cara 
menyisipkan Word Art 

 

 Mempratekan cara 
menyisipkan audio 

 

 Mengatur efek transisi 
dan durasi presentasi 
 

 
 

 Menyisipkan obyek 
berupa picture 

 Menyisipakn diagram 

 Menyisipkan Chart 

 Menyisipkan tabel 

 Menyisipkan Word Art 

 Menyisipkan audio 

 Mengatur efek transisi 

 Menentukan durasi 
presentasi 
 

Penilaian 
melalui kinerja 
(praktek serta 
tes tertulis) 

 Buku TIK 
Karya 
Sadiman, 
S.Pd 
Penerbit 
Erlangga 
Jakarta 

 Seperangkat 
Komputer 
dengan 
software 
Power Point 
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Lampiran 4: 

RENCANA PELAKSANAAN PEMBELAJARAN (RPP) 

 

Mata Pelajaran           : Teknologi Informasi dan Komunikasi 

Kelas /Semester  : XI / Genap 

Pertemuan ke  : 1 dan 2 

Standar Kompetensi         : 2. Menggunakan perangkat lunak pembuat presentasi 

Waktu            : 4 X 45 Menit 

Satuan Pendidikan           : SMA MUHAMMADIYAH 1 MUNTILAN 

 

I. KOMPETENSI DASAR 

2.1 Menggunakan menu ikon yang terdapat dalam perangkat lunak pembuat 

presentasi 

 

II. INDIKATOR 

1. Mendeskripsikan manfaat program presentasi 

2. Mengidentifikasi fungsi menu, tools dan ikon 

3. Membuat presentasi dengan templete 

4. Mengatur layout presentasi 

5. Mengatur format teks 

 

III. TUJUAN PEMBELAJARAN 

Setelah proses belajar mengajar diharapkan siswa dapat: 

1. Mendeskripsikan manfaat program presentasi 

2. Mengidentifikasi fungsi menu, tools dan ikon 

3. Membuat presentasi dengan templete dan Wizard 

4. Mengatur layout presentasi 

5. Mengatur format teks 

 

IV. MATERI PEMBELAJARAN 

1. Manfaat Microsoft Power Point dalam kehidupan sehari-hari 

2. Penjelasan menu dan ikon yang ada di Microsoft Power Point 

3. Pembuatan presentasi dengan template dan wizard 

4. Pengaturan layout presentasi dan format teks 

 

V. MODEL PEMBELAJARAN 

Metode pembelajaran yang dilakukan yaitu dengan menggunakan metode: 

1. Ceramah  

2. Praktek 

3. Tanya Jawab 

 

VI. SUMBER BELAJAR 
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1. Buku Teknologi Informasi dan Komunikasi Kelas XI Karya Sadiman, S.Pd 

Halaman 142-171. 

2. Buku Praktis Belajar Teknologi Informasi dan Komunikasi Karya Agung Novian 

Halaman 153-182. 

 

VII. KEGIATAN PEMBELAJARAN 

A. Pendahuluan 

1. Guru membuka pelajaran dengan salam. (nilai yang ditanamkan: religius) 

2. Guru memimpin doa sebelum pelajaran dimulai. (nilai yang ditanamkan: 

religius) 

3. Guru mengecek kesiapan siswa dan menanyakan kehadiran siswa. (nilai yang 

ditanamkan: disiplin) 

4. Guru menyampaikan kompetensi dasar dan indikator pembelajaran.  

B. Kegiatan Inti 

Eksplorasi: 

1. Siswa membaca dan mempelajari materi yang dibagikan guru lewat facebook. 

(nilai yang ditanamkan: gemar membaca) 

2. Siswa memperhatikan penjelasan dari guru mengenai manfaat Microsoft 

Power Point dalam kehidupan sehari-hari. (nilai yang ditanamkan: rasa ingin 

tahu) 

Elaborasi: 

1. Siswa memperhatikan penjelasan dari guru tentang menu dan ikon yang ada di 

Microsoft Power Point 

2. Siswa memperhatikan dan mempraktekkan penjelasan dari guru tentang 

pembuatan presentasi dengan template dan wizard. 

3. Siswa memperhatikan dan mempraktekkan penjelasan dari guru tentang 

pengaturan layout presentasi dan format teks. 

 Konfirmasi: 

1. Siswa diberi kesempatan untuk bertanya kepada guru apa yang belum paham. 

(nilai yang ditanamkan: kreatifitas dalam bertanya) 

2. Siswa diminta mengerjakan tugas yang dibagikan guru lewat facebook 

dirumah untuk penilaian. (nilai yang ditanamkan: tanggung jawab) 

C. Penutup 

1. Guru memberikan kesimpulan mengenai apa yang telah dipelajari. 

2. Guru menyampaikan sedikit gambaran materi pertemuan yang akan datang 

supaya siswa dapat mempersiapkannya. (nilai yang ditanamkan: rasa ingin 

tahu) 

3. Guru menutup pelajaran dengan berdoa dan diakhiri dengan salam. (nilai 

yang ditanamkan: religius) 

 

VIII. ALAT/BAHAN/MEDIA 

1. PC 

2. Jejaring Sosial Facebook 

3. Program Microsoft Power Point 
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IX. EVALUASI 

Tugas: 

1. Jelaskan manfaat Microsoft PowerPoint dalam kehidupan sehari-hari! 

2. Jelaskan fungsi ikon-ikon yang ada pada gambar berikut: 

 

3. Jelaskan ikon-ikon untuk keperluan format teks pada gambar berikut: 

 

4. Jelaskan langkah-langkah untuk membuat presentasi dengan template! 

5. Jelaskan langkah-langkah untuk mengubah layout slide! 

Kunci Jawaban: 

1. Manfaat Microsoft PowerPoint dalam kehidupan sehari-hari: 

a. Untuk merancang suatu animasi dalam pembuatan slide untuk keperluan 

presentasi. 

Dengan dimasukkannya suatu animasi atau gambar dan suara dalam setiap 

slide, maka penyajian akan nampak lebih hidup serta memotivasi audiens dan 

tidak semata-mata komunikasi verbal melalui penuturan katakata oleh 

pemakalah (penyaji materi), tetapi juga komunikasi nonverbal sehingga 

audiens tidak bosan dan pemakalah (penyaji) tidak kelebihan tenaga). 

b. Membuat presentasi dari suatu produk, pelajaran, materi seminar, produk 

unggulan, acara wisuda, dan sebagainya. 

Dalam pembuatan slide yang akan dijadikan presentasi, Microsoft 

PowerPoint telah dirancang sedemikian rupa dengan panduan-panduan yang 

memudahkan pengguna tingkat pemula. 

c. Menampilkan slide-slide presentasi 

Power Point memiliki keunggulan dibanding dengan program yang lainnya, 

yaitu dapat sekaligus menampilkan slide-slide yang telah dibuat. Slide berisi 

pesan-pesan atau informasi (sering disebut software), sedangkan peralatan 

atau sarana yang digunakan untuk menampilkan pesan yang terkandung 

dalam media tersebut disebut perangkat keras (hardware). Biasanya peralatan 

yang digunakan adalah LCD Projector. 

2. Fungsi Ikon yang ada pada gambar: 

Table  : Unttuk membuat tabel 
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Picture  : Untuk memasukkan gambar yang ada di dalam komputer 

Clip Art  : Untuk memasukkan gambar yang sudah disediakan microsoft 

Photo Album : Untuk membuat album foto pada PowerPoint 

Shapes  : Untuk membuat berbagai macam bangun 

Smart Art  : Untuk membuat diagram 

Chart  : Untuk membuat grafik 

Movie  : Untuk memasukkan video 

Sound  : Untuk memasukkan suara 

3. Ikon pada fungsi Format Teks: 

Tombol Fungsi 

 
Mengganti jenis huruf pada teks atau paragraf. 

 
Mengganti ukuran huruf pada teks atau paragraf. 

 
Memformat teks yang Anda pilih dengan cetak tebal. 

 
Memformat teks yang Anda pilih dengan cetak miring. 

 
Memformat garis bawah pada teks yang Anda pilih. 

 
Memberikan efek bayangan pada teks. 

 
Memformat teks yang Anda pilih dengan rata kiri. 

 
Memformat teks yang Anda pilihdengan rata tengah. 

 
Memformat teks yang Anda pilih dengan rata kanan. 

 
Memberikan format penomoran dalam bentuk angka. 

 
Memberikan format penomoran dalam bentuk simbol 

 
Memperbesar ukuran huruf secara bertahap. 

 
Memperkecil ukuran huruf secara bertahap. 

 
Memberikan warna huruf pada teks. 

 
Memformat garis tengah pada teks yang Anda pilih. 

 

Mengatur jarak antar huruf dalam sebuah susunan teks 

yang Anda buat. 

 

Membersihkan format teks maupun gambar secara 

keseluruhan. 

 

Mengatur jarak antarbaris dalam teks pada sebuah 

paragraf. 

 
Mengatur posisi teks baik horizontal maupun diputar 

hingga 270º 

 
Mengatur teks pada sebuah paragraf sesuai dengan posisi 

yang Anda pilih, di antaranya Top, Middle, atau Bottom. 

 
Mengatur teks dengan menggunakan SmartArt Graphic 

yang tersedia pada PowerPoint 2007. 
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4. Langkah-langkah untuk membuat presentasi dengan template: 

1) Bukalah slide kosong dengan cara klik tab Home > pilih submenu Slides > 

klik New Slide. 

2) Klik tab Design. 

3) Selanjutnya, dalam tab Design pada submenu Themes kemudian pilih 

teemplate yang anda inginkan 

5. Langkah-langkah untuk mengubah layout slide: 

1) Klik tab Home > pilih submenu Slide. 

2) Klik layout  

3) Kemudian tinggal pilih mana layout yang anda inginkan 

 

Penilaian: 

No 
Aspek yang 

Dinilai 

Skor 

Jawaban lengkap 

(20) 

Jawaban kurang lengkap 

(10) 

Tak ada jawaban 

(0) 

1. 

2. 

3.  

4. 

5. 

Soal No 1 

Soal No 2 

Soal No 3 

Soal No 4 

Soal No 5 

   

 

Kriteria Skor : 

 Setiap jawaban lengkap = 20 

 Jawaban kurang lengkap = 10 

 Tak ada jawaban  =  0 

 

 Hasil akhir = Skor Total  

 

 

Muntilan, 1 Mei 2013 

          Menyetujui                                                 

       Guru Mapel TIK                                                                                      Mahasiswa 

 

 

 

    Yanto Siswoyo, S.TP                                            Zen Widodo 

       NBM. 918.888  NIM. 09520244023 
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RENCANA PELAKSANAAN PEMBELAJARAN (RPP) 

 

Mata Pelajaran           : Teknologi Informasi dan Komunikasi 

Kelas /Semester  : XI / Genap 

Pertemuan ke  : 3 dan 4 

Standar Kompetensi         : 2. Menggunakan perangkat lunak pembuat presentasi 

Waktu            : 4 X 45 Menit 

Satuan Pendidikan           : SMA MUHAMMADIYAH 1 MUNTILAN 

 

I. KOMPETENSI DASAR 

2.2 Membuat presentasi teks dengan variasi tabel, grafik, gambar dan diagram 

 

II. INDIKATOR 

1. Menyisipkan objek berupa picture 

2. Menyisipkan diagram 

3. Menyisipkan Chart 

4. Menyisipkan tabel 

5. Menyisipkan Word Art 

6. Menyisipkan audio 

7. Mengatur efek transisi 

8. Menentukan durasi presentasi 

 

III. TUJUAN PEMBELAJARAN 

Setelah proses belajar mengajar diharapkan siswa dapat: 

1. Menyisipkan objek berupa picture 

2. Menyisipkan diagram 

3. Menyisipkan Chart 

4. Menyisipkan tabel 

5. Menyisipkan Word Art 

6. Menyisipkan audio 

7. Mengatur efek transisi 

8. Menentukan durasi presentasi 

 

IV. MATERI PEMBELAJARAN 

1. Menyisipkan objek, audio, dan video pada presentasi 

2. Mengatur efek dan transisi slide presentasi 

3. Menentukan durasi presentasi 

 

V. MODEL PEMBELAJARAN 

Metode pembelajaran yang dilakukan yaitu dengan menggunakan metode: 

1. Ceramah  

2. Praktek 

3. Tanya Jawab 
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VI. SUMBER BELAJAR 

1. Buku Teknologi Informasi dan Komunikasi Kelas XI Karya Sadiman, S.Pd 

Halaman 172-189. 

2. Buku Praktis Belajar Teknologi Informasi dan Komunikasi Karya Agung Novian 

Halaman 183-215. 

 

VII. KEGIATAN PEMBELAJARAN 

A. Pendahuluan 

1. Guru membuka pelajaran dengan salam. (nilai yang ditanamkan: religius) 

2. Guru memimpin doa sebelum pelajaran dimulai. (nilai yang ditanamkan: 

religius) 

3. Guru mengecek kesiapan siswa dan menanyakan kehadiran siswa. (nilai yang 

ditanamkan: disiplin) 

4. Guru menyampaikan kompetensi dasar dan indikator pembelajaran.  

B. Kegiatan Inti 

Eksplorasi: 

1. Siswa membaca dan mempelajari materi yang dibagikan guru lewat facebook. 

(nilai yang ditanamkan: gemar membaca) 

Elaborasi: 

1. Siswa memperhatikan dan mempraktekkan penjelasan dari guru tentang 

menyisipkan objek, audio, dan video pada presentasi. 

2. Siswa memperhatikan dan mempraktekkan penjelasan dari guru tentang 

pengaturan efek dan transisi slide presentasi. 

3. Siswa memperhatikan dan mempraktekkan penjelasan dari guru tentang 

menentukan durasi presentasi. 

 Konfirmasi: 

1. Siswa diberi kesempatan untuk bertanya kepada guru apa yang belum paham. 

(nilai yang ditanamkan: kreatifitas dalam bertanya) 

2. Siswa diminta mengerjakan tugas yang dibagikan guru lewat facebook 

dirumah untuk penilaian. (nilai yang ditanamkan: tanggung jawab) 

C. Penutup 

1. Guru memberikan kesimpulan mengenai apa yang telah dipelajari. 

2. Guru menyampaikan sedikit gambaran materi pertemuan yang akan datang 

supaya siswa dapat mempersiapkannya. (nilai yang ditanamkan: rasa ingin 

tahu) 

3. Guru menutup pelajaran dengan berdoa dan diakhiri dengan salam. (nilai 

yang ditanamkan: religius) 

 

VIII. ALAT/BAHAN/MEDIA 

1. PC 

2. Jejaring Sosial Facebook 

3. Program Microsoft Power Point 
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IX. EVALUASI 

Soal 

Buat sebuah presentasi dengan Microsoft Power Point dengan tema bebas akan tetapi 

di dalamnya harus memuat: 

1. gambar 

2. diagram 

3. chart 

4. tabel 

5. word art  

6. audio 

Jangan lupa efek transisi dan juga durasi presentasi harus disesuaikan supaya didapat 

tampilan yang menarik. Presentasi yang memuat semua ketentuan dan yang 

mempunyai tampilan menarik akan mendapat nilai yang bagus. 

 

Penilaian: 

 

    

No. 

Aspek yang Dinilai 

Skor 

75 80 85 90 

1. 

2. 

Ketepatan hasil sesuai yang diharapkan ketentuan  

Kereatifitas dan kerapian 

    

 Skor :    90 = sangat baik       80 = cukup 

       85 = baik        75 = kurang 

 Hasil akhir = Skor Total : 2  

 

 

Muntilan, 1 Mei 2013 

          Menyetujui                                                 

     Guru Mapel TIK                                                                                       Mahasiswa 

 

 

 

    Yanto Siswoyo, S.TP                                           Zen Widodo 

       NBM. 918.888  NIM. 09520244023 

 

 

 

 

 

 

 



 
 

89 
 

Lampiran 5: 

MODUL PEMBELAJARAN 

 



MICROSOFT POWERPOINT 2007 
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MODUL 
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KATA PENGANTAR 

 

 

Modul pembelajaran ini dibuat untuk menjadi sarana bagi siswa dalam belajar secara 

mandiri. Yang menjadi fokus pembahasan adalah mengenai program aplikasi pengolah 

presentasi, Microsoft PowerPoint 2007.  

 

Modul ini direncanakan dapat dipelajari secara mandiri oleh siswa sebagai sumber 

belajar. Siswa dapat mempelajarinya sebelum kegiatan pembelajaran tatap muka dimulai, 

sehingga waktu yang tersedia untuk tatap muka dapat dioptimalkan pemanfaatannya 

mendiskusikan materi pelajaran yang belum dipahami atau untuk mendapatkan penjelasan 

tambahan. 

 

Oleh karena itu, siswa diharapkan membuat catatan-catatan mengenai hal-hal yang 

perlu didiskusikan selama kegiatan belajar tatap muka. Besar harapan dengan adanya modul 

pembelajaran ini akan membantu siswa dalam memahami materi serta mampu meningkatkan 

prestasi belajar siswa khususnya pada mata pelajaran Teknologi Informasi dan Komunikasi 

(TIK) Kelas XI semester genap. 

 

Yogyakarta, 1 Mei 2013 

 

 

 

Zen Widodo 

NIM. 09520244023 
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DAFTAR ISI 
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PETUNJUK PENGGUNAAN 

 

Agar lebih mempermudah siswa dalam memahami materi dalam mata pelajaran 

Teknologi Informasi dan Komunikasi (TIK) ini, ikutilah petunjuk belajar berikut ini: 

1. Pelajarilah terlebih dahulu Standar Kompetensi, Kompetensi Dasar, Indikator dan Tujuan 

dalam pembelajaran ini. 

2. Baca dan pelajari secara teliti dan seksama materi yang ada dalam modul ini lalu 

praktikkanlah ke dalam program Microsoft PowerPoint 2007. 

3. Kerjakan soal Tugas dengan baik dan benar untuk mengukur tingkat pemahaman kalian. 

4. Perhatikanlah daftar pustaka dalam modul ini, jika kemudian hari kalian ingin lebih jauh 

mempelajari materi tersebut. 
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SKKD 1 

 

A. Standar Kompetensi 

Menggunakan perangkat lunak pembuat presentasi. 

 

B. Kompetensi Dasar 

Menggunakan menu ikon yang terdapat dalam perangkat lunak pembuat presentasi. 

 

C. Indikator 

1. Mendeskripsikan manfaat program presentasi 

2. Mengidentifikasi fungsi menu, tools dan ikon 

3. Membuat presentasi dengan template 

4. Mengatur layout presentasi 

5. Mengatur format teks 

 

D. Tujuan Pembelajaran 

Setelah proses belajar mengajar diharapkan siswa dapat: 

1. Mendeskripsikan manfaat program presentasi 

2. Mengidentifikasi fungsi menu, tools dan ikon 

3. Membuat presentasi dengan template 

4. Mengatur layout presentasi 

5. Mengatur format teks 
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MATERI KD 1 

 

A. Manfaat Program Presentasi 

Program presentasi adalah program yang digunakan untuk membuat bahan 

presentasi dan sekaligus untuk berpresentasi. Dalam modul ini program presentasi yang 

akan digunakan adalah Microsoft PowerPoint 2007. 

Banyak sekali manfaat program presentasi, baik dalam dunia usaha, pendidikan, 

kesehatan, teknik, dan sebagainya. Secara umum manfaat software pembuat presentasi 

adalah sebagai berikut: 

1. Untuk merancang suatu animasi dalam pembuatan slide untuk keperluan presentasi. 

2. Membuat presentasi dari suatu produk, pelajaran, materi seminar, produk unggulan, 

acara wisuda, dan sebagainya. 

3. Menampilkan slide presentasi. 

 

B. Mengidentifikasi fungsi menu, tools dan ikon 

Untuk memulai atau membuka program aplikasi PowerPoint 2007, ikuti langkah 

berikut. 

1. Klik tombol Start pada sudut kiri bawah tampilan desktop. 

2. Pilih atau klik menu All Programs > Microsoft Office > Microsoft Office 

PowerPoint 2007.  

3. Pada layar akan muncul tampilan awal Microsoft Office PowerPoint 2007 seperti 

berikut: 
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Menu dan Ikon yang ada dalam Microsoft PowerPoint 2007: 

1. Tab Home 

Tab Home berfungsi untuk pengoperasian file, untuk memodifikasi teks, untuk 

memodifikasi pembuatan presentasi, menentukan ukuran dan jenis teks dan 

menentukan paragraf. 

 

 

Bagian dari tab home tersebut dapat dijabarkan sebagai berikut. 
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a. Submenu Clipboard 

Submenu Clipboard digunakan untuk menampung sementara file-file hasil 

kopian, hasil pemotongan, serta format painter.  

 

b. Submenu Slides 

Sub menu slide ini digunakan untuk membuka slide baru, mengatur layout dan 

menghapus slide. 

 

c. Submenu Font 

Submenu Font berisi ikon-ikon untuk pengaturan jenis huruf, ukuran huruf, 

menebalkan huruf, mencetak huruf miring, membuat huruf turun atau naik 

setengah karakter, memberi warna huruf, serta membuat huruf menjadi besar atau 

kecil satu karakter. 

 

d. Submenu Paragraph 

Kegunaan dari sub menu Paragraph adalah untuk pemberian bullet and 

numbering, melakukan decrease dan increase indentasi paragraf, perataan teks, 

pengaturan spasi, pemberian bingkai dan pengurutan data. 

 

e. Submenu Drawing 

Kegunaan dari submenu Drawing adalah untuk memasukkan gambar standar dan 

mengatur efek. 

 

f. Submenu Editing 

Submenu Editing digunakan untuk proses pengeditan teks. 
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2. Tab Insert 

Tab Insert berfungsi untuk menyisipkan tabel, nomor halaman, catatan kaki, gambar, 

teks,dan sebagainya. 

 

 

Bagian dari tab insert tersebut dapat dijabarkan sebagai berikut. 

a. Submenu Tables 

Submenu Tables digunakan untuk menyisipkan atau memasukkan tabel ke dalam 

lembar kerja PowerPoint 2007. 

b. Submenu Illustrations 

Submenu Illustrations digunakan untuk memudahkan dalam mendesain lembar 

kerja dengan cara menambahkan gambar, clip art, shapes dan menyisipkan 

grafik. 

c. Submenu Link 

Apabila Anda menginginkan untuk dapat menghubungkan file ke file yang lain, 

maka pilihan link ini akan membantu dan mempermudah Anda menghubungkan 

ke file lain termasuk ke Internet. 

d. Submenu Text 

Submenu Text digunakan untuk membuat text box, membuat Word Art, 

pembuatan tanggal dan waktu, nomor slide, simbol, dan objek. 

e. Submenu Media Clips 

Submenu Media Clips digunakan untuk memasukkan video dan suara ke dalam 

slide presentasi agar lebih menarik. 
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3. Tab Design 

Tab Design digunakan untuk mengatur tata letak data, yang meliputi page setup, 

memasukkan tema, memberi efek huruf, serta memberiwarna background slide. 

 

Tab Design ini terdiri dari sub-submenu sebagai berikut. 

a. Page Setup 

Page setup digunakan untuk pengaturan batas tepi kertas, ukuran kertas, dan 

pembuatan kolom teks. 

b. Themes 

Themes digunakan untuk pengaturan tema (template) dengan sesuai keinginan. 

c. Page Background 

Page Background digunakan untuk memformat halaman menjadi berwarna dan 

pembuatan bingkai halaman kertas. 

 

4. Tab Animations 

Tab ini digunakan untuk memasukkan berbagai pengaturan animasi slide, 

pengaturan waktu dan kecepatan slide. 
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5. Tab Slide Show 

Tab ini merupakan perintah untuk pengaturan perpindahan antar slide, animasi, dan 

objek presentasi. 

 

 

6. Tab Review 

Tab Review berguna untuk mengecek kesalahan tata bahasa serta memproteksi 

dokumen. 

 

 

7. Tab View 

Tab View digunakan untuk menampilkan atau mencetak dokumen pada layar, 

mengatur ukuran cetakannya, serta menampilkan garis bantu pada lembar kerja. 
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C. Membuat presentasi dengan template 

Membuat lembar presentasi dengan template yaitu membuat lembar presentasi 

dengan desain yang sudah ada. Untuk dapat membuat presentasi dengan template, 

caranya adalah sebagai berikut: 

1. Bukalah slide kosong dengan cara klik tab home> pilih submenu slides> klik New 

Slide. 

2. Klik tab design. 

3. Selanjutnya, dalam tab design pada submenu themes ditampilkan berbagai pilihan 

design template seperti gambar berikut. 

 

 

4. Tampilan tersebut merupakan salah satu template dengan model pilihan Flow. 

5. Template tersebut dapat diubah warna, huruf, maupun efek. 

Cara mengubah desain template sebuah slide adalah klik tombol submenu themes 

dari menu design. Proses pengubahan huruf, warna, maupun efek ini dilakukan 

dalam satu kumpulan tombol, perhatikan tampilan di bawah. 
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Colors digunakan untuk visualisasi dari pengubahan warna. Fonts digunakan untuk 

pengubahan jenis huruf. Dan Effects digunakan untuk pengubahan efek. 

6. Penggantian background slide 

Caranya adalah klik tab Design> pilih submenu Background> Background Styles> 

Format Background. 

 

D. Mengatur Layout Presentasi 

Tampilan layout dalam Microsoft PowerPoint 2007 dapat diubah sesuai dengan 

kebutuhan dan selera. Langkah untuk mengubah layout slide adalah sebagai berikut: 

1. Klik tab home> pilih submenu slide. 

2. Klik layout akan muncul seperti di bawah ini. 

 

3. Kemudian tinggal pilih mana layout yang anda inginkan 
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E. Mengatur Format Teks 

Format Teks pada Microsoft PowerPoint 2007 dapat diubah sesuai dengan 

kehendak untuk menambah daya tarik dari media presentasi. Untuk keperluan 

pengolahan teks tombol perintah yang digunakan terdapat pada submenu Font dan 

Paragraph. Keduanya dapat ditemukan di tab home. Perhatikan gambar berikut: 

 

Berikut ini adalah penjelasan mengenai fungsi dan kegunaan beberapa tombol 

perintah yang terdapat dalam group Font dan Paragraph: 

 

Tombol Fungsi 

 
Mengganti jenis huruf pada teks atau paragraf. 

 
Mengganti ukuran huruf pada teks atauparagraf. 

 
Memformat teks yang Anda pilih dengan cetak tebal. 

 
Memformat teks yang Anda pilih dengan cetak 

miring. 

 
Memformat garis bawah pada teks yang Anda pilih. 

 
Memberikan efek bayangan pada teks. 

 
Memformat teks yang Anda pilih dengan rata kiri. 

 
Memformat teks yang Anda pilih dengan rata tengah. 

 
Memformat teks yang Anda pilih dengan rata kanan. 

 
Memberikan format penomoran dalam bentuk angka. 

 
Memberikan format penomoran dalam bentuk simbol 

 
Memperbesar ukuran huruf secara bertahap. 

 
Memperkecil ukuran huruf secara bertahap. 

 
Memberikan warna huruf pada teks. 

 
Memformat garis tengah pada teks yang Anda pilih. 

 

Mengatur jarak antar huruf dalam sebuah susunan 

teks yang Anda buat. 
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Membersihkan format teks maupun gambar secara 

keseluruhan. 

 

Mengatur jarak antarbaris dalam tekspada sebuah 

paragraf. 

 
Mengatur posisi teks baik horisontal maupun diputar 

hingga 270º 

 
Mengatur teks pada sebuah paragraf sesuai dengan 

posisi yang Anda pilih, diantaranya Top, Middle, 

atau Bottom. 

 
Mengatur teks dengan menggunakan SmartArt 

Graphic yang tersedia pada PowerPoint 2007. 

 

F. Tugas 1 

1. Jelaskan manfaat program presentasi dalam kehidupan sehari-hari! 

2. Jelaskan fungsi ikon-ikon yang ada pada gambar berikut: 

 

3. Jelaskan ikon-ikon untuk keperluan format teks pada gambar berikut: 

 

4. Jelaskan langkah-langkah untuk membuat presentasi dengan template! 

5. Jelaskan langkah-langkah untuk mengubah layout presentasi! 

 

G. Uji Kompetensi 1 

Kerjakan dibuku latihan anda! Pilihlah salah satu jawaban yang paling tepat! 

1. PowerPoint 2007 adalah program aplikasi komputer yang berguna untuk …. 

a. pengolah kata 

b. pengolah data 

c. pembuat presentasi 

d. pengolah gambar 

e. sistem operasi 

 



MICROSOFT POWERPOINT 2007 
 

SMA Muh 1 Muntilan Page 17 
 

2. Berikut ini, sistem operasi yang dapat mendukung beroperasinya PowerPoint 2007 

adalah .… 

a. Windows XP SP1 

b. Linux 

c. MacOS 

d. Dos 

e. Windows XP SP2 

3. Fasilitas yang digunakan sebagai user Interface baru pada PowerPoint 2007 adalah 

…. 

a. Ribbon 

b. Tab 

c. Toolbox 

d. Task Pane 

e. Dialog Box 

4. Perhatikan gambar berikut. 

 

Quick Access Toolbar ditunjukkan oleh nomor .... 

a. 1 

b. 2 

c. 3 

d. 4 

e. 5 

5. Formating text terdapat pada tab …. 

a. Animation 

b. Home 

c. Insert 

d. Design 

e. Review 
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6. Berikut ini, perintah yang tercantum dalam menu design adalah …. 

a. Themes 

b. Animation 

c. Table 

d. Illustration 

e. Start slide show 

7. Perintah yang digunakan untuk mengelola dan melihat semua presentasi yang telah 

Anda Buat adalah…. 

a. Normal View 

b. Slide Sorter View 

c. Slide Show 

d. Print View 

e. Duplicate Slide 

8. Untuk mengatur konfigurasi status bar, yang harus Anda lakukan Adalah…. 

a. mengklik kiri tombol mouse pada area status bar 

b. mengklik kanan tombol mouse pada area status bar 

c. menekan Ctrl+S 

d. menekan Ctrl+L 

e. menekan Alt+H 

9. Saat menyiapkan presentasi, Anda dapat memakai design presentasi yang sudah ada. 

Anda dapat mengambilnya di.... 

a. Tab Design 

b. Tab View 

c. Installed templates 

d. New Presentation 

e. Quick Access toolbar 

10. Ketika Anda akan menomori teks pada slide, perintah yang akan digunakan adalah.... 

a. Bullet and Numbering 

b. Symbol 

c. Media Clip 

d. Font 

e. Alignment 
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SKKD 2 

 

A. Standar Kompetensi 

Menggunakan perangkat lunak pembuat presentasi 

 

B. Kompetensi Dasar 

Membuat presentasi teks dengan variasi tabel, grafik, gambar dan diagram 

 

C. Indikator 

1. Menyisipkan objek berupa picture 

2. Menyisipkan diagram 

3. Menyisipkan chart 

4. Menyisipkan tabel 

5. Menyisipkan Word Art 

6. Menyisipkan audio 

7. Mengatur efek dan transisi presentasi 

8. Menentukan durasi presentasi 

 

D. Tujuan Pembelajaran 

Setelah proses belajar mengajar diharapkan siswa dapat: 

1. Menyisipkan objek berupa picture 

2. Menyisipkan diagram 

3. Menyisipkan chart 

4. Menyisipkan tabel 

5. Menyisipkan Word Art 
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6. Menyisipkan audio 

7. Mengatur efek dan transisi presentasi 

8. Menentukan durasi presentasi 
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MATERI KD2 

 

A. Menyisipkan objek berupa picture 

1. Menyisipkan gambar dari Clip Art 

Cara menyisipkan gambar dari Clip Art ke dalam slide Microsoft 

PowerPoint 2007 adalah sebagai berikut: 

a. Klik  tab insert 

b. Klik Clip Art, selanjutnya muncul task pane. Clip Art di samping kanan slide. 

 

c. Klik anak panah pada kolom Search In, kemudianpilih Office Collections. 

d. Klik Go 

e. Klik gambar yang Anda pilih, maka gambar akan disisipkan pada slide. 

 

2. Menyisipkan gambar dari file 

Langkah-langkah untuk menyisipkan gambar dari file adalah sebagai berikut: 

a. Klik tab insert, kemudian pilih Picture. 

b. Selanjutnya akan muncul kotak dialog Insert Picture, seperti tampilan di bawah 

ini. 

c. Carilah lokasi tempat gambar berada. 
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d. Pilih salah satu gambar. 

e. Klik open untuk menyisipkan gambar ke dalam slide. 

f. Setelah langkah-langkah tersebut selesai, secara otomatis gambar akan 

dimasukkan ke dalam slide. 

 

B. Menyisipkan Diagram 

Dalam Microsoft PowerPoint 2007, Anda dapat menyisipkan diagram atau grafik 

ke dalam presentasi. Diagram dimasukkan melalui tool SmartArt.  

 

 

Prosedur yang harus Anda lakukan untuk menyisipkan sebuah diagram ke dalam 

sebuah presentasi adalah seperti berikut: 

1. Klik tab insert, kemudian pilih SmartArt. 

2. Selanjutnya akan muncul kotak dialog SmartArt Graphic, seperti tampilan di bawah 

ini. 
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Pada kotak dialog Choose a SmartArt Graphic, ada beberapa pilihan yang perlu 

Anda perhatikan, di antaranya dapat Anda lihat pada tabel berikut: 

 

Menu Gambar Keterangan 

List 

 

Diagram yang menunjukkan 

daftar kerja secara bertahap. 

Process 

 

Diagram yang menunjukkan 

proses yangberlanjut dengan 

alur horisontal / mendatar. 
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Cycle 

 

Diagram yang menunjukkan 

proses yang berlanjut dengan 

alur lingkaran. 

Hierarchy 

 

Diagram yang menunjukkan 

struktur hubungan hierarki. 

Relationship 

 

Diagram hubungan dalam 

formasi elemen pelengkap. 

Matrix 

 

Diagram  hubungan antar 

bagian dengan bagian 

pusat/inti. 

Pyramid 

 

Diagram hubungan dalam 

bentuk piramid. 

 

3. Pilih salah satu pilihan SmartArt yang Anda inginkan. Kemudian, ketik OK atau 

Anda bisa mengklik dua kali bagian yang Anda pilih. Misalnya, pilih Hierarchy> 

Organization Chart sehingga slide akan tampil seperti gambar ini: 
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4. Kemudian, secara otomatis di lembar kerja akan muncul kotak dialog untuk 

memasukkan teks pada Organization Chart. Ketiklah Judul Gambar misalnya 

STRUKTUR ORGANISASI XI IPS 2. Selanjutnya, untuk mengisi teks pada kotak, 

ketiklah di samping chart tersebut teks yang Anda inginkan sesuai dengan judul. 

 

Contohnya: 
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5. Untuk proses modifikasi dan editing, Anda dapat lakukan melalui tab design yang 

terdapat pada ribbon. Tab Design memiliki tampilan ribbon seperti pada gambar 

berikut. 

 

 

C. Menyisipkan Chart 

Selain dapat menyisipkan gambar dan diagram Microsoft PowerPoint 2007 juga 

dapat menyisipkan objek grafik ke dalam presentasi. Ada beberapa cara untuk 

menyisipkan objek grafik ke dalam presentasi, antara lain dengan menggunakan tab 

Insert > Illustrations > Chart.  

 

Prosedur yang harus Anda lakukan untuk menyisipkan sebuah grafik ke dalam 

sebuah presentasi adalah seperti berikut: 

1. Klik tab insert, kemudian pilih Chart. 

2. Selanjutnya akan muncul kotak dialog Insert Chart, seperti pada tampilan di bawah 

ini. 
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3. Pilih salah satu pilihan Chart yang Anda inginkan. Kemudian, ketik OK atau Anda 

bisa mengklik dua kali bagian yang Anda pilih. Misalnya, pilih Column Clustered 

Column sehingga slide akan tampil seperti gambar berikut. 
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4. Kemudian, secara otomatis di lembar kerja akan muncul grafik dan program 

memasukkan data dari Microsoft Excel. Ketiklah “Judul Gambar” misalnya 

PERKEMBANGAN PRESTASI SISWA. Selanjutnya untuk mengisi teks pada 

kotak, ketiklah di samping chart data yang Anda inginkan sesuai dengan judul. 

Perhatikan contoh berikut. 

 

 

Jika pada Microsoft Excel diubah datanya seperti data dalam gambar maka grafik 

akan menjadi seperti ini: 

 

5. Untuk proses modifikasi dan penyuntingan grafik Anda dapat dilakukan melalui 

Chart Tools Design, Layout, dan Chart Tools Format. 
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Chart Tools Design: 

 

Chart Tools Layout: 

 

Chart Tools Format: 

 

 

D. Menyisipkan Tabel 

Tabel digunakan untuk membantu presentasi menjadi lebih jelas. Berikut adalah 

cara untuk memasukkan data dalam bentuk tabel. 

1. Klik Insert pada tab menu, kemudian pilih Table > Insert Table, selanjutnya akan 

ditampilkan kotak dialog Insert Table seperti gambar di bawah. 

 

2. Ketik jumlah kolom pada Number of columns dan jumlah baris pada Number of rows 

(misalnya ingin membuat tabel dengan jumlah kolom 3 dan jumlah baris 9). 

3. Klik OK. 
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E. Menyisipkan Word Art 

Selain teks biasa, Anda juga bisa memasukkan teks yang berupa WordArt. 

WordArt adalah fasilitas yang digunakan untuk menulis bentuk-bentuk tulisan indah dan 

menarik, di antaranya berbentuk 3 dimensi dengan berbagai tekstur. Tampilan WordArt 

ini nantinya akan diberlakukan seperti halnya gambar. 

Cara membuat WordArt pada slide presentasi dapat dilakukan dengan langkah-

langkah sebagai berikut. 

1. Klik tab insert> pilih WordArt 

2. Selanjutnya akan ditampilkan kotak dialog WordArt Gallery yang menampilkan 

berbagai model WordArt seperti berikut. 
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3. Klik salah satu model WordArt dalam kotak dialog WordArt. 

4. Secara otomatis, huruf yang Anda ketik pada slide akan mengikuti model WordArt 

yang telah dipilih. 

5. Untuk proses modifikasi dan editing WordArt, Anda dapat lakukan melalui tab 

format yang terdapat pada ribbon. Tab Format memiliki tampilan ribbon seperti 

pada gambar berikut. 

 

 

F. Menyisipkan Audio 

Agar presentasi yang ditampilkan menjadi lebih menarik, slide dapat dimasukkan 

objek berupa audio. Cara untuk menyisipkan audio pada slide adalah sebagai berikut. 

1. Buka slide yang akan disisipi suara. 

2. Klik tab insert. 



MICROSOFT POWERPOINT 2007 
 

SMA Muh 1 Muntilan Page 32 
 

3. Klik pada pilihan Movies and Sound kemudian pilih Sound From file, maka di layar 

muncul tampilan pilihan sound seperti pada gambar di bawah. 

 

4. Klik pada salah satu pilihan Sound. 

5. Klik tombol OK, di layar akan muncul tampilan sebagai berikut. 

 

6. Klik tab menu Option (akan muncul secara otomatis pada saat simbol sound diklik). 

7. Pilihlah sub menu Sound Option untuk mengatur volume sound dan pengaturan 

efeknya. 
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G. Mengatur Efek danTransisi Presentasi 

1. Transisi 

Transisi merupakan bentuk animasi perpindahan dari slide satu ke slide 

yang lannya. Penentuan transisi penting diatur dalam sebuah presentasi. Jenis 

transisi dapat membantu memudahkan peserta presentasi dalam membaca alur 

konsep materi. 

Pilihan bentuk transisi dapat dimunculkan melalui sub menu Transition to 

This Slide pada menu Animations. Berikut adalah bentuk-bentuk transisi yang 

disediakan oleh Microsoft PowerPoint 2007. 

 

2. Efek  

Efek merupakan animasi yang diterapkan pada sebuah objek presentasi 

misalnya teks, gambar, diagram, dan grafik. Ada dua cara menerapkan animasi pada 

sebuah objek, yaitu melalui Animate dan Custom Animation. 

a. Animate 

Pada group Animations terdapat pengaturan Animate dan Custom Animation. 

Pengaturan melalui Animate merupakan pemberian animasi secara sederhana. 



MICROSOFT POWERPOINT 2007 
 

SMA Muh 1 Muntilan Page 34 
 

Langkah untuk menerapkan animasi melalui fasilitas Animate adalah seperti 

berikut. 

1) Seleksi salah satu objek yang akan diberi animasi, kemudian aktifkan tab 

Animations. 

2) Pilih Animate pada kategori Animations. 

3) Pilih salah satu jenis animasi yang tersedia. 

 

b. Custom Animations 

Animasi pada objek ini diterapkan melalui fasilitas Custom Animation. Langkah 

penerapannya adalah seperti berikut. 

1) Seleksi objek yang akan diberi animasi. 

2) Klik tombol Tab, kemudian pilih Custom Animaton. 

3) Klik Add Effect, kemudian pilih jenis animasi yang Anda inginkan. 

 

4) Pilih salah satu animasi yang ada pada Custom Animation tersebut. 
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H. Menentukan Durasi Presentasi 

Untuk mengatur durasi presentasi, program Microsoft PowerPoint 2007 

menyediakan fasilitas Timing, yang digunakan untuk mengatur berapa lama slide akan 

tampil dalam satu kali presentasi. Cara mengatur durasi presentasi adalah sebagai 

berikut. 

1. Bukalah salah satu slide Anda. 

2. Klik tab Slide Show, kemudian pilih Rehearse Timings. Selanjutnya, di layar akan 

muncul tampilan sebagai berikut. 

 

 :Next, digunakan untuk melanjutkan tampilan slide berikutnya        

sesuai dengan pilihan yang telah ditentukan. 

 :Pause, digunakan untuk menghentikan jalannya waktu penghitungan 

tampilan. 

 :Slide timing, digunakan untuk menentukan lamanya waktu presentasi. 

 :Repeat, digunakan untuk mengulang ke slide pertama. 
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I. Tugas 2 

Buat sebuah presentasi dengan Microsoft PowerPoint 2007 dengan tema bebas 

akan tetapi di dalamnya harus memuat: 

1. gambar 

2. diagram 

3. chart 

4. tabel 

5. word art  

6. audio 

Jangan lupa efek, transisi dan juga durasi presentasi harus disesuaikan supaya 

didapat tampilan yang menarik. Presentasi yang memuat semua ketentuan dan yang 

mempunyai tampilan menarik akan mendapat nilai yang bagus. 

 

J. Uji Kompetensi 2 

Kerjakan dibuku latihan anda! Pilihlah salah satu jawaban yang paling tepat! 

1. Untuk membuat sebuah presentasi anda dapat melakukannya melalui Blank 

Presentasi, Design Template Auto Contect Wizard. Blank Presentasi ada di dalam …. 

a. Menu Bar 

b. Toolbar 

c. Task Pane 

d. Office Button 

e. Header and Footer 

2. Ikon Formatting text yang berfungsi untuk mengatur jarak antar huruf dalam sebuah 

susunan teks yang Anda buat adalah .… 

a.    d.  

b.    e.  

c.  
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3. Perpindahan slide yang satu dengan slide yang lain serta waktu perpindahan 

disebut… 

a. mailmerge 

b. hyperlink 

c. embeded 

d. transisi 

e. interval 

4. Perintah yang benar saat Anda ingin menyisipkan Objek dari ClipArt adalah .… 

a. Insert Design Clip Art 

b. Home Illustrations Clip Art 

c. Insert Illustrations Clip Art 

d. Home Design Clip Art 

e. Insert Object Clip Art 

5. Perhatikan gambar berikut. 

 

Gambar tersebut akan keluar dari menu…. 

a. Arrange 

b. Quick style 

c. Shapes 

d. Picture style 

e. Layout 

6. Ikon yang digunakan untuk mengatur huruf dan model yang akan dipakai dalam 

membuat WordArt adalah …. 

a.     d.  

b.     e.  

c.  
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7. Jika Anda ingin menyisipkan objek Anda harus memilih menu …. 

a. Block Arrow 

b. Equation Shapes 

c. Flowcart 

d. Stars and Banners 

e. Chat 

8. Tipe List pada Smart Art Graphic bertujuan untuk membuat …. 

a. diagram hubungan dalam formasi elemen pelengkap 

b. diagram yang menunjukkan daftar kerja secara bertahap 

c. diagram yang menunjukkan proses yang berlanjut dengan alur horizontal / 

mendatar 

d. diagram yang menunjukkan proses yang berlanjut dengan alur lingkaran 

e. diagram yang menunjukkan struktur hubungan hirarki 

9. Untuk membuat grafik, Anda harus memilih menu …. 

a. Insert Illustrations Chart 

b. Home Illustrations Chart 

c. Insert Drawing Chart 

d. Insert Picture Chart 

e. Home Picture Chart 

10. Berikut ini pilihan grafik tipe Bar adalah …. 

a.  

b.  

c.  

d.  

e.  
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KUNCI JAWABAN 

 

Uji Kompetensi 1 

1. c  

2. e  

3. a  

4. b  

5. b 

6. a 

7. c 

8. e 

9. c 

10. a 

 

Uji Kompetensi 2 

1. d  

2. c  

3. d  

4. e  

5. a  

6. d 

7. d 

8. c 

9. a 

10. c 
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Lampiran 6: 

SOAL PRETEST 

Mata Pelajaran  :  Teknologi Informasi dan Komunikasi 

Materi  :  Microsoft PowerPoint 

Kelas  :  XI 

     Alokasi Waktu :  45 menit 

 

PETUNJUK PENGERJAAN: 

1. Tulis identitas Anda pada tempat yang sudah disediakan. 

2. Untuk menjawab soal, pilihlah satu jawaban yang paling tepat dengan memberi tanda (x) 

salah satu huruf  A, B, C, D atau E di lembar soal ini. 

3. Periksalah pekerjaan Anda sebelum dikumpulkan. 

 

IDENTITAS: 

Nama  : 

Kelas  : 

No Presensi : 

 

SOAL: 

1. Untuk menentukan durasi presentasi menggunakan menu .... 

a. Record Narration 

b. Hide Slide 

c. Set Up Slide Show 

d. Rehearse Timings 

e. Resolution 

 

2. Dalam menu Rehearse Timings yang digunakan untuk menentukan lamanya waktu 

presentasi adalah .... 

a.   d.   

b.   e.  

c.  
 

3. Perhatikan gambar berikut ini: 

 
Untuk mengatur keluarnya tulisan atau gambar dari layar menggunakan .... 

a. Entrance  d. Motion Paths 

b. Exit   e.  Tidak ada jawaban benar 

c. Emphasis  

 

4. Untuk menerapkan setting Transition pada semua slide, klik tombol .... 

a. Apply   d. OK 

b. Apply to All  e. Cancel 

c. Ignore 
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5. Perhatikan gambar berikut ini: 

 
Ikon tersebut digunakan untuk memasukkan .... 

a. Gambar  d. Clip Art 

b. Video   e.  Suara 

c. Animasi 

 

6. Langkah-langkah untuk memasukkan suara dalam Microsoft Power Point adalah .... 

a. Insert > Media Clips > Sound 

b. Insert > Tables > Sound 

c. Insert > Illustrations > Sound 

d. Insert > Links > Sound 

e. Insert > Text > Sound 

 

7. Untuk membuat huruf dengan efek 3D maka menggunakan .... 

a. Font 

b. Object 

c. Word Art 

d. Smart Art 

e. Shape 

 

8. Pada menu WordArt Style, fungsi dari Text Effect adalah untuk .... 

a. mengatur huruf dan model yang akan dipakai 

b. memberikan warna pada garis 

c. memberikan warna pada huruf WordArt 

d. memberikan bayangan pada huruf 

e. memberikan efek desain pada huruf WordArt 

 

9. Untuk memisahkan cell dalam tabel menggunakan menu .... 

a. Split Cells 

b. Merge Cells 

c. Delete Rows 

d. Delete Collums 

e. Insert Cells 

 

10. Langkah-langkah untuk membuat tabel ialah .... 

a. Design > Table > Insert Table 

b. Insert > Table > Insert Table 

c. Home > Table > Insert Table 

d. Animations > Table > Insert Table 

e. Slide Slow > Table > Insert Table 
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11. Perhatikan gambar berikut ini: 

 
Gambar tersebut merupakan grafik tipe .... 

a. Column 

b. Bar 

c. Line 

d. Pie 

e. Area 

 

12. Istilah grafik dalam Microsoft Power Point disebut .... 

a. Picture  d. Smart Art 

b. Clip Art  e.  Chart 

c. Shapes 

 

13. Untuk membuat diagram dalam Microsoft PowerPoint menggunakan menu .... 

a. Clip Art  d. Smart Art 

b. Picture  e. Chart 

c. Shapes 

 

14. Untuk membuat struktur organisasi menggunakan diagram tipe .... 

a.   d.   

b.   e.   

 

c.    
  

15. Ikon yang digunakan untuk menyisipkan clip art adalah .... 

a.    d.   

b.    e.   

c.   
 

16. Perintah yang benar saat Anda ingin menyisipkan picture adalah .... 

a. Insert > Design > Picture 

b. Home > Illustrations > Picture 

c. Insert > Illustrations > Picture 

d. Home > Design > Picture 

e. Insert > Object > Picture 
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17. Menu clip art digunakan untuk .... 

a. menyisipkan gambar yang sudah disediakan Microsoft 

b. menyisipkan gambar yang diinginkan dari file di komputer 

c. menyisipkan suara yang sudah disediakan Microsotft 

d. menyisipkan suara yang diinginkan dari file di komputer 

e. menyisipkan video yang diinginkan dari file di komputer 

 

18. Berikut ini ialah jenis-jenis font yang ada di Microsoft Power Point, kecuali .... 

a. Times New Roman  d. Italic 

b. Arial    e. Tahoma 

c. Calibri 

 

19. Perintah font terdapat pada tab menu .... 

a. Home   d.  Review 

b. Insert   e.  Design 

c. View 

 

20. Berikut adalah bukan effect pada font, yaitu.... 

a. Subscript  d. Underline 

b. Bold   e.  Justify 

c. Italic 

 

21. Untuk membuat judul di bagian paling depan presentasi, maka layout yang dipakai 

adalah .... 

a.   d.   

b.   e.   

c.  
 

22. Langkah-langkah mengganti layout presentasi adalah .... 

a. Home > Slides > Layout 

b. Home > Font > Layout 

c. Design > Slides > Layout 

d. Insert > Slides > Layout 

e. Insert > Illustrations > Layout 

 

23. Dalam pembuatan lembar presentasi dengan menggunakan Template, yaitu .... 

a. membuat lembar presentasi dengan desain dari dokumen lain 

b. membuat lembar presentasi dengan format dan latar sendiri 

c. membuat lembar presentasi secara otomatis 

d. membuat lembar presentasi dengan desain yang sudah ada 

e. membuat lembar presentasi dengan syarat tertentu 

 

 



 

134 
 

24. Kita dapat menggunakan template ke dalam slide yang dibuat dengan bantuan menu .... 

a. Insert   d. Slide Show 

b. Design  e. View 

c. Animations 

 

25. Jika ingin mengubah background dari template yang sudah ada yaitu dengan 

menggunakan .... 

a. Page Setup 

b. Slide Orientation 

c. Themes 

d. Background Styles 

e. Hide Background Graphics 

 

26. Perhatikan gambar berikut. 

 
       Office button ditunjukkan oleh nomor 

       .... 

a. 1  d.   4 

b. 2  e.   5 

c. 3 

 

27. Jika anda ingin menghapus slide yang dipilih, ikon yang digunakan adalah .... 

a.    d.  

b.   e.  

c.  
 

28. Jika anda ingin menampilkan presentasi dari awal maka ikon yang digunakan adalah .... 

a.   d.  

b.   e.  

c.  
 

29. Salah satu software yang saat ini dikenal sebagai media presentasi melalui komputer 

adalah.... 

a. Microsoft Word   d. Microsoft Excel 

b. Microsoft Acces   e. Microsoft Visio 

c. Micosoft PowerPoint 
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30. Di bawah ini adalah beberapa manfaat dari Microsoft PowerPoint. 

(1) promosi produk 

(2) presentasi di depan publik 

(3) publikasi 

(4) pengolah angka 

Pernyataan yang salah adalah .... 

a. (1), (2), dan (3) 

b. (1) dan (3) 

c. (2) dan (4) 

d. (4) saja 

e. (1), (2), (3), dan (4) 
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Lampiran 7: 

KUNCI JAWABAN SOAL PRETEST 

 

1. D 

2. E 

3. B 

4. B 

5. E 

6. A 

7. C 

8. E 

9. A 

10. B 

11. A 

12. E 

13. D 

14. D 

15. D 

16. C 

17. A 

18. D 

19. A 

20. E 

21. D 

22. A 

23. D 

24. B 

25. D 

26. A 

27. E 

28. B 

29. C 

30. D 
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Lampiran 8: 

SOAL POSTTEST 

Mata Pelajaran  :  Teknologi Informasi dan Komunikasi 

Materi  :  Microsoft PowerPoint 

Kelas  :  XI 

     Alokasi Waktu :  45 menit 

 

PETUNJUK PENGERJAAN: 

1. Tulis identitas Anda pada tempat yang sudah disediakan. 

2. Untuk menjawab soal, pilihlah satu jawaban yang paling tepat dengan memberi tanda (x) 

salah satu huruf  A, B, C, D atau E di lembar soal ini. 

3. Periksalah pekerjaan Anda sebelum dikumpulkan. 

 

IDENTITAS: 

Nama  : 

Kelas  : 

No Presensi : 

 

SOAL: 

1. Microsoft PowerPoint adalah program aplikasi komputer yang berguna untuk .... 

a. Pengolah kata 

b. Pengolah data 

c. Pembuat presentasi 

d. Pengolah gambar 

e. Sisten operasi 

 

2. Di bawah ini adalah beberapa manfaat dari Microsoft PowerPoint. 

(1) promosi produk 

(2) presentasi di depan publik 

(3) publikasi 

(4) pengolah angka 

Pernyataan yang benar adalah .... 

a. (1), (2), dan (3) 

b. (1) dan (3) 

c. (2) dan (4) 

d. (4) saja 

e. (1), (2), (3), dan (4) 
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3. Perhatikan gambar berikut. 

 
       Quick Access Toolbar ditunjukkan oleh nomor 

       .... 

a. 1  d.   4 

b. 2  e.   5 

c. 3 

 

4. Jika anda akan mengubah warna huruf, ikon yang digunakan adalah .... 

a.    d.  

b.    e.   

c.  
 

5. Untuk membuat halaman baru digunakan ikon .... 

a.    d.  

b.    e.   

c.  
 

6. Dalam pembuatan lembar presentasi dengan menggunakan Template, yaitu .... 

a. membuat lembar presentasi dengan desain dari dokumen lain 

b. membuat lembar presentasi dengan desain yang sudah ada 

c. membuat lembar presentasi dengan format dan latar sendiri 

d. membuat lembar presentasi secara otomatis 

e. membuat lembar presentasi dengan syarat tertentu 

 

7. Langkah-langkah untuk memulai presentasi baru dengan Design Template adalah .... 

a. Design > Themes  

b. Animations > Themes  

c. Insert > Themes  

d. Home > Themes  

e. Slide Show > Themes  

 

8. Langkah-langkah untuk mengatur background presentasi pada Microsoft PowerPoint 

ialah .... 

a. Design > Themes  

b. Design > Page Setup  

c.  Design > Background Styles > Format Background  

d.  Design > Background Styles   

e.  Design > Slide Orientation  
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9. Untuk membuat judul di bagian paling depan presentasi, maka layout yang dipakai 

adalah .... 

a.   d.   

b.   e.    

c.  
 

10. Untuk mengganti layout presentasi digunakan ikon .... 

a.    d.  

b.   e.   

c.  
 

11. Bold merupakan efek pada font untuk.... 

a. memberi garis bawah  d. memberi warna 

b. mencetak miring  e.  menebalkan huruf 

c. pangkat kuadrat 

 

12. Langkah-langkah untuk mengatur format font ialah .... 

a. Home > Font   

b. Insert > Font  

c. Design > Font 

d. Animations > Font 

e.   Slide Show > Font 

 

13. Berikut yang bisa diformat pada font, kecuali .... 

a. Font   d.  Size 

b. Style   e.  Color 

c. Background 

 

14. Perintah yang benar saat Anda ingin menyisipkan Objek dari ClipArt adalah .... 

a. Insert > Design > Clip Art 

b. Home > Illustrations > Clip Art 

c. Insert > Illustrations > Clip Art 

d. Home > Design > Clip Art 

e. Insert > Object > Clip Art 

 

15. Fasilitas Clip Art digunakan untuk .... 

a. memasukkan gambar 

b. memasukkan video 

c. memasukkan diagram 

d. memasukkan audio 

e. memasukkan tabel 
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16. Ikon yang digunakan untuk menyisipkan gambar dari komputer adalah .... 

a.    d.  

b.    e.   

c.   
 

17. Smart Art adalah menu yang digunakan untuk membuat .... 

a. diagram  d. gambar 

b. tabel   e. object 

c. grafik 

 

18. Untuk membuat struktur organisasi menggunakan diagram tipe .... 

a.   d.   

b.   e.   

 

c.    
  

19. Berikut ini pilihan grafik tipe bar  adalah .... 

a.  
 

b.  
 

c.  
 

d.  
 

e.  
 

 

 



 

141 
 

20. Untuk membuat grafik, Anda harus memilih menu .... 

a. Insert > Illustrations > Chart 

b. Home > Illustrations > Chart 

c. Insert > Drawing > Chart 

d. Insert > Picture > Chart 

e. Home > Picture > Chart 

 

21. Langkah-langkah untuk membuat tabel ialah .... 

a. Design > Table > Insert Table 

b. Home > Table > Insert Table 

c. Insert > Table > Insert Table 

d. Animations > Table > Insert Table 

e. Slide Slow > Table > Insert Table 

 

22. Untuk menggabungkan cell dalam tabel menggunakan menu .... 

a. Split Cells 

b. Merge Cells 

c. Delete Rows 

d. Delete Collums 

e. Insert Cells 

 

23. Pada menu WordArt Style, fungsi dari Text Effect adalah untuk .... 

a. memberikan efek desain pada huruf WordArt 

b. mengatur huruf dan model yang akan dipakai 

c. memberikan warna pada garis 

d. memberikan warna pada huruf WordArt 

e. memberikan bayangan pada huruf 

 

24. Ikon yang digunakan untuk membuat WordArt adalah .... 

a.    d.   

b.    e.   

c.  
 

25. Untuk memasukkan suara pada file presentasi terdapat pada menu .... 

a. Home   d. Animations 

b. Insert   e. Slide Show 

c. Design 

 

26. Perintah Sound berfungsi untuk menyisipkan .... 

a. gambar  d.  dekorasi 

b. audio   e.  bilangan 

c. animasi 

 

27. Gerakan dari satu slide ke slide berikutnya disebut .... 

a. Format  d. Effect 

b. View   e. Transition 

c. Edit 
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28. Perhatikan gambar berikut ini: 

 
Untuk mengatur pemunculan tulisan atau gambar ke layar menggunakan .... 

a. Entrance  d. Motion Paths 

b. Emphasis  e.  Tidak ada jawaban benar 

c. Exit  

 

29. Untuk menentukan durasi presentasi menggunakan menu .... 

a. Record Narration 

b. Rehearse Timings 

c. Set Up Slide Show 

d. Hide Slide 

e. Resolution 

 

30. Dalam menu Rehearse Timings yang digunakan untuk menentukan lamanya waktu 

presentasi adalah .... 

a.   d.  

b.   e.  

c.  
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Lampiran 9: 

KUNCI JAWABAN SOAL POSTTEST 

 

1. C 

2. A 

3. B 

4. C 

5. E 

6. B 

7. A 

8. C 

9. E 

10. D 

11. E 

12. A 

13. C 

14. C 

15. A 

16. E 

17. A 

18. D 

19. B 

20. A 

21. C 

22. B 

23. A 

24. C 

25. B 

26. B 

27. E 

28. A 

29. B 

30. D 
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Lampiran 10: 

DATA SKOR KELAS EKSPERIMEN 

 

No Nama Lengkap 
Nilai 

PRETEST POSTTEST 

1 Apik Winulat 5 9,2 

2 Aprilia Nuraini 5,6 8 

3 Aprilia Susilowati 6,6 9,2 

4 Danang Susetyo Ridwan 6 9,2 

5 Danu Dwi Pambudi 7,6 9,2 

6 Devi Kurnianingsih  6,3 8 

7 Diah Ayu Candra Devi 7,3 9,2 

8 Dita Rahmawati 6,6 8,4 

9 Fera Hidayatun Najah 7,3 8,8 

10 Fika Ariyani 6,6 8,4 

11 Hery Prasetya 5 8,8 

12 Iis Mariyana 6,3 8,4 

13 Landung Suryandoko 7,3 9,2 

14 Mitfah Nur Fauzi 7,3 9,2 

15 Muhammad Lukman Hakim 7,6 9,2 

16 Nino Fibriana 6,6 8,4 

17 Novia Anggraini 6,6 8,8 

18 Noviana Indri Astuti 6,6 9,2 

19 Novita Riviyani 8,3 9,2 

20 Nur Oktaviyanni 7,3 8,8 

21 Rafita Nur Laila 5,3 8,4 

22 Riki Bagus Budi Perkoso 6,6 8 

23 Riska Noviani 6,6 9,2 

24 Risky Bagus Nur Sidiq 6,3 8,8 

25 Roro Berlianingtiyas Probosekti 6,6 8,4 

26 Ruli 7,6 8,4 

27 Siti Khotimatussaroh 6,6 9,2 

28 Yuni Wahyu Hidayah 7,3 9,2 
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Lampiran 11: 

DATA SKOR KELAS KONTROL 

 

No Nama Lengkap 
Nilai 

PRETEST POSTTEST 

1 Agus Budiyanto 6,3 9,2 

2 Ani Salwa Dama Rini 6,3 8 

3 Ayu Hermawati 6,6 8,4 

4 Eka Septia Ningsih 6,6 8,4 

5 Eni Nur Nita 7 9,2 

6 Erwin Budiman 7 8,4 

7 Eti Purwati 6,6 9,2 

8 Fajar Pujiyantoro 6,3 8 

9 Fatimah Anggi Safitri 7,3 8,4 

10 Fitriyaningsih Sulistiyami 7 8,8 

11 Helmy Ferawati Dwi Anggraini 6 7,2 

12 Ida Khoirunisa 6 8,8 

13 Islamiya 5,6 8,4 

14 Joko Purnomo 5,6 6,4 

15 Lisa Nur Indahsari 6,3 8,8 

16 Muhammad Alam Wizuda Utama 6 7,6 

17 Nisvah Tri Utami 5 8,4 

18 Nur Isnaini 7,6 6 

19 Putri Dwi Lestari 6,6 9,2 

20 Rani Susilaningsih 7 8,8 

21 Riki Dwi Saputra 7,3 8,8 

22 Rizka Wildanu Arikzan 6,3 8,4 

23 Rully Adi Perdana 5,6 8,8 

24 Siti Latipah 7 8,8 

25 Wahyu Eri Hidayati 8,6 8 

26 Wahyu Sukma Arga Rini 7 9,2 

27 Wahyu Susilowati 8,3 8,4 

28 Yenni Ariyanti 6,6 8,8 

29 Khalifatus Sholikhah 8,3 8,8 

30 Anugrah Darmawan 6,6 8,4 

31 Wahyu Dwi S 6,6 8,8 
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Lampiran 12: 

INPUT DATA UJI COBA INSTRUMEN PRETEST 

 

030 0 n 04 
DEBBEACEABAEDDDCADAEDADBDAEBCD 
555555555555555555555555555555 
YYYYYYYYYYYYYYYYYYYYYYYYYYYYYY 
001 DEBBECCEBBBEDDDCACAADADBDAEBCD 
002 ADBBBACEBCBEDDECBDBAECBBCEEACD 
003 DEBBEACEABAEDDDCADAEDABBDAABCD 
004 DEABEACEABBEDDDEADACDADBDAEBCD 
005 DEBBEACEEBAEDDECADAEDADBDAEBCD 
006 DEBCEACEABAEDDACADAEDADBDAEBCD 
007 DEBBECCEABBEDDDCADAEDAABDAEBCD 
008 AEABBACABCBEEDEDADAEDCCBDDACCA 
009 DEBBEACEABBEDDDCADAEDADBDAEBCA 
010 DECACDCEBCBDABDCAEACDCDADAADCD 
011 DEBBEACAEBCEDDDCADAEDADBDAEBCD 
012 DEAAEABCABBECBBCCEABDABBCCEBBA 
013 DEBBEACEABAEDDDCADAEDDDBDBEBCD 
014 DEADECCECADDEDEADEABDDDADAEBCD 
015 DEBBEDCEACBEDDDCADBACADBDAEACB 
016 DEBBEACEABEEDDDCADAEDADBDAEACD 
017 DECBEACEADBEDDDBAEAADADBDAEBCD 
018 DEBBEACEABADEDDCADAEDADBDAEBCD 
019 CEBBEBCDABBBEDCDADAADABBBCEDCD 
020 DEBBEACEABBEEDDCBDAEDADBDAEBCD 
021 DEBBEACEABBEDDDCADAEDADBDAEBCD 
022 DEDBEACEABAEEDDCADAEDADBDAEBCD 
023 DEABEACEABBDDDDCADAEDADBDAEBCD 
024 DABBEECCDBBEEDDEBDDBDBDBABEDCC 
025 DEBBEACEBBAEDDDCADAEDAABEAEBCD 
026 DEBBEACEEEAEEDDCADAEDADBCAEBCD 
027 BEBDEAAEABDADCDAEDEEAACCCACBBA 
028 EDCBEACEBCBCEEDCADBEBEDBDAEBED 
029 DBDBECDBBBBDDDECBBAEEABBDADBBD 
030 DEBBEACEABAEDDDCBDAEDCDBDAEBCD 
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Lampiran 13: 

HASIL ANALISIS UJI COBA INSTRUMEN PRETEST 

 

 

MicroCAT (tm) Testing System 

Copyright (c) 1982, 1984, 1986, 1988 by Assessment Systems Corporation 

 

       Item and Test Analysis Program -- ITEMAN (tm) Version 3.00 

 

Item analysis for data from file PRETEST.TXT                       Page 1 

 

 

                 Item Statistics             Alternative Statistics 

             -----------------------   ----------------------------------

- 

Seq.  Scale   Prop.           Point            Prop.            Point 

No.   -Item  Correct  Biser.  Biser.   Alt.  Endorsing  Biser.  Biser. 

Key 

----  -----  -------  ------  ------   ----- ---------  ------  ------ --

- 

 

  1   0-1     0.833    0.879   0.589     A     0.067    -0.785  -0.407   

                                         B     0.033    -0.683  -0.283   

                                         C     0.033    -0.454  -0.188   

                                         D     0.833     0.879   0.589  * 

                                         E     0.033    -0.454  -0.188   

                                       Other   0.000    -9.000  -9.000   

 

  2   0-2     0.867    0.811   0.513     A     0.033    -0.607  -0.251   

                                         B     0.033    -0.607  -0.251   

                                         C     0.000    -9.000  -9.000   

                                         D     0.067    -0.653  -0.338   

                                         E     0.867     0.811   0.513  * 

                                       Other   0.000    -9.000  -9.000   

 

  3   0-3     0.667    0.552   0.426     A     0.167    -0.424  -0.284   

                                         B     0.667     0.552   0.426  * 

                                         C     0.100    -0.446  -0.261   

                                         D     0.067    -0.126  -0.065   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

  4   0-4     0.833    0.674   0.452     A     0.067    -0.785  -0.407   

                                         B     0.833     0.674   0.452  * 

                                         C     0.033     0.388   0.160   

                                         D     0.067    -0.741  -0.384   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

  5   0-5     0.900    0.867   0.507     A     0.000    -9.000  -9.000   

                                         B     0.067    -0.785  -0.407   

                                         C     0.033    -0.683  -0.283   

                                         D     0.000    -9.000  -9.000   

                                         E     0.900     0.867   0.507  * 

                                       Other   0.000    -9.000  -9.000   
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  6   0-6     0.733    0.578   0.430     A     0.733     0.578   0.430  * 

                                         B     0.033    -0.454  -0.188   

                                         C     0.133    -0.257  -0.163   

                                         D     0.067    -0.433  -0.225   

                                         E     0.033    -0.607  -0.251   

                                       Other   0.000    -9.000  -9.000   

 

 

                 Item Statistics             Alternative Statistics 

             -----------------------   ----------------------------------

- 

Seq.  Scale   Prop.           Point            Prop.            Point 

No.   -Item  Correct  Biser.  Biser.   Alt.  Endorsing  Biser.  Biser. 

Key 

----  -----  -------  ------  ------   ----- ---------  ------  ------ --

- 

 

  7   0-7     0.900    0.835   0.488     A     0.033    -0.683  -0.283   

                                         B     0.033    -0.683  -0.283   

                                         C     0.900     0.835   0.488  * 

                                         D     0.033    -0.607  -0.251   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

  8   0-8     0.800    0.722   0.505     A     0.067    -0.214  -0.111   

                                         B     0.033    -0.607  -0.251   

                                         C     0.067    -0.741  -0.384   

                                         D     0.033    -0.454  -0.188   

                                         E     0.800     0.722   0.505  * 

                                       Other   0.000    -9.000  -9.000   

 

  9   0-9     0.600    0.561   0.443     A     0.600     0.561   0.443  * 

                                         B     0.233    -0.641  -0.464   

                                         C     0.033    -0.607  -0.251   

                                         D     0.033    -0.607  -0.251   

                                         E     0.100     0.395   0.231   

                                       Other   0.000    -9.000  -9.000   

 

 10   0-10    0.733    0.647   0.481     A     0.033    -0.607  -0.251   

                                         B     0.733     0.647   0.481  * 

                                         C     0.167    -0.765  -0.513   

                                         D     0.033     0.082   0.034   

                                         E     0.033     0.235   0.097   

                                       Other   0.000    -9.000  -9.000   

 

 11   0-11    0.300    0.696   0.528     A     0.300     0.696   0.528  * 

                                         B     0.567    -0.503  -0.400   

                                         C     0.033     0.311   0.129   

                                         D     0.067    -0.741  -0.384   

                                         E     0.033     0.388   0.160   

                                       Other   0.000    -9.000  -9.000   

 

 12   0-12    0.733    0.630   0.468     A     0.033    -0.683  -0.283   

                                         B     0.033    -0.454  -0.188   

                                         C     0.033    -0.454  -0.188   

                                         D     0.167    -0.356  -0.239   

                                         E     0.733     0.630   0.468  * 

                                       Other   0.000    -9.000  -9.000   
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                     MicroCAT (tm) Testing System                

Copyright (c) 1982, 1984, 1986, 1988 by Assessment Systems Corporation 

 

       Item and Test Analysis Program -- ITEMAN (tm) Version 3.00 

 

Item analysis for data from file PRETEST.TXT                       Page 3 

 

 

                 Item Statistics             Alternative Statistics 

             -----------------------   ----------------------------------

- 

Seq.  Scale   Prop.           Point            Prop.            Point 

No.   -Item  Correct  Biser.  Biser.   Alt.  Endorsing  Biser.  Biser. 

Key 

----  -----  -------  ------  ------   ----- ---------  ------  ------ --

- 

 

 13   0-13    0.633    0.562   0.439     A     0.033    -0.683  -0.283   

                                         B     0.000    -9.000  -9.000   

                                         C     0.033    -0.683  -0.283   

                                         D     0.633     0.562   0.439  * 

                                         E     0.300    -0.317  -0.240   

                                       Other   0.000    -9.000  -9.000   

 

 14   0-14    0.867    0.863   0.547     A     0.000    -9.000  -9.000   

                                         B     0.067    -0.785  -0.407   

                                         C     0.033    -0.683  -0.283   

                                         D     0.867     0.863   0.547  * 

                                         E     0.033    -0.454  -0.188   

                                       Other   0.000    -9.000  -9.000   

 

 15   0-15    0.733    0.665   0.494     A     0.033     0.388   0.160   

                                         B     0.033    -0.683  -0.283   

                                         C     0.033    -0.454  -0.188   

                                         D     0.733     0.665   0.494  * 

                                         E     0.167    -0.651  -0.437   

                                       Other   0.000    -9.000  -9.000   

 

 16   0-16    0.767    0.659   0.477     A     0.067    -0.741  -0.384   

                                         B     0.033     0.082   0.034   

                                         C     0.767     0.659   0.477  * 

                                         D     0.067    -0.653  -0.338   

                                         E     0.067    -0.214  -0.111   

                                       Other   0.000    -9.000  -9.000   

 

 17   0-17    0.733    0.717   0.532     A     0.733     0.717   0.532  * 

                                         B     0.167    -0.356  -0.239   

                                         C     0.033    -0.683  -0.283   

                                         D     0.033    -0.607  -0.251   

                                         E     0.033    -0.683  -0.283   

                                       Other   0.000    -9.000  -9.000   

 

 18   0-18    0.800    0.621   0.434     A     0.000    -9.000  -9.000   

                                         B     0.033    -0.607  -0.251   

                                         C     0.033     0.158   0.065   

                                         D     0.800     0.621   0.434  * 

                                         E     0.133    -0.652  -0.413   

                                       Other   0.000    -9.000  -9.000   



 

150 
 

                     MicroCAT (tm) Testing System                
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                 Item Statistics             Alternative Statistics 

             -----------------------   ----------------------------------

- 

Seq.  Scale   Prop.           Point            Prop.            Point 

No.   -Item  Correct  Biser.  Biser.   Alt.  Endorsing  Biser.  Biser. 

Key 

----  -----  -------  ------  ------   ----- ---------  ------  ------ --

- 

 

 19   0-19    0.833    0.742   0.498     A     0.833     0.742   0.498  * 

                                         B     0.100    -0.511  -0.299   

                                         C     0.000    -9.000  -9.000   

                                         D     0.033    -0.607  -0.251   

                                         E     0.033    -0.683  -0.283   

                                       Other   0.000    -9.000  -9.000   

 

 20   0-20    0.667    0.677   0.522     A     0.167    -0.288  -0.193   

                                         B     0.100    -0.802  -0.469   

                                         C     0.067    -0.258  -0.134   

                                         D     0.000    -9.000  -9.000   

                                         E     0.667     0.677   0.522  * 

                                       Other   0.000    -9.000  -9.000   

 

 21   0-21    0.833    0.742   0.498     A     0.033    -0.683  -0.283   

                                         B     0.033    -0.454  -0.188   

                                         C     0.033    -0.071  -0.030   

                                         D     0.833     0.742   0.498  * 

                                         E     0.067    -0.741  -0.384   

                                       Other   0.000    -9.000  -9.000   

 

 22   0-22    0.733    0.665   0.494     A     0.733     0.665   0.494  * 

                                         B     0.033    -0.607  -0.251   

                                         C     0.133    -0.573  -0.363   

                                         D     0.067    -0.126  -0.065   

                                         E     0.033    -0.454  -0.188   

                                       Other   0.000    -9.000  -9.000   

 

 23   0-23    0.700    0.594   0.451     A     0.067     0.357   0.185   

                                         B     0.167    -0.606  -0.406   

                                         C     0.067    -0.785  -0.407   

                                         D     0.700     0.594   0.451  * 

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

 24   0-24    0.900    0.835   0.488     A     0.067    -0.741  -0.384   

                                         B     0.900     0.835   0.488  * 

                                         C     0.033    -0.683  -0.283   

                                         D     0.000    -9.000  -9.000   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   
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                 Item Statistics             Alternative Statistics 

             -----------------------   ----------------------------------

- 

Seq.  Scale   Prop.           Point            Prop.            Point 

No.   -Item  Correct  Biser.  Biser.   Alt.  Endorsing  Biser.  Biser. 

Key 

----  -----  -------  ------  ------   ----- ---------  ------  ------ --

- 

 

 25   0-25    0.767    0.622   0.450     A     0.033    -0.607  -0.251   

                                         B     0.033    -0.454  -0.188   

                                         C     0.133    -0.626  -0.396   

                                         D     0.767     0.622   0.450  * 

                                         E     0.033     0.311   0.129   

                                       Other   0.000    -9.000  -9.000   

 

 26   0-26    0.800    0.722   0.505     A     0.800     0.722   0.505  * 

                                         B     0.067    -0.126  -0.065   

                                         C     0.067    -0.653  -0.338   

                                         D     0.033    -0.683  -0.283   

                                         E     0.033    -0.683  -0.283   

                                       Other   0.000    -9.000  -9.000   

 

 27   0-27    0.833    0.674   0.452     A     0.100    -0.414  -0.242   

                                         B     0.000    -9.000  -9.000   

                                         C     0.033    -0.683  -0.283   

                                         D     0.033    -0.607  -0.251   

                                         E     0.833     0.674   0.452  * 

                                       Other   0.000    -9.000  -9.000   

 

 28   0-28    0.767    0.678   0.490     A     0.100    -0.155  -0.091   

                                         B     0.767     0.678   0.490  * 

                                         C     0.033    -0.683  -0.283   

                                         D     0.100    -0.738  -0.432   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

 29   0-29    0.867    0.837   0.530     A     0.000    -9.000  -9.000   

                                         B     0.100    -0.835  -0.488   

                                         C     0.867     0.837   0.530  * 

                                         D     0.000    -9.000  -9.000   

                                         E     0.033    -0.454  -0.188   

                                       Other   0.000    -9.000  -9.000   

 

 30   0-30    0.800    0.621   0.434     A     0.133    -0.573  -0.363   

                                         B     0.033    -0.071  -0.030   

                                         C     0.033    -0.607  -0.251   

                                         D     0.800     0.621   0.434  * 

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   
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There were 30 examinees in the data file. 

 

 

Scale Statistics 

---------------- 

 

  Scale:           0    

               ------- 

N of Items          30 

N of Examinees      30 

Mean            22.933 

Variance        34.462 

Std. Dev.        5.870 

Skew            -0.607 

Kurtosis        -1.455 

Minimum         14.000 

Maximum         29.000 

Median          26.000 

Alpha            0.884 

SEM              1.995 

Mean P           0.764 

Mean Item-Tot.   0.486 

Mean Biserial    0.698 
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Lampiran 14: 

INPUT DATA UJI COBA INSTRUMEN POSTTEST 

 

030 0 n 04 
CABCEBACEDEACCAEADBACBACBBEABD 
555555555555555555555555555555 
YYYYYYYYYYYYYYYYYYYYYYYYYYYYYY 
001 CABCEBACEEEABCAECDCDCBACBBEABD 
002 DACCEAADEEDBCAAECDAACBACBCDABE 
003 CABCEBACEDEACCAECDBACBAABBEABD 
004 CAACEBCCDDBACAAEADAACBACBBEAAE 
005 CABBEBACEDEACCAEADBACBECBBEABD 
006 CAACEBACEDEACCAECDAACEACBBEABD 
007 CACCEBACEDEACEAEADCACBACBBEAAD 
008 DACCEBCCDEBBBAABCDABCBECDBEAAD 
009 CABCEBACEEEACCAECDDACBACBBEABD 
010 CACCBBECDEECCECEEBADCEBCBBECBD 
011 CACCEBACEEEACCABCDAACBACBBEABD 
012 CEACBCECEDECCCABCDACBABCBBEBBD 
013 CACCEBACEDEACCACEDBACBACBBEABD 
014 CECCEBBCDEAACAABCBACBEACDBDABD 
015 CACCEBECEEEACCAECDAACBACBBEABD 
016 CABCEBACEDEACEAECDBECBACBBEABD 
017 CABCEBACEDEACCAECDADCBACBBDABD 
018 CAECEBECEDEACCAEBDBACBACBBEABD 
019 CAACEBECEEECCCAEEDAACBACBBEABD 
020 CACCEBACEEEACCAECDAACBACBBEABD 
021 CABCEBACADEACCAEEDEACBACBBEABD 
022 CABCEBACEEEACCABDDAACBACBBEABD 
023 CACCEBACEEEACCABDDAACBACBBEABD 
024 CEACBBADEEEACACBEBACBBACDBEDBD 
025 CABCECACEDEACBAECDADCBACBBEABD 
026 CACCEBECEEEACCAECDAACBACBBEABD 
027 DACCECEDCDEABCCBBDBACAACBAEAAE 
028 CAACECACEAEACCAEEDAACBACBBEABD 
029 CAECECEDEDEABEABCDBDCBDCDCAAAE 
030 CAACEBACEAEACAAECDCACBACBBEABD 

 

 

 

 

 

 

 

 

 

 



 

154 
 

Lampiran 15: 

HASIL ANALISIS UJI COBA INSTRUMEN POSTTEST 
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                 Item Statistics             Alternative Statistics 

             -----------------------   ----------------------------------

- 

Seq.  Scale   Prop.           Point            Prop.            Point 

No.   -Item  Correct  Biser.  Biser.   Alt.  Endorsing  Biser.  Biser. 

Key 

----  -----  -------  ------  ------   ----- ---------  ------  ------ --

- 

 

  1   0-1     0.900    0.863   0.505     A     0.000    -9.000  -9.000   

                                         B     0.000    -9.000  -9.000   

                                         C     0.900     0.863   0.505  * 

                                         D     0.100    -0.863  -0.505   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

  2   0-2     0.900    0.942   0.551     A     0.900     0.942   0.551  * 

                                         B     0.000    -9.000  -9.000   

                                         C     0.000    -9.000  -9.000   

                                         D     0.000    -9.000  -9.000   

                                         E     0.100    -0.942  -0.551   

                                       Other   0.000    -9.000  -9.000   

 

  3   0-3     0.300    0.642   0.487     A     0.233    -0.175  -0.127   

                                         B     0.300     0.642   0.487  * 

                                         C     0.400    -0.369  -0.291   

                                         D     0.000    -9.000  -9.000   

                                         E     0.067    -0.210  -0.109   

                                       Other   0.000    -9.000  -9.000   

 

  4   0-4     0.967   -0.469  -0.194     A     0.000    -9.000  -9.000   

                                         B     0.033     0.469   0.194  ? 

           CHECK THE KEY                 C     0.967    -0.469  -0.194  * 

   C was specified, B works better       D     0.000    -9.000  -9.000   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

  5   0-5     0.900    0.902   0.528     A     0.000    -9.000  -9.000   

                                         B     0.100    -0.902  -0.528   

                                         C     0.000    -9.000  -9.000   

                                         D     0.000    -9.000  -9.000   

                                         E     0.900     0.902   0.528  * 

                                       Other   0.000    -9.000  -9.000   
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  6   0-6     0.800    0.588   0.411     A     0.033    -0.556  -0.230   

                                         B     0.800     0.588   0.411  * 

                                         C     0.167    -0.494  -0.331   

                                         D     0.000    -9.000  -9.000   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

                 Item Statistics             Alternative Statistics 

             -----------------------   ----------------------------------

- 

Seq.  Scale   Prop.           Point            Prop.            Point 

No.   -Item  Correct  Biser.  Biser.   Alt.  Endorsing  Biser.  Biser. 

Key 

----  -----  -------  ------  ------   ----- ---------  ------  ------ --

- 

 

  7   0-7     0.633    0.728   0.569     A     0.633     0.728   0.569  * 

                                         B     0.033    -0.835  -0.345   

                                         C     0.067    -0.531  -0.275   

                                         D     0.000    -9.000  -9.000   

                                         E     0.267    -0.436  -0.324   

                                       Other   0.000    -9.000  -9.000   

 

  8   0-8     0.867    0.927   0.587     A     0.000    -9.000  -9.000   

                                         B     0.000    -9.000  -9.000   

                                         C     0.867     0.927   0.587  * 

                                         D     0.133    -0.927  -0.587   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

  9   0-9     0.800    0.736   0.515     A     0.033     0.376   0.155   

                                         B     0.000    -9.000  -9.000   

                                         C     0.033    -0.649  -0.268   

                                         D     0.133    -0.863  -0.547   

                                         E     0.800     0.736   0.515  * 

                                       Other   0.000    -9.000  -9.000   

 

 10   0-10    0.467    0.252   0.201     A     0.067     0.217   0.113   

                                         B     0.000    -9.000  -9.000   

                                         C     0.000    -9.000  -9.000   

                                         D     0.467     0.252   0.201  * 

                                         E     0.467    -0.322  -0.257   

                                       Other   0.000    -9.000  -9.000   

 

 11   0-11    0.867    0.799   0.506     A     0.033    -0.835  -0.345   

                                         B     0.067    -0.531  -0.275   

                                         C     0.000    -9.000  -9.000   

                                         D     0.033    -0.556  -0.230   

                                         E     0.867     0.799   0.506  * 

                                       Other   0.000    -9.000  -9.000   

 

 12   0-12    0.833    0.798   0.535     A     0.833     0.798   0.535  * 

                                         B     0.067    -0.799  -0.414   

                                         C     0.100    -0.548  -0.320   

                                         D     0.000    -9.000  -9.000   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   
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                 Item Statistics             Alternative Statistics 

             -----------------------   ----------------------------------

- 

Seq.  Scale   Prop.           Point            Prop.            Point 

No.   -Item  Correct  Biser.  Biser.   Alt.  Endorsing  Biser.  Biser. 

Key 

----  -----  -------  ------  ------   ----- ---------  ------  ------ --

- 

 

 13   0-13    0.867    0.702   0.445     A     0.000    -9.000  -9.000   

                                         B     0.133    -0.702  -0.445   

                                         C     0.867     0.702   0.445  * 

                                         D     0.000    -9.000  -9.000   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

 14   0-14    0.633    0.691   0.540     A     0.200    -0.761  -0.533   

                                         B     0.033     0.189   0.078   

                                         C     0.633     0.691   0.540  * 

                                         D     0.000    -9.000  -9.000   

                                         E     0.133    -0.285  -0.180   

                                       Other   0.000    -9.000  -9.000   

 

 15   0-15    0.900    0.902   0.528     A     0.900     0.902   0.528  * 

                                         B     0.000    -9.000  -9.000   

                                         C     0.100    -0.902  -0.528   

                                         D     0.000    -9.000  -9.000   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

 16   0-16    0.667    0.697   0.538     A     0.000    -9.000  -9.000   

                                         B     0.300    -0.810  -0.614   

                                         C     0.033     0.376   0.155   

                                         D     0.000    -9.000  -9.000   

                                         E     0.667     0.697   0.538  * 

                                       Other   0.000    -9.000  -9.000   

 

 17   0-17    0.100    0.280   0.164     A     0.100     0.280   0.164  * 

                                         B     0.067    -0.157  -0.081   

                                         C     0.567    -0.078  -0.062   

                                         D     0.067     0.271   0.140   

                                         E     0.200    -0.119  -0.083   

                                       Other   0.000    -9.000  -9.000   

 

 18   0-18    0.900    0.981   0.574     A     0.000    -9.000  -9.000   

                                         B     0.100    -0.981  -0.574   

                                         C     0.000    -9.000  -9.000   

                                         D     0.900     0.981   0.574  * 

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   
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                 Item Statistics             Alternative Statistics 

             -----------------------   ----------------------------------

- 

Seq.  Scale   Prop.           Point            Prop.            Point 

No.   -Item  Correct  Biser.  Biser.   Alt.  Endorsing  Biser.  Biser. 

Key 

----  -----  -------  ------  ------   ----- ---------  ------  ------ --

- 

 

 19   0-19    0.233    0.163   0.118     A     0.600    -0.401  -0.316   

                                         B     0.233     0.163   0.118  * 

           CHECK THE KEY                 C     0.100     0.280   0.164  ? 

   B was specified, C works better       D     0.033     0.376   0.155   

                                         E     0.033     0.376   0.155   

                                       Other   0.000    -9.000  -9.000   

 

 20   0-20    0.667    0.716   0.553     A     0.667     0.716   0.553  * 

                                         B     0.033    -0.835  -0.345   

                                         C     0.100    -0.942  -0.551   

                                         D     0.167    -0.244  -0.164   

                                         E     0.033     0.376   0.155   

                                       Other   0.000    -9.000  -9.000   

 

 21   0-21    0.900    0.942   0.551     A     0.000    -9.000  -9.000   

                                         B     0.100    -0.942  -0.551   

                                         C     0.900     0.942   0.551  * 

                                         D     0.000    -9.000  -9.000   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

 22   0-22    0.833    0.770   0.516     A     0.067    -0.745  -0.386   

                                         B     0.833     0.770   0.516  * 

                                         C     0.000    -9.000  -9.000   

                                         D     0.000    -9.000  -9.000   

                                         E     0.100    -0.548  -0.320   

                                       Other   0.000    -9.000  -9.000   

 

 23   0-23    0.833    0.743   0.498     A     0.833     0.743   0.498  * 

                                         B     0.067    -0.799  -0.414   

                                         C     0.000    -9.000  -9.000   

                                         D     0.033    -0.742  -0.307   

                                         E     0.067    -0.210  -0.109   

                                       Other   0.000    -9.000  -9.000   

 

 24   0-24    0.967   -0.469  -0.194     A     0.033     0.469   0.194  ? 

                                         B     0.000    -9.000  -9.000   

           CHECK THE KEY                 C     0.967    -0.469  -0.194  * 

   C was specified, A works better       D     0.000    -9.000  -9.000   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   
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                 Item Statistics             Alternative Statistics 

             -----------------------   ----------------------------------

- 

Seq.  Scale   Prop.           Point            Prop.            Point 

No.   -Item  Correct  Biser.  Biser.   Alt.  Endorsing  Biser.  Biser. 

Key 

----  -----  -------  ------  ------   ----- ---------  ------  ------ --

- 

 

 25   0-25    0.867    1.000   0.689     A     0.000    -9.000  -9.000   

                                         B     0.867     1.000   0.689  * 

                                         C     0.000    -9.000  -9.000   

                                         D     0.133    -1.000  -0.689   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

 26   0-26    0.900    0.824   0.482     A     0.033    -0.649  -0.268   

                                         B     0.900     0.824   0.482  * 

                                         C     0.067    -0.745  -0.386   

                                         D     0.000    -9.000  -9.000   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

 27   0-27    0.867    0.638   0.404     A     0.033    -0.742  -0.307   

                                         B     0.000    -9.000  -9.000   

                                         C     0.000    -9.000  -9.000   

                                         D     0.100    -0.469  -0.274   

                                         E     0.867     0.638   0.404  * 

                                       Other   0.000    -9.000  -9.000   

 

 28   0-28    0.900    0.902   0.528     A     0.900     0.902   0.528  * 

                                         B     0.033    -0.649  -0.268   

                                         C     0.033    -0.742  -0.307   

                                         D     0.033    -0.742  -0.307   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

 29   0-29    0.833    0.604   0.405     A     0.167    -0.604  -0.405   

                                         B     0.833     0.604   0.405  * 

                                         C     0.000    -9.000  -9.000   

                                         D     0.000    -9.000  -9.000   

                                         E     0.000    -9.000  -9.000   

                                       Other   0.000    -9.000  -9.000   

 

 30   0-30    0.867    0.702   0.445     A     0.000    -9.000  -9.000   

                                         B     0.000    -9.000  -9.000   

                                         C     0.000    -9.000  -9.000   

                                         D     0.867     0.702   0.445  * 

                                         E     0.133    -0.702  -0.445   

                                       Other   0.000    -9.000  -9.000   
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There were 30 examinees in the data file. 

 

 

Scale Statistics 

---------------- 

 

  Scale:           0    

               ------- 

N of Items          30 

N of Examinees      30 

Mean            22.967 

Variance        23.232 

Std. Dev.        4.820 

Skew            -0.910 

Kurtosis        -0.890 

Minimum         14.000 

Maximum         28.000 

Median          25.000 

Alpha            0.857 

SEM              1.824 

Mean P           0.766 

Mean Item-Tot.   0.433 

Mean Biserial    0.650 
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Lampiran 16: 

RINGKASAN HASIL VALIDITAS DATA UJI COBA PRETEST 

 

 
No 

 
Tingkat Kesukaran Daya Beda Validitas Kesimpulan 

1 0,833 Mudah 0,879 Baik Sekali 0,589 Valid Lolos 

2 0,867 Mudah 0,811 Baik Sekali 0,513 Valid Lolos 

3 0,667 Sedang 0,552 Baik 0,426 Valid Lolos 

4 0,833 Mudah 0,674 Baik 0,452 Valid Lolos 

5 0,900 Mudah 0,867 Baik Sekali 0,507 Valid Lolos 

6 0,733 Mudah 0,578 Baik 0,430 Valid Lolos 

7 0,900 Mudah 0,835 Baik Sekali 0,488 Valid Lolos 

8 0,800 Mudah 0,722 Baik Sekali 0,505 Valid Lolos 

9 0,600 Sedang 0,561 Baik 0,443 Valid Lolos 

10 0,733 Mudah 0,647 Baik 0,481 Valid Lolos 

11 0,300 Sulit 0,696 Baik 0,528 Valid Lolos 

12 0,733 Mudah 0,630 Baik 0,468 Valid Lolos 

13 0,633 Sedang 0,562 Baik 0,439 Valid Lolos 

14 0,867 Mudah 0,863 Baik Sekali 0,547 Valid Lolos 

15 0,733 Mudah 0,665 Baik 0,494 Valid Lolos 

16 0,767 Mudah 0,659 Baik 0,477 Valid Lolos 

17 0,733 Mudah 0,717 Baik Sekali 0,532 Valid Lolos 

18 0,800 Mudah 0,621 Baik 0,434 Valid Lolos 

19 0,833 Mudah 0,742 Baik Sekali 0,498 Valid Lolos 

20 0,667 Sedang 0,677 Baik 0,522 Valid Lolos 

21 0,833 Mudah 0,742 Baik Sekali 0,498 Valid Lolos 

22 0,733 Mudah 0,665 Baik 0,494 Valid Lolos 

23 0,700 Sedang 0,594 Baik 0,451 Valid Lolos 

24 0,900 Mudah 0,835 Baik Sekali 0,488 Valid Lolos 

25 0,767 Mudah 0,622 Baik 0,450 Valid Lolos 

26 0,800 Mudah 0,722 Baik Sekali 0,505 Valid Lolos 

27 0,833 Mudah 0,674 Baik 0,452 Valid Lolos 

28 0,767 Mudah 0,678 Baik 0,490 Valid Lolos 

29 0,867 Mudah 0,837 Baik Sekali 0,530 Valid Lolos 

30 0,800 Mudah 0,621 Baik 0,434 Valid Lolos 
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Lampiran 17: 

RINGKASAN HASIL VALIDITAS DATA UJI COBA POSTTEST 

 

 
No 

 
Tingkat Kesukaran Daya Beda Validitas Kesimpulan 

1 0,900 Mudah 0,863 Baik Sekali 0,505 Valid Lolos 

2 0,900 Mudah 0,942 Baik Sekali 0,551 Valid Lolos 

3 0,300 Sulit 0,642 Baik 0,487 Valid Lolos 

4 0,967 Mudah -0,469 Jelek -0,194 Tdk Valid Gugur 

5 0,900 Mudah 0,902 Baik Sekali 0,528 Valid Lolos 

6 0,800 Mudah 0,588 Baik 0,411 Valid Lolos 

7 0,633 Sedang 0,728 Baik Sekali 0,569 Valid Lolos 

8 0,867 Mudah 0,927 Baik Sekali 0,587 Valid Lolos 

9 0,800 Mudah 0,736 Baik Sekali 0,515 Valid Lolos 

10 0,467 Sedang 0,252 Cukup 0,201 Tdk Valid Gugur 

11 0,867 Mudah 0,799 Baik Sekali 0,506 Valid Lolos 

12 0,833 Mudah 0,798 Baik Sekali 0,535 Valid Lolos 

13 0,867 Mudah 0,702 Baik Sekali 0,445 Valid Lolos 

14 0,633 Sedang 0,691 Baik 0,540 Valid Lolos 

15 0,900 Mudah 0,902 Baik Sekali 0,528 Valid Lolos 

16 0,667 Sedang 0,697 Baik 0,538 Valid Lolos 

17 0,100 Sulit 0,280 Cukup 0,164 Tdk Valid Gugur 

18 0,900 Mudah 0,981 Baik Sekali 0,574 Valid Lolos 

19 0,233 Sulit 0,163 Jelek 0,118 Tdk Valid Gugur 

20 0,667 Sedang 0,716 Baik Sekali 0,553 Valid Lolos 

21 0,900 Mudah 0,942 Baik Sekali 0,551 Valid Lolos 

22 0,833 Mudah 0,770 Baik Sekali 0,516 Valid Lolos 

23 0,833 Mudah 0,743 Baik Sekali 0,498 Valid Lolos 

24 0,967 Mudah -0,469 Jelek -0,194 Tdk Valid Gugur 

25 0,867 Mudah 1,000 Baik Sekali 0,689 Valid Lolos 

26 0,900 Mudah 0,824 Baik Sekali 0,482 Valid Lolos 

27 0,867 Mudah 0,638 Baik 0,404 Valid Lolos 

28 0,900 Mudah 0,902 Baik Sekali 0,528 Valid Lolos 

29 0,833 Mudah 0,604 Baik 0,405 Valid Lolos 

30 0,867 Mudah 0,702 Baik Sekali 0,445 Valid Lolos 
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Lampiran 18: 

STATISTIK DESKRIPTIF DATA PRETEST DAN POSTTEST 
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Lampiran 19: 

UJI NORMALITAS DAN UJI HOMOGENITAS 
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Lampiran 20: 

UJI KESAMAAN KEMAMPUAN KELOMPOK DAN UJI HIPOTESIS 
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Lampiran 21: 

DATA USER FACEBOOK KELAS EKSPERIMEN 

 

No Nama Lengkap User Facebook 

1 Apik Winulat Apik Apik Winulat 

2 Aprilia Nuraini Aprilia Nuraini 

3 Aprilia Susilowati Aprilia Susilowati 

4 Danang Susetyo Ridwan Danang Susetyo Ridwan 

5 Danu Dwi Pambudi Superz Sonixz 

6 Devi Kurnianingsih  Devi Kurnia 

7 Diah Ayu Candra Devi Ayu Dyach Chandra 

8 Dita Rahmawati Dita Rahma 

9 Fera Hidayatun Najah FhéRà Hidàyàtuñ Ñàjàh 

10 Fika Ariyani Piikaa Aryanie 

11 Hery Prasetya Herry Prasetya 

12 Iis Mariyana Iis Maryana 

13 Landung Suryandoko LéGåcy Lìght 

14 Mitfah Nur Fauzi Fauzie Testimony Penyesatan 

15 Muhammad Lukman Hakim Muhammad LH 

16 Nino Fibriana Radhen'aiiyu Angellcrydeadd Saaiiankdiieya-Sakmoddaree 

17 Novia Anggraini OpIk Goendul 

18 Noviana Indri Astuti Noviana Indri Astuti 

19 Novita Riviyani Vietha Tjachchueck 

20 Nur Oktaviyanni Octtaa Vhievieany 

21 Rafita Nur Laila Rafa Cewexmanja Ingindicinta 

22 Riki Bagus Budi Perkoso Rbbp 

23 Riska Noviani Reskha Nopheane 

24 Risky Bagus Nur Sidiq Riski Bagus Nur Sidiq 

25 Roro Berlianingtiyas Probosekti ROro Berlianingtiyas Probosekti 

26 Ruli Bob Roeley Part II 

27 Siti Khotimatussaroh Oji HoshiMoccacyno  

28 Yuni Wahyu Hidayah Zunny Wahyu 
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Lampiran 22: 

KUESIONER 

TANGGAPAN SISWA TERHADAP PENGGUNAAN  

JEJARING SOSIAL FACEBOOK SEBAGAI MEDIA PEMBELAJARAN  

 

Petunjuk: 

 Kuesioner ini dibuat dalam rangka melakukan penelitian mengenai tanggapan siswa 

terhadap penggunaan jejaring sosial facebook sebagai media pembelajaran TIK. Semua 

informasi yang didapatkan semata-mata untuk penelitian ini dan tidak akan disalahgunakan 

untuk kepentingan lain. Oleh karena itu dimohon agar saudara mengisi kuesioner ini apa 

adanya. Terima kasih atas kesediaan saudara berpartisipasi mengisi kueioner ini. 

 

A. Intensitas Penggunaan Facebook 

Beri tanda tanda silang (x) atau checklist (√) sesuai dengan keadaan anda yang 

sebenarnya! 

1. Berapa kali intensitas penggunaan facebook untuk bersosial anda? 

a. 1 – 6 jam sekali 

b. sehari sekali 

c. 3 – 5 hari sekali 

d. seminggu sekali 

2. Berapa lama anda menggunakan facebook untuk bersosial setiap sekali membuka? 

a. lebih dari 60 menit 

b. 15 menit – 60 menit 

c. 5 – 15 menit 

d. 1 – 5 menit 

3. Berapa kali intensitas anda dalam menggunakan facebook untuk belajar? 

a. 1 – 6 jam sekali 

b. sehari sekali 

c. 3 – 5 hari sekali 

d. seminggu sekali 
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4. Berapa lama anda menggunakan facebook untuk belajar setiap sekali membuka? 

a. lebih dari 60 menit 

b. 15 menit – 60 menit 

c. 5 – 15 menit 

d. 1 – 5 menit 

 

B. Kegiatan Pembelajaran dengan Facebook 

Isilah dengan memberi tanda silang (x) atau checklist (√) sesuai dengan keadaan anda 

yang sebenarnya! 

Keterangan Jawaban : 

SL =  Selalu 

SR =  Sering  

JR =  Jarang 

TP =  Tidak Pernah 

 

No. Kegiatan Pembelajaran dengan Facebook 
Frekuensi Penggunaan 

SL SR JR TP 

5 Membaca materi pelajaran dari materi yang 

dibagikan melalui link 

    

6 Melakukan diskusi mata pelajaran dari materi 

yang disampaikan melalui link 

    

7 Membaca materi pelajaran dari materi yang 

dibagikan melalui note 

    

8 Melakukan diskusi mata pelajaran dari materi 

yang disampaikan melalui note 

    

9 Membaca materi pelajaran dari materi yang 

disampaikan melalui grup 

    

10 Melakukan diskusi mata pelajaran dari materi 

yang disampaikan melalui grup 

    

11 Membaca materi pelajaran dari materi yang 

dibagikan melalui wall grup 

    

12 Melakukan diskusi mata pelajaran dari materi 

yang disampaikan melalui wall grup 
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13 Mempelajari gambar yang dibagikan melalui 

fitur Add Photo di dalam grup 

    

14 Melakukan diskusi mata pelajaran dari gambar 

yang dibagikan melalui fitur Add Photo di 

dalam grup 

    

15 Mempelajari video yang dibagikan melalui fitur 

Add Video di dalam grup 

    

16 Melakukan diskusi mata pelajaran dari video 

yang dibagikan melalui fitur Add Video di 

dalam grup 

    

17 Mempelajari materi yang didiskusikan melalui 

fitur Ask Question di dalam grup 

    

18 Melakukan diskusi mata pelajaran dari materi 

yang didiskusikan melalui fitur Ask Question di 

dalam grup 

    

19 Mempelajari buku paket elektronik yang 

dibagikan melalui fitur Add File di dalam grup 

    

20 Melakukan diskusi mata pelajaran dari buku 

paket elektronik yang dibagikan melalui fitur 

Add File di dalam grup 

    

21 Mengecek fitur event di facebook untuk 

mengetahui jadwal ulangan 

    

22 Mengecek fitur event di facebook untuk 

mengatur jadwal belajar 
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Lampiran 23: 

DATA KUESIONER 

 

No Nama Lengkap 
Soal No 

y 
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 

1 Apik Winulat 1 2 1 1 1 1 2 1 3 3 3 1 3 1 1 1 1 1 1 1 30 

2 Aprilia Nuraini 3 4 3 2 2 2 3 2 4 4 3 2 3 2 2 2 2 3 2 2 52 

3 Aprilia Susilowati 3 3 3 2 2 2 3 1 2 3 2 1 2 2 2 2 2 2 1 1 41 

4 Danang Susetyo Ridwan 4 3 3 3 3 2 2 2 2 2 2 2 3 3 1 1 1 3 3 1 46 

5 Danu Dwi Pambudi 4 1 4 3 3 3 2 1 2 3 3 2 2 1 1 1 1 3 1 1 42 

6 Devi Kurnianingsih  3 3 3 3 2 1 3 1 2 2 2 1 2 1 1 1 1 2 1 1 36 

7 Diah Ayu Candra Devi 4 2 4 2 4 3 4 2 4 4 4 3 4 3 1 2 2 4 2 2 60 

8 Dita Rahmawati 4 3 4 2 3 2 2 1 4 3 3 2 3 1 2 3 3 4 1 1 51 

9 Fera Hidayatun Najah 4 3 4 4 2 3 2 2 3 2 3 3 2 1 1 1 1 3 2 1 47 

10 Fika Ariyani 2 1 1 1 1 1 1 1 2 2 1 1 1 2 1 1 1 2 1 1 25 

11 Hery Prasetya 2 2 2 1 2 1 3 3 4 3 2 3 3 2 1 1 1 3 3 1 43 

12 Iis Mariyana 4 2 4 2 3 3 2 1 2 2 3 2 2 3 2 2 2 2 1 2 46 

13 Landung Suryandoko 4 3 2 2 3 2 3 2 3 2 3 3 3 2 2 3 3 4 2 1 52 

14 Mitfah Nur Fauzi 1 1 1 1 1 1 2 1 3 3 1 2 3 1 1 2 1 3 1 1 31 

15 Muhammad Lukman Hakim 3 3 3 2 3 3 2 2 4 3 2 1 2 2 1 1 1 2 2 2 44 

16 Nino Fibriana 4 4 4 3 3 3 4 3 4 4 4 3 4 3 3 2 2 2 3 3 65 

17 Novia Anggraini 2 1 2 1 2 1 3 1 3 3 3 2 3 2 2 1 3 1 1 2 39 

18 Noviana Indri Astuti 3 2 4 2 3 1 2 2 2 2 1 3 4 1 1 1 1 2 2 1 40 

19 Novita Riviyani 3 3 4 3 2 2 2 1 2 2 1 1 1 2 2 2 1 3 1 1 39 

20 Nur Oktaviyanni 2 2 2 2 3 1 2 1 3 3 3 2 2 3 1 2 1 3 1 1 40 

21 Rafita Nur Laila 2 1 1 1 2 2 3 2 3 2 3 2 2 1 2 1 2 2 3 1 38 
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22 Riki Bagus Budi Perkoso 4 4 4 4 4 1 4 1 3 3 2 2 3 2 3 3 3 4 2 2 58 

23 Riska Noviani 3 3 4 4 3 2 3 1 3 3 2 3 2 2 2 2 2 3 3 1 51 

24 Risky Bagus Nur Sidiq 3 3 3 2 2 3 2 1 3 2 1 1 2 1 1 1 1 2 1 1 36 

25 Roro Berlianingtiyas Probosekti 2 3 2 3 2 1 2 2 2 3 3 2 3 2 2 1 2 1 3 2 43 

26 Ruli 1 2 2 1 1 1 2 1 3 3 4 2 3 3 1 1 1 2 2 2 38 

27 Siti Khotimatussaroh 4 1 4 3 2 2 3 3 4 3 3 1 3 3 3 3 2 3 4 2 56 

28 Yuni Wahyu Hidayah 3 2 3 3 3 1 2 1 2 2 2 1 2 1 1 3 2 3 2 1 40 
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Lampiran 24: 

UJI VALIDITAS DAN RELIABILITAS KUESIONER 

 

Reliability Statistics 

Cronbach's 

Alpha 

N of Items 

.876 22 

 

Item-Total Statistics 

 Scale Mean if 

Item Deleted 

Scale Variance 

if Item Deleted 

Corrected Item-

Total 

Correlation 

Cronbach's 

Alpha if Item 

Deleted 

Butir1 46.29 79.026 .671 .863 

Butir2 46.82 83.634 .436 .872 

Butir3 46.32 79.189 .601 .866 

Butir4 46.96 83.665 .428 .872 

Butir5 46.82 81.411 .671 .864 

Butir6 47.39 84.914 .437 .872 

Butir7 46.71 83.101 .627 .866 

Butir8 47.68 85.782 .461 .871 

Butir9 46.32 84.597 .481 .870 

Butir10 46.50 86.259 .448 .871 

Butir11 46.75 83.528 .462 .871 

Butir12 47.29 85.249 .448 .871 

Butir13 46.64 84.831 .462 .871 

Butir14 47.32 85.263 .434 .872 

Butir15 47.64 85.201 .510 .870 

Butir16 47.54 85.147 .451 .871 

Butir17 46.32 88.226 .181 .880 

Butir18 47.57 85.735 .436 .872 

Butir19 46.64 84.164 .449 .871 

Butir20 47.36 84.312 .432 .872 

Butir21 47.82 86.004 .556 .870 

Butir22 46.79 89.360 .161 .879 
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Lampiran 25: 

DESKRIPSI DATA KUESIONER 
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Lampiran 26: 

 SK PEMBIMBING 
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Lampiran 27: 

 VALIDASI  MODUL PEMBELAJARAN 

Dosen Ahli 1: 
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Dosen Ahli 2: 
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Guru TIK: 
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Lampiran 28: 

 VALIDASI INSTRUMEN TES 

Dosen Ahli 1: 
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Dosen Ahli 2: 
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Guru TIK: 
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Lampiran 29: 

 VALIDASI INSTRUMEN NON-TEST (KUESIONER) 
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Lampiran 30: 

 SURAT IJIN PENELITIAN 
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Lampiran 31: 

 SURAT KETERANGAN SELESAI PENELITIAN 
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Lampiran 32: 

 SCREENSHOOT PEMBELAJARAN DENGAN FACEBOOK 

 

Tampilan Grup Kelas: 

 

Contoh Penggunaan Note: 
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Contoh Penggunaan Link: 

 

Contoh Penggunaan Fitur Add Video: 

 

Contoh Penggunaan Fitur Add File: 
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Contoh Penggunaan Fitur Add Photo: 

 

Contoh Penggunaan Fitur Ask Questions: 

 

Penggunaan Fitur Event: 
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Contoh Diskusi Pembelajaran dengan Facebook:  
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Kesan Siswa Terhadap Pembelajaran dengan Facebook:  

 

           



 

188 
 

Lampiran 33: 

 DOKUMENTASI PENELITIAN 
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Lampiran 34: 

 SK PENGUJI 

 

 


